Oracle Fusion Cloud Applications

Implementing Help Desk

22D
## Contents

### Get Help

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Help</td>
<td>i</td>
</tr>
</tbody>
</table>

### 1 About This Guide

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audience and Scope</td>
<td>1</td>
</tr>
<tr>
<td>Related Guides</td>
<td>1</td>
</tr>
<tr>
<td>Educational Resources</td>
<td>1</td>
</tr>
<tr>
<td>Overview of Help Desk</td>
<td>3</td>
</tr>
</tbody>
</table>

### 2 Enable Help Desk

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Steps to Enable Help Desk</td>
<td>5</td>
</tr>
</tbody>
</table>

### 3 Lookups, Profile Options, and Scheduled Processes

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What are Lookups, Profile Options, and Scheduled Processes for Help Desk?</td>
<td>11</td>
</tr>
<tr>
<td>Lookups</td>
<td>11</td>
</tr>
<tr>
<td>Scheduled Processes</td>
<td>16</td>
</tr>
<tr>
<td>Profile Options</td>
<td>21</td>
</tr>
</tbody>
</table>

### 4 Users and Security

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Users and Security for Help Desk</td>
<td>27</td>
</tr>
<tr>
<td>Enter Your Company Information and Corporate Currency</td>
<td>27</td>
</tr>
<tr>
<td>Overview of Help Desk Roles</td>
<td>28</td>
</tr>
<tr>
<td>Overview of Steps to Create Users</td>
<td>29</td>
</tr>
<tr>
<td>Overview of Setting Up Users and Security</td>
<td>30</td>
</tr>
<tr>
<td>Resource Team Information</td>
<td>32</td>
</tr>
<tr>
<td>About Security Roles for Help Desk</td>
<td>34</td>
</tr>
<tr>
<td>Remove Data Security Policies from Users for Help Desk</td>
<td>35</td>
</tr>
<tr>
<td>Set Up a Role With Read-Only Access</td>
<td>36</td>
</tr>
<tr>
<td>Data Security Policies</td>
<td>36</td>
</tr>
<tr>
<td>Restrict Contact Search Results</td>
<td>40</td>
</tr>
<tr>
<td>Control User Types Displayed in Contact Picker</td>
<td>41</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>------</td>
</tr>
<tr>
<td>Synchronize Worker Data Loaded Through HDL in Help Desk</td>
<td>42</td>
</tr>
<tr>
<td><strong>5 Manage Categories and Product Usage Groups</strong></td>
<td>43</td>
</tr>
<tr>
<td>Manage Help Desk Request Categories and Product Usage Groups</td>
<td>43</td>
</tr>
<tr>
<td><strong>6 Manage Assignment Objects and Assignment Rules</strong></td>
<td>45</td>
</tr>
<tr>
<td>Overview of Work Assignments</td>
<td>45</td>
</tr>
<tr>
<td>Assignment Mappings</td>
<td>46</td>
</tr>
<tr>
<td>Assignment Rules</td>
<td>47</td>
</tr>
<tr>
<td>Work Assignments</td>
<td>51</td>
</tr>
<tr>
<td>Omnichannel</td>
<td>56</td>
</tr>
<tr>
<td>Prevent Work Starvation</td>
<td>59</td>
</tr>
<tr>
<td>FAQs About Help Desk Requests and Queues</td>
<td>60</td>
</tr>
<tr>
<td><strong>7 Email Channels</strong></td>
<td>63</td>
</tr>
<tr>
<td>Configure Help Desk Email</td>
<td>63</td>
</tr>
<tr>
<td>How Inbound Messages Are Processed</td>
<td>65</td>
</tr>
<tr>
<td>Enable Configuration of Email Communications</td>
<td>67</td>
</tr>
<tr>
<td>Configure an Email Channel</td>
<td>67</td>
</tr>
<tr>
<td>Inbound Message Filters</td>
<td>69</td>
</tr>
<tr>
<td>Configure Profile Options for Inbound and Outbound Email</td>
<td>73</td>
</tr>
<tr>
<td>Enable the Ability to Add All Contacts and Team Members or Additional Email Recipients</td>
<td>78</td>
</tr>
<tr>
<td>Set the From Name in Outbound Emails</td>
<td>78</td>
</tr>
<tr>
<td>Define Email Templates</td>
<td>79</td>
</tr>
<tr>
<td>Modify Acknowledgment Messages for Inbound Email</td>
<td>80</td>
</tr>
<tr>
<td>Enable Deep Links to KM Articles in Help Desk Outbound Emails</td>
<td>81</td>
</tr>
<tr>
<td>Access Point Setup for Inbound Emails</td>
<td>82</td>
</tr>
<tr>
<td>Process Inbound Emails Job</td>
<td>90</td>
</tr>
<tr>
<td>Display Email Thread in Preview and Outbound Email</td>
<td>91</td>
</tr>
<tr>
<td>FAQs About Help Desk Emails</td>
<td>96</td>
</tr>
<tr>
<td><strong>8 Service Entitlements</strong></td>
<td>99</td>
</tr>
<tr>
<td>Overview of Service Entitlements</td>
<td>99</td>
</tr>
<tr>
<td>Milestones and Coverages</td>
<td>100</td>
</tr>
<tr>
<td>Set Up Additional Condition Columns for Standard Coverage Entitlement Rules</td>
<td>108</td>
</tr>
<tr>
<td>Set Up Administrator-Defined Milestones</td>
<td>112</td>
</tr>
</tbody>
</table>
9 Set Up Action Plans

- Overview of Action Plans
- Manage Action Plan Profile Options
- Manage Action Plan Actions
- Manage Action Plan Templates
- Map Action Plan Status Values

10 Configure Outcomes and Resolutions

- Outcomes and Resolutions
- Manage Outcomes and Resolutions
- Ready to Use Outcomes and Resolutions for Help Desk

11 Adaptive Intelligence

- Help Desk Request Classifications

12 Enable Productivity Tools

- Enable Productivity Tools
- How You Manage SmartText Entries
- SmartText Naming Conventions

13 Configure Notifications

- Set Notification Triggers and Preferences
- Sample Groovy Scripts for Notifications

14 Adaptive Search

- Using Adaptive Search for Help Desk

15 Collaborate with Slack

- How You Collaborate with Slack
- Create a Collaboration Action for Slack
- Create a Child Action for a Collaboration Action for Slack
- Create a Second-Level Child Action for a Collaboration Action for Slack
Add an Event to Capture Messages Mentioning Your Slack App .............................. 166

16 Collaborate with Microsoft Teams ........................................................................... 169
   How You Set Up a Microsoft Teams Channel .......................................................... 169
   Create a Microsoft Teams App ............................................................................... 170
   Set Up a Bot User for Your Microsoft Teams App .................................................. 170
   Register Your Microsoft Teams App in the Azure Portal ........................................ 171
   Update Functional Setup Manager with Credentials of Your Microsoft Teams App ... 171
   Create a Microsoft Teams Channel ........................................................................... 172
   Enable Notifications to Microsoft Teams ................................................................. 172
   Create a Collaboration Action .................................................................................... 173
   Create a Child Action for a Collaboration Action ..................................................... 175
   Create a Child Action for the Reply to Request Child Action ..................................... 176
   Configure the FND_IDP_PROXY_USER_WHITELIST Profile Option ......................... 177
   Upload Your Microsoft Teams App ............................................................................ 178
   Install Your Microsoft Teams App and Add It to Your Team .................................... 178

17 Build Insightful Reporting with Help Desk Analytics .............................................. 181
   How to View Analyses Using OTBI ........................................................................... 181
   Help Desk Analytics Roles ....................................................................................... 182
   Help Desk Analytics Subject Areas .......................................................................... 183
   Help Desk Analytics Saved Queries ........................................................................ 184

18 Import and Export ................................................................................................. 187
   Overview of Import and Export Management .......................................................... 187
   Use Functional Setup Manager to Import, Export, and Compare Categories Between Environments 188
   Before You Import .................................................................................................... 189
   Import Objects .......................................................................................................... 189
   Overview of Bulk Data Export ................................................................................... 190

19 Manage Knowledge ............................................................................................... 193
   Implement Knowledge for Help Desk ....................................................................... 193

20 Implement Cases for Help Desk .............................................................................. 195
   About Case Management ........................................................................................... 195
21 Associate Assets and Work Orders to Help Desk Requests 197
Associate Assets and Work Orders to Help Desk Work Requests 197
Enable the Maintenance Help Desk Profile Option for REST API 198

22 Manage Digital Assistant for Help Desk 199
Manage Digital Assistant for Help Desk 199

23 Channels for Collaboration 201
Control the Display of Channels Used Only for Internal Conversations 201
Create an Email Channel for Collaboration or Internal Conversations 202

24 Extend Help Desk 203
Using Visual Builder Studio for Help Desk 203
Overview of Extending Your Application 203
Configure Visual Builder Studio for Help Desk 204
Set Up Visual Builder Studio 205
Work with Dynamic UI 205
Work with Dynamic Forms 213
Preview, Share, and Publish an Application Extension 222

25 Configure HCM Pages with the Help Desk Link 223
How to Provide User Access to Help Desk 223

26 Appendix: HR Help Desk Classic Configuration 225
About This Appendix 225
Overview of Configuring HR Help Desk 225
Enable HR Help Desk 226
Configure the HR Help Desk UI Using Application Composer 227
Enable the HR Help Desk Profile Options 228
Restrict Contact Search Results 229
Control User Types Displayed in Contact Picker 230
Synchronize Worker Data Loaded Through HDL in HR Help Desk 231
Configure Notifications 232
Manage Assignment Objects and Assignment Rules for HR Help Desk 232
Manage Service Request Categories and Product Usage Groups for HR Help Desk 235
HR Help Desk Email ................................................................. 236
Manage Other HR Help Desk Features ..................................... 238
Set Up Business Units for HR Help Desk ................................. 245
Get Help

There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications

Use help icons to access help in the application. If you don't see any help icons on your page, click your user image or name in the global header and select Show Help Icons.

Get Support

You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training

Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community

Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch events.

Learn About Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback

We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
1 About This Guide

Audience and Scope

This guide is intended for users who are involved in implementing and administering Help Desk.

Related Guides

To understand more about the implementation tasks covered in this guide, you can refer to the following table for a list of related guides.

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Fusion Cloud Applications: Oracle Cloud Using Help Desk</td>
<td>Contains information to assist help desk personnel and other end users to perform day-to-day business task using Oracle Help Desk.</td>
</tr>
<tr>
<td>Oracle Fusion Cloud B2B Service Using Knowledge Management</td>
<td>Describes how administrators, agents, authors, and other knowledge base contributors can implement and use Oracle Knowledge in Oracle B2B Service.</td>
</tr>
<tr>
<td>Extending Oracle Cloud Applications with Visual Builder Studio</td>
<td>Describes how to use Visual Builder Studio to extend your application.</td>
</tr>
<tr>
<td>Oracle Fusion Cloud Customer Experience Understanding Import and Export Management for Sales and B2B Service</td>
<td>Contains information to help those charged with exporting and importing object data.</td>
</tr>
<tr>
<td>Oracle Fusion Cloud Customer Experience Securing Sales and B2B Service</td>
<td>Contains information to help setup users and sales administrators configure access to Oracle Sales functionality and data.</td>
</tr>
</tbody>
</table>

Educational Resources

Learn how to successfully implement Help Desk in your organization with online video training, student guides, and hands-on practices.
Implementing Help Desk Course

In this course, you'll learn to perform an initial Help Desk implementation. You'll learn the implementation basics, dive into specific configuration options, and get access to hands-on practices you need to get up and running fast.

In this course, you'll learn to:

- Enable the Help Desk offering in your environment
- Configure help desk request management options
- Configure entitlements, queues, routing, and agent assignment
- Configure inbound and outbound email
- Create and maintain knowledge articles
- Create and maintain helpful agent productivity tools

To learn more, visit Oracle University's Help Desk Implementation course.

Implementation Foundation Course

If this is your first Help Desk implementation, you'll need to learn the foundations first. In this hands-on course, you'll learn how to enable the application components you need, how to configure access and security, and best practices for performing a basic initial implementation of your application.

Starting off right will help you avoid costly mistakes down the line. Knowing how things work will help you communicate effectively with your internal team and with Oracle staff. In short, this knowledge will help you make the best decisions for your specific business requirements.

This course, or equivalent knowledge, is a prerequisite for the Implementing Help Desk course. Here's what you'll learn in this course:

- Perform the initial setup of your environment
- Create and manage setup users
- Configure application and user security
- Perform common configurations such as setting profile options, modifying lookups, and using Quick Setup pages
- Identify tools for integration, extension, and migration of the application

To learn more, visit Oracle University's Implementation Foundation course.

Sign Up for Oracle Cloud Learning Subscriptions

Ongoing education is your key to success. Oracle University offers online courses, that let you learn at your own pace. With this knowledge and hands-on experience, you'll be prepared to earn the Certified Implementation Professional credential acknowledging you as a skilled implementor.

To learn more about online learning, visit Oracle University's Cloud Learning Subscriptions.
Overview of Help Desk

Help Desk is a tool you can use to support your internal employees, contingent worker’s, and non worker’s questions and requests. It can be used for any type of support.

For example, Human Resources, ERP, Sales, or Facilities. The sensitive data for Human Resource requests has an added layer of security with the stripe code HRHD that keeps it separate from all other requests. All other types requests use the stripe code ISR for Internal Requests.

Think of Internal Requests as any type of support for your employees, other than Human Resources.

Help Desk is a separate offering in Setup and Maintenance and has employee and agent flows that you can configure by the type of support you’re implementing. After enabling the offering, the HR Help Desk and Internal Service Requests features are enabled and setup separately.

Help Desk has built-in capabilities for a self-service employee’s My Help page to search knowledge, view existing help desk requests, or create new requests. In addition, agents working on requests manage their work through a request list page that includes assignment and routing, milestones, action plans, knowledge search, messaging with the request owners, and collaboration across the enterprise.
2 Enable Help Desk

Steps to Enable Help Desk

To enable Help Desk, you need to complete the following steps:

1. Enter the promotion code.
2. Enable the Help Desk offering and features in Setup and Maintenance.
3. Enable Elastic Search.
4. Set Global Locale for Knowledge (if applicable).
5. Grant job roles to your test users to access the Redwood UI pages.

Enter the Promotion Code for Help Desk

Here's how to enter your Help Desk promotion code:

Log in to Setup and Maintenance using the Application Implementation role.

1. From Navigator, navigate to: My Enterprise > Enterprise.
2. On the Enterprise Information page, click the Manage Promotion Codes link.
3. Click Enter Promotion Code.
4. Enter the promotion code provided to you.

   If you don’t have a promotion code, contact Oracle Support.
5. Click Save and Close.
Enable the Help Desk Offering and Features

The Help Desk offering and features must be enabled in order to see them in Setup and Maintenance. Here’s how:

1. Sign in to Setup and Maintenance as an Application Implementation Consultant.
2. From the Actions drop-down list, select Go to Offerings.
3. Click the Help Desk offering.
4. Click the Opt In Features button.
5. In the Help Desk row, select the Enable check-box.
6. In the Help Desk row, click the Edit icon in the Features column.
7. In the Edit Features: Help Desk window, click the Edit icon in the Enable column.
8. In the Help Desk Usage, click the Edit icon in the Enable column.
9. Select the usage that you want to use for your implementation. Options are Internal Service Requests and HR Service Requests.
10. Click Save and Close.
11. Click Done.
12. In the Opt In: Help Desk page, you can select to enable any other features you’re using.
13. Click Done.

**Note:** Some setup tasks will only appear in the table of contents after you enable the associated feature. For example, some of the email setup tasks don’t appear in the task list unless the Email Communication Channel feature is enabled.

Functional Areas of the Help Desk Offering

To start implementing Help Desk, a user with the Application Implementation Consultant role must opt into the offerings you want to use.

Help Desk Functional Areas

The following table shows the primary functional areas of the Help Desk offering.

<table>
<thead>
<tr>
<th>Functional Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Desk Request</td>
<td>Manage lookup values for requests, for example severity, status, or priority values. You can opt into auditing of help desk requests, or change default action for areas such as assignment, auto-close, and default values.</td>
</tr>
<tr>
<td>Assignment and Routing</td>
<td>Manage the Help Desk request assignment objects and assignment rules. You can use attributes of the request as well as the employee to create the rules.</td>
</tr>
</tbody>
</table>

**CAUTION:** Changes in tasks that are shared with the Service offering will impact the setup for existing service requests (used in CRM and the legacy HR Help Desk). If your company is using the CRM Service application or the previous generation help desk, be sure to coordinate any changes to shared tasks with the Service Administrator.
Enable Help Desk

<table>
<thead>
<tr>
<th>Functional Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Communication Channel</td>
<td>Manage the channels you use to communicate with customers, configure each channel, and manage the Omnichannel toolbar and assignment rules.</td>
</tr>
<tr>
<td>Other Communication Channels</td>
<td>Manage settings for the tools that make agents more productive, including global search, collaboration, standard text, and keyboard shortcuts.</td>
</tr>
<tr>
<td>Service Catalog</td>
<td>Manage the product hierarchy used for categorizing the product of a help desk request.</td>
</tr>
<tr>
<td>Knowledge Management</td>
<td>Enable knowledge management features, set up locales and users, and create and manage the knowledge base for authors, agents, and external users.</td>
</tr>
<tr>
<td>Service Entitlements</td>
<td>Manage the configuration of milestones tracked for Help Desk requests.</td>
</tr>
<tr>
<td>Action Plans</td>
<td>Associate action plans with help desk requests to help facilitate a series of steps or a sequence of events that may be required to resolve requests.</td>
</tr>
<tr>
<td>Productivity Tools</td>
<td>Manage settings for the tools that make agents more productive, including global search, collaboration, standard text, and keyboard shortcuts.</td>
</tr>
<tr>
<td>Business Units</td>
<td>Set profile options to enable the multi-BU functionality, define and add internal resource organizations, create business units, and BUs associated with resource organizations.</td>
</tr>
<tr>
<td>Add Application Extensions</td>
<td>Manage the common functions that help in maintaining the core application data, establishing security, maintaining transactional and shared data, and setting the user general preferences.</td>
</tr>
</tbody>
</table>

Enable Elastic Search

Elastic search is used for the Next Gen Help Desk request list and is enabled in the Sales Offering.

Enable Elastic Search for Help Desk

If the Sales offering is not enabled, go to Navigator > My Enterprise > Offerings to enable it.

You must first enable it for Help Desk and then the Help Desk Object.

Use the following steps to Enable Elastic Search for Help Desk:

1. Navigate to Setup and Maintenance and select the Sales offering.
2. Select Change Feature Opt In.
3. Select the Edit icon in the Sales Foundation row.
4. Select the Enable check box for Open Work Areas Powered by Adaptive Search.
5. Click Done.
6. Click Done.
Enable Elastic Search for the Help Desk Object

1. In Setup and Maintenance, navigate to:
   - Offering: Sales
   - Functional Area: Sales Foundation
   - Task: Configure Adaptive Search
2. On the Configure Adaptive Search page, select the Setup tab.
3. In the Service section, click the check box to enable either the HR Help Desk Request object, or the Internal Service Request object.
4. Select Publish from the Actions menu.
5. Select the Monitor tab.
6. Click Start Process to start the Elastic Search indexing.

   **Note:** This job will continue to run in the background. It is initially very common for there to be errors. Start the process again until you see a Wait status. As long as the job is running, you won't see REST API errors from this search in Help Desk.

Set Global Locale for Knowledge

If you are using a single Global Knowledge Locale, you can set it globally so each user doesn't need to set it for themselves.

To set the global language preference:

1. In Setup and Maintenance, go to:
   - Offering: Help Desk
   - Functional Area: Knowledge Management
   - Task: Manage Knowledge Locales
2. On the Manage Locales page, select a locale from the Default Preferred Knowledge Locale drop-down list.
3. Set the Default Preferred Knowledge Locale.

   The checked box indicates that the English-US locale is active, which means an author can create knowledge in that locale.

   **Note:** Use an account that is tied to an employee record in Core HR.

Grant Help Desk Job Roles to Users

Use the following job roles are used for Help Desk:
HR Help Desk

Employee:
- Next Gen Human Resources Help Desk User

Agent:
- Next Gen Human Resource Help Desk Agent
- Next Gen Human Resource Help Desk Manager

Administrator:
- Next Gen Human Resource Help Desk Administrator

Internal Help Desk

Employee:
- Internal Help Desk User (Internal – non-HCM SRs)

Agent:
- Internal Help Desk Agent
- Internal Help Desk Manager

Administrator:
- Internal Help Desk Administrator

When you’ve successfully enabled the interface for the Redwood experience and granted access to users, new icons for Help Desk appear on the Home Page.
Lookups, Profile Options, and Scheduled Processes

What are Lookups, Profile Options, and Scheduled Processes for Help Desk?

Lookup types, profile options, and scheduled processes let you configure application behavior and process data.

Briefly, here’s what lookup types, profile options, and scheduled processes do:

- **Lookup types**: Provide the lists of values in applications. Many lookup types can be modified to fit your business needs.
- **Profile options**: Let you configure the application behavior.
- **Scheduled processes**: Act on data in the applications.

Get additional information on lookup types, profile options, and scheduled processes in this chapter and in the related topics.

**Related Topics**
- Overview of Scheduled Processes
- How can I access predefined profile options?
- How can I access predefined lookups?

Lookups

Lookup Types

Lookup types provide the lists of values in application fields that are drop-down lists.

For example, while creating a help desk request, the **Severity** is selected from a drop-down list. The values in that list are derived from a lookup type defined in Setup and Maintenance. This lookup type has several potential values known as lookups, each with their own unique lookup code and meaning that displays in the UI.

**Note**: You can't create a new lookup with the name starting with ORA, to avoid any conflict with the lookups seeded in the application.

How You Modify Lookup Types

You can modify many lookup types during or after implementation.
The configuration level of a lookup type determines whether the lookups in that lookup type can be edited. The lookup configuration levels are: User, Extensible, and System.

Here's a table that shows which lookup management tasks are allowed at each modification level.

<table>
<thead>
<tr>
<th>Allowed Task</th>
<th>User</th>
<th>Extensible</th>
<th>System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleting a lookup type</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Inserting new codes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Changing the wording that displays on the page (Meaning field)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Updating start date, end date, and enabled fields</td>
<td>Yes</td>
<td>Yes, only if the code isn’t predefined data</td>
<td>No</td>
</tr>
<tr>
<td>Deleting codes</td>
<td>Yes</td>
<td>Yes, only if the code isn’t predefined data</td>
<td>No</td>
</tr>
<tr>
<td>Updating tags</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Updating module</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

If a product depends on a lookup type, the configuration level must be set to system or extensible to prevent deletion. Once the configuration level is set for a lookup type, it can't be modified. The configuration level for lookup types created using the Define Lookups page is by default set at the User level.

Help Desk Lookup Types

You can find lookup types by searching for an associated setup task in the Setup and Maintenance work area. Lookup types that are commonly edited are presented within the Help Desk offering as one of the setup tasks or task lists. Other lookup types that are less frequently changed, may not be shown in the offering, but can still be accessed through the Manage Common Lookups task. Here are some of the common help desk lookup tasks or task lists:

- Define Help Desk Request Lookups
- Manage Help Desk Request Severity
- Manage Help Desk Request Channel Types

Modify Lookups

Administrators can modify lookups for help desk requests. Optionally, you can map status values to status types. By default, the following five Status types exist for help desk requests:

A help desk request always has one of these status types. However, administrators might want to display different labels for status types or change the display sequence. For example, this might be useful in situations where you want to
distinguish between statues such as "In Progress - Troubleshooting" versus "In Progress - Repairing." This procedure maps one or more Statuses to status types.

The following tasks are used to modify the request lookups for **Internal Help Desk**:

**Internal Help Desk Tasks**

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Severities for Internal Help Desk Requests</td>
<td>Manage the values and color coding that indicate the severity of the issue to the employee for Internal Help Desk Requests.</td>
</tr>
<tr>
<td>Manage Status Values for Internal Help Desk Requests</td>
<td>Set up Status Values for Internal Help Desk Requests and map them to the required status type.</td>
</tr>
<tr>
<td>Manage Outcomes and Resolutions for Internal Help Desk Requests</td>
<td>Set up Outcomes and Resolutions for Internal Help Desk Request wrap-ups.</td>
</tr>
<tr>
<td>Manage Profile Options for Internal Help Desk Requests</td>
<td>Set up Profile Options for Internal Help Desk Requests.</td>
</tr>
<tr>
<td>Manage Categories for Internal Help Desk Requests</td>
<td>Set up the category hierarchy that describes the nature of the Internal Help Desk Requests submitted by the employee.</td>
</tr>
</tbody>
</table>

The following tasks are used to modify the request lookups for **HR Help Desk**:

**HR Help Desk Tasks**

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Severities for HR Help Desk Requests</td>
<td>Manage the values and color coding that indicate the severity of the issue to the employee for HR Help Desk Requests.</td>
</tr>
<tr>
<td>Manage Status Values for HR Help Desk Requests</td>
<td>Set up status values for HR Help Desk Requests and map them to the required status type.</td>
</tr>
<tr>
<td>Manage Outcomes and Resolutions for HR Help Desk Requests</td>
<td>Set up Outcomes and Resolutions for HR Help Desk Requests wrap-ups.</td>
</tr>
<tr>
<td>Manage Profile Options for HR Help Desk Requests</td>
<td>Set up Profile Options for HR Help Desk Requests.</td>
</tr>
<tr>
<td>Manage Categories for HR Help Desk Requests</td>
<td>Set up the category hierarchy that describes the nature of the HR Help Desk Requests submitted by the employee.</td>
</tr>
</tbody>
</table>

The following tasks are shared between Help Desk (both HR and Internal Help Desk) and the Service offering (used by the CX solution). Important: See the Caution note in the following procedure.
Shared Tasks Between Help Desk (both HR and Internal Help Desk) and B2B Service

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Service Request Internal Priorities</td>
<td>Review and define lookup values that provide choices for a Service Request’s Priority.</td>
</tr>
<tr>
<td>Manage Service Request Channel Types</td>
<td>Specifies the origin of the service request and the communication mechanism of each message.</td>
</tr>
<tr>
<td>Manage Service Request Sources</td>
<td>Specifies the source or user interface where the request was created.</td>
</tr>
<tr>
<td>Manage Service Request Resolutions</td>
<td>Specify the values identifying how the Service Request was ultimately resolved.</td>
</tr>
<tr>
<td>Manage Service Request Problem Types</td>
<td>Specifies the type of problem reported in the request.</td>
</tr>
</tbody>
</table>

To modify lookups:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Help Desk
   - Functional Area: Help Desk Request
   - Task: Select All Tasks and click the task you want to modify.

   **CAUTION:** If the task doesn’t specifically say Internal Help Desk or HR Help Desk, it’s a shared task. Changes in tasks that are shared with the Service offering will impact the setup for existing service requests (used in CRM and the previous generation HR Help Desk). If your company is using the CRM Service application or the previous generation help desk, be sure to coordinate any changes to shared tasks with the Service Administrator.

2. In **Lookup Codes**, click the lookup code that you want to modify.
3. Modify the fields to correspond to your needs.
4. Click **Save and Close**.
5. Repeat the procedure for all of the help desk request lookup tasks.

The help desk request lookup is modified.

Related Topics
- Update Existing Setup Data

Modify Channel Type Visibility

Help Desk administrators can disable channels that should not be displayed in the application when an agent composes a message by sending a response or capturing an employee message.

Visibility is shared with Fusion Service and is set up in the Service offering.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Service Request
   - Task: Manage Service Request Channel Visibility
2. On the Manage Service Request Channel Type Visibility page, select the Property Value options to enable or disable the selected channel.

3. Click Save and Close.

The disabled channels aren't displayed when a message is composed.

Configure the Prefix and Radix

When a help desk request is created, a unique number or ID is generated for it by the application.

Users can't easily read or use these unique IDs because of their length and complexity. As an administrator, you can configure the unique ID that's generated to make it more user-friendly, readable, and specific to your requirement.

This user-friendly value called the public unique ID consists of a prefix and a radix, and you can configure both of them. For example, SR_0000027413 is a configured public unique ID, where SR_ is the prefix and 0000027413 is the radix or suffix.

To configure the prefix and radix for help desk requests:

1. Sign in to the application as a setup user or administrator.
2. In the Setup and Maintenance work area, go to the following:
   o Offering: Service
   o Functional Area: Productivity Tools
   o Task: Manage Public Unique Identifier Sequence Generation
3. On the Manage Public Unique Identifier Sequence Generation page, for the Help Desk Request or Internal Service Request Object Name, specify a prefix of your choice in the Prefix column. For example: HRHD- or ISR-.
4. Click in the Radix column for the HR Help Desk Request or Internal Service Request object.
5. From the multiple options displayed in the drop-down list, select the type of radix that you want for your help desk requests.

This option determines the radix value of the request number. To format the autogenerated radix value, you can configure the SVC_PUID_FORMAT profile option as described in the "Help Desk Profile Options" topic.

6. Click Save and Close.

Related Topics
- Overview of Public Unique IDs

FAQs About Lookups and Lookup Types

How can I edit lookups?

On any of the Manage Lookups pages, you can edit the existing lookup codes of a lookup type or add new lookup codes. You can edit lookups using the following tasks in the Setup and Maintenance work area:

- Manage Standard Lookups
- Manage Common Lookups
- Manage Set Enabled Lookups
Each task contains a predefined set of lookup types that are classified and stored. Open a task to search and edit the required lookup. However, you may not be able to edit a lookup if its configuration level doesn’t support editing.

Why can’t I see my lookup types?
Lookup types are classified using tasks that involve a group of related lookups, such as Manage Geography Lookups. Each task gives you access only to certain lookup types.

However, the generic tasks provide access to all lookup types of a kind, such as common lookups associated with the Manage Common Lookups task. If the lookup types in an application are available in the standard, common, or set-enabled lookups view, they’re central to an application. However, lookup types defined for a specific application are managed using the task for that application.

Can I create a new lookup name starting with ORA?
No, you can’t create a new lookup with the name starting with ORA. The application validates the lookup names to avoid any conflict with the lookups seeded in the application.

Scheduled Processes

Overview of Scheduled Processes

Scheduled processes do tasks that are too complex or time-consuming to do manually, for example importing data or updating many records. You can run scheduled processes on a recurring schedule and send notifications based on how the process ends.

Some scheduled processes give you printable output. Those processes might have Report in their name.

Use the Scheduled Processes work area to run all the processes you have access to and to manage submissions. If you need access to this work area, ask your security administrator to assign you a role that gives you access, for example a custom role with the Manage Scheduled Processes (FND_MANAGE_SCHEDULED_PROCESSES_PRIV) privilege. Other than the Scheduled Processes work area, you might be also able to run certain processes from other work areas.

Jobs and Job Definitions

Each scheduled process that you run is based on a job. The job is the executable that controls what the process does. Each job needs a job definition, which, for example, determines the parameters and other options you have for the process. You or your administrator can create job definitions for Oracle Analytics Publisher reports so that users can run the reports as scheduled processes.

Process Sets

A process set is a scheduled process that contains multiple processes or even other process sets. So, when you submit a process set, you’re running more than process.

Note: When you submit certain scheduled processes, the job logic causes other processes to automatically run. But in this case, you’re not submitting a process set that includes those other processes.
Submission

When you submit a scheduled process, you can use its parameters to control how, and which records are processed. For example, a process includes only the transactions that were edited by the person you select for a Last Updated By parameter. Some scheduled processes don’t have parameters.

As part of the submission, you can also set up a schedule for the process, for example to run once a week for two months. Every time a process runs, there’s a unique process ID.

Output

Some scheduled processes provide output in PDF, HTML, and other formats. For example, a process can import records and also produce output with details about those records. There are many types of output, for example a tax document or a list of transactions.

Related Topics

- Submit Scheduled Processes and Process Sets
- View Status and Other Details for Scheduled Processes
- Cancel or Make Changes to Scheduled Processes
- View Output from Scheduled Processes
- Create Job Definitions to Run Reports as Scheduled Processes
- Best Practices for Scheduled Processes in Fusion Applications

Manage Scheduled Processes for Help Desk Requests

You can set various profile options and schedule job processes for help desk request management.

You must use some of the profile options along with the job processes to achieve the results you want. For example, when you set the profile value for closing a resolved request after N number of days, you should also schedule a job process that closes requests. Run scheduled processes to manipulate a set of records for a specific business need, or to get printable output with information about certain records. Some processes do both. For example, to import records and provide a report about them.

Here’s a table that describes the job processes you can schedule to manage help desk requests.

<table>
<thead>
<tr>
<th>Job Process Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-Close Internal Help Desk Service Requests</td>
<td>Closes requests that were resolved a certain number of days ago, and resolves requests that have been in waiting status for a certain number of days. The number of days for both the scenarios is set using the SVC_ISR_IN_RESOLVED_DAYS, SVC_ISR_IN_WAITING_DAYS profile options respectively.</td>
</tr>
<tr>
<td>Auto-Close HR Help Desk Service Requests</td>
<td>Closes requests that were resolved a certain number of days ago, and resolves requests that have been in waiting status for a certain number of days. The number of days for both the scenarios is set using the SVC_HRHD_IN_RESOLVED_DAYS, SVC_HRHD_IN_WAITING_DAYS profile options respectively.</td>
</tr>
<tr>
<td>Purge Deleted Internal Help Desk Service Requests</td>
<td>Purges requests and their child records that were deleted a certain number of days ago. The number of days is set using the SVC_ISR_IN_DELETED_DAYS profile option.</td>
</tr>
<tr>
<td>Job Process Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Purge Deleted HR Help Desk Service Requests</td>
<td>Purges requests and their child records that were deleted a certain number of days ago. The number of days is set using the SVC_HRHD_IN_DELETED_DAYS profile option.</td>
</tr>
<tr>
<td>Purge Inbound Messages</td>
<td>Purges the successfully processed messages from the inbound message database tables, based on the retention days specified in the SVC_INBOUND_MSG_RETENTION_DAYS profile option. If the SVC_INBOUND_ENABLE_FAILED_MESSAGE_PURGE profile option to set to Yes, this job also purges inbound messages that failed or weren't processed successfully. This job and the corresponding profile options are shared with B2B Service.</td>
</tr>
<tr>
<td>Load and Update Cloud Metrics for Service</td>
<td>Performs incremental loading and updating of usage and business metrics that are targeted to cloud usage patterns.</td>
</tr>
<tr>
<td>Help Desk Request Queue Assignment</td>
<td>Assigns queues to requests. This job takes the following parameters:</td>
</tr>
<tr>
<td></td>
<td>• Work Object Code: Indicates business objects that get assigned to agents, such as, help desk requests. Expected Value: ORA_HRHD_Service_Request_Work_Object or ORA_ISR_Service_Request_Work_Object</td>
</tr>
<tr>
<td></td>
<td>• Candidate Object Code: Indicates objects that are the possible pool of assignment candidates, such as queues. Expected Value: ORA_HRHD_Queue_Candidate_Object or ORA_ISR_Queue_Candidate_Object</td>
</tr>
<tr>
<td></td>
<td>• Assignment Mode (List of Values: Classification, Matching, Scoring, Territory): Indicates the type of assignment processing. Matching is the only mode that’s supported.</td>
</tr>
<tr>
<td></td>
<td>• View Criteria Name: Indicates the view criteria used to identify the requests to be assigned. Expected Value: OpenSRsUnassignedToQueueByStripeCd</td>
</tr>
<tr>
<td></td>
<td>• Bind Variable: Indicates the bind variables required for the view criteria. Expected Value: bindStripeCd=ORA_SVC_HRHD or bindStripeCd=ORA_SVC_ISR</td>
</tr>
<tr>
<td></td>
<td>• Metrics Logging Interval (default value is 100): Indicates the number of work objects in a subprocess before logging assignment metrics, such as update metrics after processing 100 requests. This is used if your object support Enterprise logging for assignment.</td>
</tr>
<tr>
<td></td>
<td>• Diagnostic Mode (check box): Indicates if the process must be run in diagnostic mode to view the details of assignment processing in an output log.</td>
</tr>
<tr>
<td><strong>Note:</strong> This job is shared with B2B Service but should be set up with a separate parameter for Help Desk.</td>
<td></td>
</tr>
<tr>
<td>Service Configuration Setup</td>
<td>Schedules service setup jobs, such as metrics. This job must be run once during implementation. Ensure that you run this job before you create requests.</td>
</tr>
<tr>
<td>Aggregate Service Requests</td>
<td>Enables querying request data for reporting, using the CRM - CRM Service Request Summary subject area. The recommended frequency for running this job is one hour.</td>
</tr>
<tr>
<td>Job Process Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If you need faster data refreshes, increase the frequency. However, this impacts the performance of the transaction system.</td>
</tr>
<tr>
<td>This job is shared with B2B Service.</td>
<td></td>
</tr>
<tr>
<td>Monitor Service Request Milestones</td>
<td>Ensures that the request and milestone status are up-to-date and sends an email notification if compliance issues or warning flags are found.</td>
</tr>
<tr>
<td>This job is shared with B2B Service.</td>
<td></td>
</tr>
<tr>
<td>Purge Service Event History</td>
<td>Evaluates the processed records and retains the data for the days specified in the profile option SVC_EVENT_HISTORY_DAYS_TO_KEEP, while it purges the rest. The recommended frequency for running this job is daily.</td>
</tr>
<tr>
<td>This job is shared with B2B Service.</td>
<td></td>
</tr>
<tr>
<td>Monitor Action Plan Actions</td>
<td>Evaluates the status of an action plan.</td>
</tr>
<tr>
<td>This job is shared with B2B Service.</td>
<td></td>
</tr>
<tr>
<td>Execute Incremental Load of Cross-Channel Interaction Data for Reporting</td>
<td>Incrementally loads cross-channel interaction data, for reporting using the CRM - CRM Interaction Aggregate subject area. You must run this job daily to load and update the new data everyday.</td>
</tr>
<tr>
<td>This job is shared with B2B Service.</td>
<td></td>
</tr>
<tr>
<td>Execute Full Load of Cross-Channel Interaction Data for Reporting</td>
<td>Fully loads cross-channel interaction data, or refreshes the data based on a particular date, for reporting using the CRM - CRM Interaction Aggregate subject area. This is an on-demand job. You must run this job in the following scenarios:</td>
</tr>
<tr>
<td></td>
<td>• The first time data is loaded.</td>
</tr>
<tr>
<td></td>
<td>• Any time the data needs to be refreshed from a specific date.</td>
</tr>
<tr>
<td>This job is shared with B2B Service.</td>
<td></td>
</tr>
<tr>
<td>Refresh Service Categories for Reporting</td>
<td>Generates the service category hierarchy and stores it in the SVC_CATEGORIES_CF table in a flattened form for ease of reporting. Service category attributes in all service request subject areas obtain data from this table. This process needs to be scheduled to pick up changes to the service category hierarchies to ensure accurate reporting. The recommended frequency for running this job is 1 hour.</td>
</tr>
<tr>
<td>This job is shared with B2B Service.</td>
<td></td>
</tr>
<tr>
<td>Migrate Service Business Unit Data</td>
<td>Migrates the following business objects from one business unit (BU) to another:</td>
</tr>
<tr>
<td></td>
<td>• Category</td>
</tr>
<tr>
<td></td>
<td>• Channel</td>
</tr>
<tr>
<td></td>
<td>• Milestone Configuration</td>
</tr>
<tr>
<td></td>
<td>• Service Request</td>
</tr>
<tr>
<td>This job is shared with B2B Service.</td>
<td></td>
</tr>
</tbody>
</table>
Configure a Scheduled Process

Here's how you configure a scheduled process:

1. Sign in to the application as an administrator.
2. From the Navigator, select Scheduled Processes. The Scheduled Processes Overview page is displayed.
4. Select Job as the Type option.
5. In the Name drop-down list, click Search to search and select the process that you want to configure.
6. In the Process Details dialog box for the selected job, click Advanced.
7. On the Schedule tab, select Using a schedule as the Run option.
8. Specify the Frequency for the job.
9. Select the Start Date and End Date for the job.
10. Click Submit.

Note: The scheduled process is visible only to the user who creates the job.

How a Request Is Closed

A help desk request is closed automatically when the Auto-Close HR Help Desk Service Requests or Auto-Close Internal Help Desk Service Requests scheduled process runs as scheduled.

This process closes help desk requests that were resolved a certain number of days ago. The number of days for this scenario is set using the SVC_ISR_SR_IN_RESOLVED_DAYS and SVC_HRHD_SR_IN_RESOLVED_DAYS profile options. These mentioned scheduled processes also resolve requests that have been in waiting status for a certain number of days. The number of days for this scenario is set using the SVC_ISR_IN_WAITING_DAYS and SVC_HRHD_IN_WAITING_DAYS profile options.

Note: You can see a list of closed help desk requests by using advanced search, but you can't manually set the status of a request to Closed. Also, after a help desk request is closed, you can't edit the request, add a message, or reopen it.
Profile Options

Overview of Profile Options

Profile options let you configure and control application data centrally. Administrators and setup users manage profile options in the Setup and Maintenance work area.

Profile options store various kinds of information. This table lists some examples:

<table>
<thead>
<tr>
<th>Type of Information</th>
<th>Profile Option Setting Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>User preferences</td>
<td>Set preferences at the user level</td>
</tr>
<tr>
<td>Installation information</td>
<td>Identify the location of a portal</td>
</tr>
<tr>
<td>Configuration choices</td>
<td>Change UI skins and actions</td>
</tr>
<tr>
<td>Processing options</td>
<td>Determine how much information to log</td>
</tr>
<tr>
<td>Enabling the Activity Stream</td>
<td>Enable agents to see the Activity Stream</td>
</tr>
</tbody>
</table>

Profile Option Hierarchy Levels

Profile options can be set at different levels, such as site level or user level. The application gives precedence to certain levels over others, when multiple levels are set. The levels that are allowed to be set are preconfigured with the application.

In the predefined profile option levels, the hierarchy levels and their precedence are:

1. Site: This level affects all applications for a given implementation. The application gives it the lowest precedence when other levels are set. If no other levels are set, however, it's the highest level.
2. Product: This level affects a product or product family. The application gives it priority over Site level. However, if the user level is set, the user level takes precedence.
3. User: This level affects only the current user. It has the highest precedence, over Site and Product.

As a best practice, set site-level profile option values before specifying values at any other level (where available). The profile option values specified at the site-level work as the default until profile option values are specified at the other levels.

This table shows an example of the predefined profile option hierarchy levels and their priorities.
Lookups, Profile Options, and Scheduled Processes

<table>
<thead>
<tr>
<th>Level</th>
<th>Priority</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>Lowest</td>
<td>Currency for a site is set to Euros.</td>
</tr>
<tr>
<td>Product</td>
<td>Supersedes Site</td>
<td>Currency for the product or set of products is set to UK pound sterling.</td>
</tr>
<tr>
<td>User</td>
<td>Highest, supersedes Product</td>
<td>Currency for a user is set to US dollars.</td>
</tr>
</tbody>
</table>

You can find additional information about profile options in the related topics.

**Related Topics**
- Set Profile Option Values
- How can I access predefined profile options?

Help Desk Profile Options

Administrators and setup users manage help desk profile options and schedule job processes from the Setup and Maintenance work area.

Some of the profile options must be used along with job processes to achieve the results you want. For example, after setting the profile value for closing a resolved request after N number of days, schedule a job process that closes requests.

To enable the profile options, follow these steps in Setup and Maintenance:

- Offering: Help Desk
- Functional Area: Help Desk Request
- Task: Manage Profile Options for Internal Help Desk Requests or Manage Profile Options for HR Help Desk Requests

The following table describes the various profile options for internal help desk requests:

<table>
<thead>
<tr>
<th>Internal Help Desk Profile Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| SVC_ISR_IN_RESOLVED_DAYS          | Defines the number of days after which any resolved request is automatically closed. This profile option must be used along with the Auto-Close Help Desk Requests job process. Make sure the following two conditions are met:  
  - The SVC_ISR_IN_RESOLVED_DAYS profile value must be set to 1 or greater for the Auto-Close Internal Help Desk Service Request job to run.  
  - The SVC_ISR_IN_RESOLVED_DAYS profile value must be set to 0 to disable the Auto-Close Internal Help Desk Service Request job. |
<p>| SVC_ISR_IN_WAITING_DAYS           | Defines number of days for which a help desk request must be in Waiting status before the request is auto resolved. This profile option must be used along with the Auto-Close Internal Help Desk Service Request job process. For more information, see Scheduled Processes for SR Management. |</p>
<table>
<thead>
<tr>
<th>Internal Help Desk Profile Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make sure the following two conditions are met:</td>
<td></td>
</tr>
<tr>
<td>• The SVC_ISR_IN_WAITING_DAYS profile value must be set to 1 or greater for the Auto-Close Internal Help Desk Service Request job to run.</td>
<td></td>
</tr>
<tr>
<td>• The SVC_ISR_IN_WAITING_DAYS profile value must be set to 0 to disable the Auto-Close Internal Help Desk Service Request job.</td>
<td></td>
</tr>
<tr>
<td>SVC_ISR_AUTO_CLOSED_STATUS_CD</td>
<td>Defines the status code to use for auto-closing requests that have been in Resolved status for at least the number of days specified by SVC_ISR_IN_RESOLVED_DAYS. This profile option must be used along with the <strong>Auto-Close Internal Help Desk Service Requests</strong> job process.</td>
</tr>
<tr>
<td>SVC_ISR_AUTO_RESOLVED_STATUS_CD</td>
<td>Defines the status code to use for auto-resolving requests that have been in Waiting status for at least the number of days specified by SVC_ISR_IN_WAITING_DAYS. This profile option must be used along with the <strong>Auto-Close Internal Help Desk Service Request</strong> job process.</td>
</tr>
<tr>
<td>SVC_ISR_DEFAULT_SEVERITY_CD</td>
<td>Sets the default Severity value for a new request.</td>
</tr>
<tr>
<td>SVC_ISR_DEFAULT_STATUS_CD</td>
<td>Sets the default Status code for a new request.</td>
</tr>
<tr>
<td>SVC_ISR_IN_DELETED_DAYS</td>
<td>Defines the number of days after which a deleted request is purged. Although a soft deleted request is in the database, it can't be retrieved or updated from the UI or REST APIs. Once purged, requests are completely removed from the database. This profile option must be used along with the <strong>Purge Deleted Internal Help Desk Service Requests</strong> job process to purge requests. When a soft-deleted request created from an inbound email is purged, all data associated with that request is also purged from the inbound message tables.</td>
</tr>
<tr>
<td>SVC_ISR_PROD_CATALOG_USAGE</td>
<td>Internal Help Desk Request Product catalog usage.</td>
</tr>
</tbody>
</table>

The following table describes the various profile options for HR help desk requests:

<table>
<thead>
<tr>
<th>HR Help Desk Profile Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVC_HRHD_IN_RESOLVED_DAYS</td>
<td>Defines the number of days after which any resolved request is automatically closed. This profile option must be used along with the <strong>Auto-Close HR Help Desk Service Requests</strong> job process. Make sure the following two conditions are met:</td>
</tr>
<tr>
<td>• The SVC_HRHD_IN_RESOLVED_DAYS profile value must be set to 1 or greater for the Auto-Close HR Help Desk Service Requests job to run.</td>
<td></td>
</tr>
<tr>
<td>• The SVC_ISR_IN_RESOLVED_DAYS profile value must be set to 0 to disable the Auto-Close HR Help Desk Service Requests job.</td>
<td></td>
</tr>
<tr>
<td>SVC_HRHD_IN_WAITING_DAYS</td>
<td>Defines number of days for which a HR Help Desk request must be in Waiting status before the request is auto resolved. This profile option must be used along with the <strong>Auto-Close HR Help Desk Service Requests</strong> job process. Make sure the following two conditions are met:</td>
</tr>
<tr>
<td>• The SVC_HRHD_IN_WAITING_DAYS profile value must be set to 1 or greater for the Auto-Close HR Help Desk Service Requests job to run.</td>
<td></td>
</tr>
<tr>
<td>HR Help Desk Profile Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>• The SVC_HRHD_IN_WAITING_DAYS profile value must be set to 0 to disable the HR Help Desk Auto-Close Service Requests job.</td>
<td></td>
</tr>
<tr>
<td>SVC_HRHD_AUTO_CLOSED_STATUS_CD</td>
<td>Defines the status code to use for auto-closing requests that have been in Resolved status for at least the number of days specified by SVC_HRHD_IN_RESOLVED_DAYS. This profile option must be used along with the Auto-Close HR Help Desk Service Requests job process.</td>
</tr>
<tr>
<td>SVC_HRHD_AUTO_RESOLVED_STATUS_CD</td>
<td>Defines the status code to use for auto-resolving requests that have been in Waiting status for at least the number of days specified by SVC_HRHD_IN_WAITING_DAYS. This profile option must be used along with the Auto-Close HR Help Desk Service Requests job process.</td>
</tr>
<tr>
<td>SVC_HRHD_DEFAULT_SEVERITY_CD</td>
<td>Sets the default Severity value for a new request.</td>
</tr>
<tr>
<td>SVC_HRHD_DEFAULT_STATUS_CD</td>
<td>Sets the default Status code for a new request.</td>
</tr>
<tr>
<td>SVC_HRHD_IN_DELETED_DAYS</td>
<td>Defines the number of days after which a deleted request is purged. Although a soft deleted request is in the database, it can't be retrieved or updated from the UI or REST APIs. Once purged, requests are completely removed from the database. This profile option must be used along with the Purge Deleted HR Help Desk Service Requests process. When a soft-deleted request created from an inbound email is purged, all data associated with that request is also purged from the inbound message tables.</td>
</tr>
</tbody>
</table>

The following table describes the various profile options that are shared between Help Desk and B2B Service:

<table>
<thead>
<tr>
<th>Profile Options Shared with B2B Service</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVC_ENABLE_AUDIT_IN_SR</td>
<td>Enables or disables auditing of field value changes.</td>
</tr>
<tr>
<td>SVC_ASSIGN_TO_QUEUE_ON_CREATE</td>
<td>Assigns a Help Desk request to a queue automatically when the request is created.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The preferred way of assigning to a queue is by using Omnichannel assignment. If Omnichannel is enabled, this profile option is ignored.</td>
</tr>
<tr>
<td>SVC_PUID_FORMAT</td>
<td>Defines the format for the unique reference number on each Help Desk request. For example, every Help Desk request number consists of a prefix and radix. Let's say that you select HRHD_ as the prefix and No alphanumeric conversion as the radix. Without this formatting profile option, the Help Desk request numbers are generated as HRHD_1, HRHD_2, and so on. Now suppose you use this formatting profile option and the value is 000000. Then the Help Desk request numbers are generated as HRHD_000001, HRHD_000002, and so on. For more information about configuring the prefix and radix, see “Configure the Prefix and Radix for Help Desk Requests.”</td>
</tr>
<tr>
<td>SVC_INBOUND_ENABLE_FAILED_MESSAGE_PURGE</td>
<td>Enables or disables purging of inbound messages that fail or aren't processed successfully. When the value is set to Yes, the purge job deletes the records corresponding to such messages from the inbound message tables.</td>
</tr>
<tr>
<td>Profile Options Shared with B2B Service</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| **SVC_ATTACHMENT_UI**                  | Defines the attachment view for a Help Desk request. There are thee types of attachment options you can provide:  
|                                        | • Classic: Enables users to select the type of attachment, category, and enter the name and description for each attachment.  
|                                        | • Basic: Enables users to only select file type, browse and upload attachments to the Help Desk request.  
|                                        | • Advanced: Enables users to select the type of attachment, category, and enter the name and description for each attachment. You can also upload files with the drag-and-drop feature, or extract all files after they’re uploaded. |
| **SVC_EVENT_HISTORY_DAYS_TO_KEEP**    | Specifies the number of days for which the Help Desk request event history details such as update and create must be retained. The data beyond this value is purged. |
| **SVC_INBOUND_MSG_RETENTION_DAYS**    | Specifies the number of retention days for successfully processed inbound messages. After the specified number of retention days, the successfully processed inbound messages are deleted from the inbound message tables. |
| **SVC_ENABLE_MESSAGE_CORRECTION**     | Enables you to edit the text of the Internal Note and Employee Entry Help Desk request messages that you have previously created and posted. |
| **SVC_ENABLE_RESOLVE_SR**             | Enables the ready-to-use workflow for resolving a request. This profile option is disabled by default. When enabled, the Resolve Help Desk Request action on the Action Bar opens a dialog box that captures the outcome and resolution, and enables you to enter resolution notes.  
|                                        | **Note:**  
|                                        | If this profile option isn’t enabled, you can still manually set the Help Desk request status to Resolved. |
4 Users and Security

Overview of Users and Security for Help Desk

In this Users and Security chapter, when a topic references CX Sales or B2B Service, that reference includes Help Desk since Help Desk is part of both products.

Enter Your Company Information and Corporate Currency

These steps are required if you haven't previously configured Fusion Sales in your instance.

What you have to do is enter basic information in the Sales: Setup page about your company and specify your corporate currency. Your entries are required for internal application purposes only and are required for your instance of Fusion Service. The information you enter creates a rudimentary enterprise structure and isn't visible to service organization users or customers.

When you finish this procedure you will have:

- Created a rudimentary enterprise structure required for internal application purposes only.
- The enterprise structure isn't visible to service organization users or their customers.
- Created a set of automatic role-provisioning rules that provision users with the required security roles.

This is a one-time setup. After you enter the information on the Create Company Information page, the page becomes read-only and the title changes to Review Company Information.

So, enter your company information and corporate currency by doing the following:

1. Open the task from the Setup: Sales page by clicking the Quick Setup icon for the Company Profile functional area (the gears icon highlighted by callout 1 in the following figure). If any changes are required after your initial setup, you can open the appropriate tasks in the Task area.
2. In the Create Company Information page, enter your company name in the Enterprise Name field.
3. Enter the country where your company is located.
4. Enter your company street address. Don’t enter city or state and other information.
5. The first and last name fields list the names of the user who signed into the application. You can edit the entries.
6. When you’re satisfied that the information is correct, click Submit.
   - The application runs a background process to create the enterprise structure and create the role-provisioning rules.
7. Optionally, click Refresh to monitor the progress of the process.
   - When the process completes, the Review Company Information page appears. The page displays both the information that you entered and the information that the process created for you. You can’t edit any of the
fields except Corporate Currency. None of the names you see are visible to salespeople, so they don’t have to correspond to any actual entities in your organization. The following table lists and describes the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enterprise Name</td>
<td>The name you entered.</td>
</tr>
<tr>
<td>Address</td>
<td>The street address you entered.</td>
</tr>
<tr>
<td>Legal Entity</td>
<td>The enterprise name followed by the letters LE.</td>
</tr>
<tr>
<td>Business Unit</td>
<td>The enterprise name followed by the letters LE BU.</td>
</tr>
<tr>
<td>Initial User</td>
<td>Name of the user who’s signed in.</td>
</tr>
<tr>
<td>Corporate Currency</td>
<td>By default, the corporate currency is US Dollar. Select a different corporate currency, if required.</td>
</tr>
</tbody>
</table>

This image shows the Corporate Currency field.

8. If your company uses a different currency than the US Dollar select the currency from the Corporate Currency list.

9. Record the Legal Entity and Business Unit names. You must enter these names when importing users.

10. Click Save and Close.

Overview of Help Desk Roles

Provision the roles to enable access to Help Desk. These roles include:
Internal Help Desk
- Internal Help Desk Administrator
- Internal Help Desk Agent
- Internal Help Desk Manager
- Internal Help Desk User

HR Help Desk
- Next Gen Human Resources Help Desk Administrator
- Next Gen Human Resources Help Desk Agent
- Next Gen Human Resources Help Desk Manager
- Next Gen Human Resources Help Desk User

Both HR Help Desk and Internal Help Desk
- Knowledge Analyst
- Knowledge Manager
- Employee

**Note:** Help Desk Users that own help desk requests (for example, agents and managers) must be set up as Resources. This happens during the creation of an Employee record in the New Person UI. Once you save the new employee record with a selected Resource Role, a TCA party is created for the resource. A new resource then shows up in the Resource Directory, which may or may not be associated with a Resource Organization. From the Resource Directory, you can put the resource into the correct Resource Organization at the correct level. This resource hierarchy setup is required for team reporting to roll up to a manager. Also, for manager visibility of Help Desk requests that the agents on their team are working on.

**Related Topics**
- Overview of Resources and Resource Management

---

**Overview of Steps to Create Users**

Here are the steps you need to follow to create users and resources:

1. Define and Create Setup Users
2. Create Help Desk Users with Next Gen Human Resource Help Desk User or Internal Help Desk user roles
3. Set up Resource Users for Agents and Managers
4. Set up Resource Team and Resource Hierarchy
5. Synchronize Worker Data
Overview of Setting Up Users and Security

Since you followed the Implementing Sales guide steps to set up your initial set of users, then you already know that Oracle applications use a role-based access control security model to secure access to functionality and data.

In a role-based access control security model, users are assigned roles, and roles are assigned access privileges to protected system resources.

Sales users who access the transactional UI, for example sales representatives working in leads and opportunities, are created as resources and are known as sales resources.

Default Preferences

To set up default preferences for users and roles, access the Security Console as a setup user or other user with the IT Security Manager job role. Only setup users, or other users with the IT Security Manager job role, can access the Security Console. See the Securing Fusion Sales and Service guide for more information.

User Identity Store

The Lightweight Directory Access Protocol (LDAP) identity store is a repository of user identity data. Your LDAP directory stores definitions of LDAP user accounts. In general, changes you make to user accounts are automatically synchronized between the sales application and your LDAP directory server. However, you must also run processes on a daily basis to manage the information exchange between your application and the LDAP directory server. For information, see the chapter about setting up application security in the Securing Fusion Sales and Service guide.

Setup Tasks in the UI and Other Setup Options

As a setup user, you use multiple different tasks in Setup and Maintenance to create and maintain users. You also have additional setup options to consider. The following table describes these tasks and setup options.

<table>
<thead>
<tr>
<th>Setup Task or Option and Navigation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Job Roles Task</td>
<td>Oracle provides many predefined job roles. The relevant sales roles are listed in the Implementing Sales guide. You perform the Manage Job Roles task to:</td>
</tr>
<tr>
<td>Manage Duties Task</td>
<td>You perform the Manage Duties task to:</td>
</tr>
<tr>
<td>Manage Sales and Service Access Management Task</td>
<td></td>
</tr>
</tbody>
</table>

This task opens the Roles tab of the Security Console.
<table>
<thead>
<tr>
<th>Setup Task or Option and Navigation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Data Security Policies Task</td>
<td>You use the Manage Data Security Policies task to manage the data security policies that determine grants of entitlement to a user or role on an object or attribute group. This task opens the Roles tab of the Security Console.</td>
</tr>
<tr>
<td>Manage Sales and Service Access Task</td>
<td>You can also use the Manage Sales and Service Access task to review and configure data security. This task opens the Sales and Service Access Management work area. For information, see the Securing Fusion Sales and Service guide.</td>
</tr>
<tr>
<td>Manage Users Task</td>
<td>You create application users in the UI using the Manage Users task. A user with the IT Security Manager job role performs the Manage Users tasks.</td>
</tr>
<tr>
<td>Manage HCM Role Provisioning Rules Task</td>
<td>Oracle provides predefined role mapping rules for provisioning many of the standard job roles included with the application. However, using the Manage HCM Role Provisioning Rules task, you can create any additional role mappings you need to, to control the provisioning of roles to application users. For example, you can create a role mapping to provision the Channel Sales Manager role automatically to specific sales managers.</td>
</tr>
<tr>
<td>Import and Export Management</td>
<td>You can import users in bulk using data files. For information on the user import options available, see the Understanding Import and Export Management for Fusion Sales and Service and Implementing Sales guides.</td>
</tr>
<tr>
<td>Import Partner Users Task</td>
<td>You can also import partner contact data using the Import Partner Users task. For more information, see the Getting Started with Your Partner Relationship Management Implementation guide.</td>
</tr>
<tr>
<td>Single Sign-On Authentication</td>
<td>Single sign-on authentication is optionally available for user authentication. If your enterprise has moved from a traditional on-premises environment to an Oracle Cloud implementation, you might want to use your existing identity management solution for authenticating your employees, and you might also want to provide a single sign-on experience. Implementing federated single sign-on lets you provide users with single sign-on access to applications and systems located across organizational boundaries. For additional information, see Oracle Applications Cloud Service Entitlements (Doc ID 2004494.1) on My Oracle Support at <a href="https://support.oracle.com">https://support.oracle.com</a>.</td>
</tr>
<tr>
<td>Resetting User Passwords</td>
<td>Setup users provisioned with the IT Security Manager job role can use the Users tab in the Security Console work area to reset passwords for all application users. Users who can't access the Security Console can reset only their own passwords using the Set Preferences link in the Settings and Actions menu available by clicking their user name in the application or by using the Forgot Password link on the sign-in page. See the Implementing Sales guide for more information.</td>
</tr>
<tr>
<td>Updating Email Addresses</td>
<td>Use the Users tab in the Security Console work area to change user email addresses. You can use the procedure described in this topic to update addresses of both setup users and sales users. If you're updating the email addresses of sales users, then you can also use the same import process you use to create them. See the Implementing Sales guide for more information.</td>
</tr>
</tbody>
</table>
Note: Other data security tasks listed in the Users and Security functional area task list don't apply to the sales applications. Follow the guidance in the Implementing Sales and Securing Fusion Sales and Service guides.

Related Topics
- Set General Preferences for All Users
- Subject Areas for Adoption and Usage Reporting

Resource Team Information

Manage Resource Teams

This procedure describes how to manage resource teams. A resource team is a temporary group of resources formed to complete a business task. A resource team can't be hierarchically structured and isn't intended to implement an organization.

Create Resource Teams

To create resource teams:

2. Click the Create action menu option or button.
   The Create Team page appears.
3. Enter an appropriate team name.
4. Optionally, enter a team description and specify team usage, resource members, and organization members.
5. Click Save and Close.

Edit Resource Teams

To edit resources teams:

2. Search for the resource team that you want to edit.
   You can search by entering criteria such as the team name, number, and usage. You can also use the saved searches.
3. Select the resource team you want to edit from the Search Results region and click its name to navigate to the Edit Team page.
4. On the Edit Team page, you can edit the team's details such as the team name, description, usage, resource members and organization members.
5. Click Save and Close.
How Resources Work Within a Team

This topic explains how resources work within a team.

You can include resources from different resource organizations to work together on a work object as members of the same resource team. You can also include the entire resource organization into a resource team. The resource organization membership and their hierarchy determine what a resource can do. Resource teams provide a flexible way of bringing resources together without any organizational or hierarchy-based restrictions.

Assigning Resources to Teams

You can assign identified resources to teams and assign them roles within the team. Each resource can have a specific role within a team. A resource may play different roles in different teams.

How Resource Team Membership and Role Assignment Components Work Together

This topic explains the team membership and role assignment for resources.

Resources who are team members can be assigned different roles within the team. These roles don't necessarily reflect the roles these resources might play in resource organizations. Depending on the task requirements of the team, roles are assigned to resources. Based on the role assignment, resources can access data related to the tasks in the team.

You can manage the resources in a team using the Manage Resource Teams task. You can access the Manage Resource Teams task as follows: Click Navigator > Resource Directory > Tasks > Manage Resource Teams.

Resource Team Membership

A resource can belong to multiple teams depending on the requirements of these teams and the skills that the resource offers. This doesn't affect the resource's membership with organizations within the deploying company.

Role Assignment

Resources have specific roles to play in the team to which they belong. Each of these roles can be different. Also, these roles can be different from the roles assigned to the same resources in resource organizations. Thus, a resource can be a manager in one team and a member in another simultaneously.

FAQs for Defining Resource Team Information

What's a resource team?

A resource team is a group of resources formed to work on work objects. A resource team can comprise resource organizations, resources, or both. A resource team is neither hierarchically structured nor intended to implement an organization structure.
You can use resource teams as a quick reference to groups of related resources to which you can quickly assign work objects.

**Note:** You can either individually assign the members of a team to a task or assign entire teams to tasks.

**What's the difference between a resource organization and a resource team?**

A resource organization is an organization whose members are resources. Resource organizations are used to implement sales organizations, partner organizations, and so on.

A resource team is a temporary group of resources formed to work on work objects. A resource team may contain a resource organization or resources or both. A resource team can’t be hierarchically structured and isn’t intended to implement an organization.

**Can I assign multiple resource roles to a team member at the same time?**

Yes. Resources within resource teams can have multiple resource roles. You can add roles to a resource in a resource team using the Manage Resource Teams task. Select the resource and click the Edit button to assign additional roles to the resource.

**About Security Roles for Help Desk**

Many job roles and duty roles are predefined in the Help Desk and HR Help Desk offerings.

The following table lists **job roles** for Internal Help Desk and HR Help Desk:

<table>
<thead>
<tr>
<th>Job Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal Help Desk Administrator</td>
<td>Manages setup and configuration.</td>
</tr>
<tr>
<td>Next Gen Human Resources Help Desk Administrator</td>
<td></td>
</tr>
<tr>
<td>Internal Help Desk Agent</td>
<td>Creates requests on behalf of employees and manages requests.</td>
</tr>
<tr>
<td>Next Gen Human Resources Help Desk Agent</td>
<td></td>
</tr>
<tr>
<td>Internal Help Desk Manager</td>
<td>Manages a group of Agents (as defined in the Resource Hierarchy) or is responsible for reviewing and analyzing help desk metrics.</td>
</tr>
<tr>
<td>Next Gen Human Resources Help Desk Manager</td>
<td></td>
</tr>
<tr>
<td>Internal Help Desk User</td>
<td>Requests support to resolve their questions and issues.</td>
</tr>
<tr>
<td>Next Gen Human Resources Help Desk User</td>
<td></td>
</tr>
</tbody>
</table>
The following table lists the **duty roles** specific to the Help Desk offering.

<table>
<thead>
<tr>
<th>Duty Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal Service Request Administration</td>
<td>Manage all aspects of help desk requests. In addition, can manage queues and administer the help desk service application, including setup.</td>
</tr>
<tr>
<td>HR Service Request Administration</td>
<td></td>
</tr>
<tr>
<td>Internal Service Request Analysis</td>
<td>Manages group of agents. Can view requests, activities, and attachments. Monitors metrics and overall resource balancing, critical requests, SLA's.</td>
</tr>
<tr>
<td>HR Help Desk Analysis</td>
<td></td>
</tr>
<tr>
<td>Internal Service Request Creation</td>
<td>Requests support to resolve their related questions and issues.</td>
</tr>
<tr>
<td>HR Service Request Creation</td>
<td></td>
</tr>
<tr>
<td>Internal Service Request Management</td>
<td>Manages all aspects of the request object.</td>
</tr>
<tr>
<td>HR Service Request Management</td>
<td></td>
</tr>
</tbody>
</table>

**Related Topics**
- [Overview of Role-Based Access Control](#)
- [Create Rules to Automatically Provision Job Roles to Sales Users](#)

**Remove Data Security Policies from Users for Help Desk**

If your users have existing help desk duty roles and you don't want them to view all the help desk requests that they can currently view, you must remove those data security policies from the users.

To remove the data security policies from your users:

1. Copy the predefined duty roles given to your users.
   
   For more information about copying roles, see "Copying and Editing Duty Roles" in the Oracle Fusion Cloud Customer Experience Securing Sales and B2B Service guide.

2. Remove the data security policies that you don't want these users to have.
   
   For more information about removing or creating data security policies, see "Managing Data Security Policies" in the Oracle Fusion Cloud Customer Experience Securing Sales and B2B Service guide.

**Related Topics**
- [Edit Data Security Policies on the Security Console](#)
- [Create Job and Abstract Roles](#)
- [Copy and Edit Duty Roles](#)
- [Copy Job or Abstract Roles](#)
Set Up a Role With Read-Only Access

Here's how you set up a role with read-only access to the help desk request header alone, or both the help desk request header and messages:

**Note:** These steps use the **HR Service Request Management** duty role and **Next Gen Human Resource Help Desk Agent** job role as examples. You can copy any of the Help Desk job and duty role combinations to create a read-only version of that role. For example, **Internal Service Request Management** duty role and **Internal Help Desk Agent** job role.

1. Sign into the application as an administrator.
2. Navigate to **Security Console**.
3. Copy a **Help Desk** duty role, such as **HR Service Request Management**.
   When copying the role, select the **Copy Top Role** option.
4. Remove the **Edit HR Service Request** privilege or **Edit Internal Service Request** privilege.
5. Copy a Help Desk job role, such as **Next Gen Human Resource Help Desk Agent**.
   When copying the role, select the **Copy Top Role** option.
6. Delete the HR Service Request Management child role from the copied job role.
7. Associate the copied job role with the users who need read-only access to the header alone, or both the header and messages. Ensure that the users don't have other roles that assign them the **Edit HR Service Request** or **Edit Internal Service Request** privilege.

**Related Topics**
- Create Job and Abstract Roles
- Copy and Edit Duty Roles
- Copy Job or Abstract Roles

Data Security Policies

Define Access-Group-Based Data Security Policies

As a Customer Relationship Management Application Administrator you can define access-group-based data security policies on help desk requests. Though predefined data security policies are available, you have the option to define additional data security policies based on access groups.

As compared to SQL-based data security policies, access groups are an alternative way of granting data permissions to users. Instead of creating security policies using SQL, you can use object-sharing rules in the sales and service access management UI to define your visibility criteria.

For more information about creating data security policies, see the Access Groups chapter in the Oracle Fusion: Securing Sales and Service guide.
If you're replacing existing SQL-based data security policies with policies based on access groups, then remember to set an end date for those policies.

Related Topics
- Create a Custom Access Group
- Add Members to Custom Access Groups Using the UI
- Create Custom Object Sharing Rules

Define System-Access-Group-Based Data Security Policies

Let's say you're an HR Help Desk Administrator, Internal Help Desk Administrator or IT Security Manager. Then you can use system access groups and predefined rules to support help desk request data security for your users.

Every standard job role provided by Oracle has a corresponding system access group. The predefined object-sharing rules assigned to each system access group provide the same access to help desk request data as provided by the standard job roles.

**Note:** System access groups provide you an alternative way to manage a user's access to help desk request data. You can also create access extension rules to extend the access provided by the predefined rules to related objects.

System access groups are active by default. But the predefined object-sharing rules associated with each system access group are inactive by default. So you must activate these rules before you can use them. The association between system groups and predefined rules is also disabled by default. So for each system group, you must also enable the predefined rules you want to apply to the group.

For more information about:
- How to enable the predefined rules for a system access group: See the Oracle Fusion Securing Sales and Service guide.
- Managing system access groups for service requests: See "Overview of System Access Groups" in the Oracle Fusion Securing Sales and Service guide.

The following table lists the predefined object-sharing rules for system access groups along with their descriptions.

<table>
<thead>
<tr>
<th>S. no.</th>
<th>Predefined rule name</th>
<th>This rule provides access to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>All Service Requests</td>
<td>All service requests.</td>
</tr>
<tr>
<td>2</td>
<td>All CRM Service Requests</td>
<td>Access to all CRM service requests.</td>
</tr>
<tr>
<td>3</td>
<td>CRM Business Unit Service Requests</td>
<td>All CRM service requests associated with the user's business units.</td>
</tr>
<tr>
<td>4</td>
<td>CRM Partner Service Requests</td>
<td>All CRM partner service requests.</td>
</tr>
<tr>
<td>5</td>
<td>CRM Business Unit Partner Service Requests</td>
<td>CRM partner service requests associated with the user's business units.</td>
</tr>
<tr>
<td>S. no.</td>
<td>Predefined rule name</td>
<td>This rule provides access to:</td>
</tr>
<tr>
<td>-------</td>
<td>-----------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>6</td>
<td>CRM Service Request Queue Member</td>
<td>All CRM service requests assigned to queues that the user is a member.</td>
</tr>
<tr>
<td>7</td>
<td>CRM Service Request Queue Member Hierarchy</td>
<td>All CRM service requests assigned to queues that the user’s subordinates are a member.</td>
</tr>
<tr>
<td>8</td>
<td>CRM Service Request Team</td>
<td>All CRM service requests where the user is on the SR team.</td>
</tr>
<tr>
<td>9</td>
<td>CRM Service Request Team Hierarchy</td>
<td>All CRM service requests where the user’s subordinates are on the SR team.</td>
</tr>
<tr>
<td>10</td>
<td>CRM Service Request Assignee</td>
<td>All CRM service requests where the user is the assignee.</td>
</tr>
<tr>
<td>11</td>
<td>CRM Service Request Assignee Hierarchy</td>
<td>All CRM service requests where the user’s subordinates are the assignee.</td>
</tr>
<tr>
<td>12</td>
<td>CRM Service Request Creator</td>
<td>All CRM service requests where the user created the SRs.</td>
</tr>
<tr>
<td>13</td>
<td>CRM Service Request Creator Hierarchy</td>
<td>All CRM service requests where the user’s subordinates created the SRs.</td>
</tr>
<tr>
<td>14</td>
<td>CRM Service Request Partner Account</td>
<td>All service requests where the SR is associated with the user’s partner account.</td>
</tr>
<tr>
<td>15</td>
<td>CRM Service Request Contact</td>
<td>All CRM service requests where the user is an SR contact.</td>
</tr>
<tr>
<td>16</td>
<td>All HR Service Requests</td>
<td>All HR service requests.</td>
</tr>
<tr>
<td>17</td>
<td>HR Business Unit Service Requests</td>
<td>All HR service requests associated with the user’s business units.</td>
</tr>
<tr>
<td>18</td>
<td>HR Service Request Queue Member</td>
<td>All HR service requests assigned to queues that the user is a member of.</td>
</tr>
<tr>
<td>19</td>
<td>HR Service Request Queue Member Hierarchy</td>
<td>All HR service requests assigned to queues that the user’s subordinates are a member of.</td>
</tr>
<tr>
<td>20</td>
<td>HR Service Request Team</td>
<td>All HR service requests where the user is on the SR team.</td>
</tr>
<tr>
<td>21</td>
<td>HR Service Request Team Hierarchy</td>
<td>All HR service requests where the user’s subordinates are on the SR team.</td>
</tr>
</tbody>
</table>
### Define Access Group-Based Data Security Policies for Messages

You can define access group-based data security policies on help desk request messages.

Access groups are an alternative way of granting data permissions to users, compared to SQL-based data security policies. You can use object-sharing rules in the Sales and Service Access Management UI to define your visibility criteria.

You can create custom data security policies on help desk request messages by using a user-friendly administration UI. You don’t need to know SQL to create these policies.

If you don’t want to use an existing access group, complete the following tasks:

1. Create a new access group.
2. Add members to the access group.
3. Create an object-sharing rule to grant access to help desk request messages for all the access group members.

**Note:** For more detailed information about the above steps, see the Oracle Fusion Securing Sales and Service guide.

### Related Topics
- Create a Custom Access Group
- Add Members to Custom Access Groups Using the UI
- Create Custom Object Sharing Rules

---

### Table: Predefined Rule Names

<table>
<thead>
<tr>
<th>S. no.</th>
<th>Predefined rule name</th>
<th>This rule provides access to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>22</td>
<td>HR Service Request Creator</td>
<td>All HR service requests where the user created the SRs.</td>
</tr>
<tr>
<td>23</td>
<td>HR Service Request Primary Contact</td>
<td>All HR service requests where the user is the SR primary contact.</td>
</tr>
<tr>
<td>24</td>
<td>HR Service Request Assignee</td>
<td>All HR service requests where the user is the assignee.</td>
</tr>
<tr>
<td>25</td>
<td>HR Service Request Assignee Hierarchy</td>
<td>All HR service requests where the user’s subordinates are the assignee.</td>
</tr>
</tbody>
</table>

### Related Topics
- Create a Custom Access Group
- Add Members to Custom Access Groups Using the UI
- Create Custom Object Sharing Rules
Define Access Group-Based Data Security Policies for Categories

You can define access group-based data security policies on service categories.

Access groups are an alternative way of granting data permissions to users as compared to the SQL-based data security policies. You can use object-sharing rules in the Sales and Service Access Management UI to define your visibility criteria.

To define access-group-based data security policies for service categories:

1. Create a new access group if you don’t want to use an existing access group.
2. Add members to the access group.
3. Create an object-sharing rule to grant the access group members access to service categories.

**Note:** For more detailed information about the above steps, see the Oracle Fusion Cloud Securing Sales and Fusion Service guide.

Related Topics

- Create a Custom Access Group
- Add Members to Custom Access Groups Using the UI
- Create Custom Object Sharing Rules

Restrict Contact Search Results

You can restrict the user’s visibility of contacts in the contact picker based on HCM data security visibility.

By default, all contacts are displayed in the contact picker for the Human Resource Analyst. To restrict their visibility, use the ORA_HELPDESK_CONTACT_DATASECURITY profile option. Here’s how to enable that profile option:

1. Navigate to Setup and Maintenance.
2. Click the Tasks icon.
3. Click the Search link.
4. Enter Manage Administrator Profile Values in the Search field.
5. Click Search.
6. Click the Manage Administrator Profile Values link.
7. Enter the Profile Option Code ORA_HELPDESK_CONTACT_DATASECURITY.
8. Click Search.
9. In the Profile Values section, change the default PublicPerson to Person. This limits results by HCM data security. The default "PublicPerson" displays all contacts.
10. Click Save and Close.
11. Click Done.
Control User Types Displayed in Contact Picker

You can configure the types of HCM contacts that are visible in the contact picker.

Here’s how you set the profile options to control visibility in the contact picker:

1. Navigate to Setup and Maintenance.
2. Click the Tasks icon.
3. Click the Search link.
4. Enter Manage Administrator Profile Values in the Search field.
5. Click Search.
6. Click the Manage Administrator Profile Values link.
7. In the Search field, enter the profile option code from the following table.
8. Click Search.

<table>
<thead>
<tr>
<th>Profile Option Name</th>
<th>Profile Option Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_HELPDESK_CONTACT_PRIMARY_ASSIGNMENT</td>
<td>Primary All</td>
<td>Determines if all assignments or only the primary assignment is displayed in the search results.</td>
</tr>
<tr>
<td>ORA_HELPDESK_CONTACT_TERMINATED_EMPLOYEES</td>
<td>Active All</td>
<td>Determines if both active and terminated employees or only active employees are displayed in the search results.</td>
</tr>
<tr>
<td>ORA_HELPDESK_CONTACT_ASSIGMENT_TYPE</td>
<td>E, C</td>
<td>Help Desk supports assignment types of Employee (E), Contingent Worker (C), Non-Worker (N) and Pending Worker (P). This profile option lets you either include all types in the contact picker results or just the Employees and Contingent Workers.</td>
</tr>
<tr>
<td></td>
<td>E, C, P, N</td>
<td></td>
</tr>
</tbody>
</table>

9. Select the appropriate profile value.
10. Click the link for the profile option in the search results.
11. Click Save and Close.
12. Click Done.

The default value for each profile option is All.
Synchronize Worker Data Loaded Through HDL in Help Desk

After loading the worker data using HCM Data Loader, Oracle recommends running the "Synchronize Person Records" ESS job to synchronize worker data in Help Desk.

The Synchronize Person Records job is used to create or update corresponding TCA person party records for HCM workers.

To Ensure Workers are Properly Synchronized

To ensure workers are properly synchronized, set the following parameters for the Synchronize Person Records job:

- From Date: Enter the load start date
- To Date: Enter the load end date
- After Batch Load: Yes

**Note:** In the case where the worker data is loaded for more than seven days, you must repeat the process multiple times. In other words, if you have more than seven days, repeat the process (with a maximum date range of seven days) until you’re done.

Here are the steps to run the ESS job.

1. From the Navigator, navigate to Tools > Scheduled Processes.
2. Click the **Schedule New Process** button.
3. Search for and select "Synchronize Person Records" in the **Name** field of the Schedule New Process window.
4. Click **OK**.
5. Enter the **From Date**.
6. Enter the **To Date**.
7. Select Yes from the **After Batch Load** drop-down list.
8. Click **Submit**.

You can confirm the synchronization when you see the worker is available in the Primary Point of Contact attribute picker.

**Note:** The Human Resource Help Desk Administrator job role is required to view all worker data in the picker.

Maintain Party and Location Current Record Information

In order to support additional user types like pending workers and nonworkers, **Maintain Party and Location Current Record Information** creates or updates person party records with the party usage. This is required for these additional worker types to display in the contact pickers.

For more details about this job and corresponding profile options, see **Maintain Party and Location Current Record Information**.
5 Manage Categories and Product Usage Groups

Manage Help Desk Request Categories and Product Usage Groups

Help Desk request categories can help identify the nature of issues reported in help desk requests.

For example, categories can help group requests related to General HR in one category, and requests related to Benefits in another category. Further, categories and child categories can be created to narrow the type of request within one of the ordered groupings.

Administrators can create categories and category hierarchies to group and organize requests depending on their organizational needs. Before creating categories, do the following:

- Create a list of your top-level categories.
- For each top-level category, create a list of child categories.

To create help desk request categories, follow these steps in Setup and Maintenance:

- Offering: Help Desk
- Functional Area: Help Desk Request
- Task: Manage Categories for Internal Help Desk Requests or Manage Categories for HR Help Desk Requests

Create a top-level category:

1. In the Create Category list, select Create Top-Level Category.
2. Enter a name in the Category Name field.
3. Specify if the category must be active, by selecting a value in the Active drop-down list.
4. Enter a unique Category Code for the category.
   - **Note:** Category code must be unique across all Business Units and Application stripe.
5. Create additional top-level categories, as needed.

Create child categories:

1. In the Categories list, select the top-level category for which you want to create child categories.
2. In the Create Category list, select Create Child Category.
3. Enter a name in the Category Name field.
4. Enter a unique Category Code. It must be unique across all business units and application stripes.
5. Specify if the category must be active, by selecting a value from the Active list.
   - The Business Unit Name column displays the BU associated with the top-level category.
6. Create additional child categories, as needed.
   - The child categories appear indented under the top-level category.
   - **Note:** You can set the BU only for the top-level category. The BU on the child categories is automatically set based on the BU of the root category.
Product Usage Groups

Similar to categories, products can also help narrow down service request issues in Help Desk. For example, products can be Payroll Application or Benefits Application. To set up products, use the Manage Product Group Usage setup task in the Setup and Maintenance work area and add products for the Help Desk category.

Related Topics

• Define a Catalog for the Service Offering
Overview of Work Assignments

You use the assignment engine to assign resources (for example, service personnel or territory owners) to the business objects they must work on, such as a service request. Being assigned to business objects gives resources and their manager’s visibility into the business object.

You also use rule-based assignment to assign additional resources to objects.

Candidate and Work Objects

When setting up assignments, you must be familiar with two types of assignment objects: candidate objects and work objects.

- Work objects are the business objects that are assigned, for example,
- Candidate objects are the possible pool of assignment candidates, for example, resources.

Rule-Based Assignment

Rule-based assignment lets you set up additional rules that are used to assign resources to work objects. After you set up the rules containing the conditions that records must meet when resources match the rule conditions, they’re assigned to the object.

For example, you use rules to assign a certain agent to a certain queue when the customer is located in a specific state or region.

Rule-based assignment requires that you plan your rules, create the rules using the rules UI, and set profile options to configure the assignment behavior, in addition to any scheduled processes that must be run.

Assignment Profile Options

Each of the business objects available in assignment has its own set of profile options that enable you to further configure the application behavior.

Scheduled Processes

Scheduled processes are batch jobs that capture data and permit business objects to act on that data. You must schedule several processes when using assignment. See the Service Request Queue Assignment topic in the Oracle Fusion Cloud Sales Understanding Scheduled Processes guide.

Assignment Reports

You use the Diagnostic Dashboard to generate reports about the assigned objects and the volume of territory data involved in assignment.
Assignment Resources

To learn more about assignment, refer to the following resources:

- Online help: Use the keyword `assignment` to search for the relevant topics.
- Assignment Resource Center: See the Assignment Manager Resource Center page on My Oracle Support (Doc ID 1522958.1) for more resources.

Assignment Mappings

How You Export and Import Assignment Objects and Rules Setup Data

You can understand how to export and import assignment objects and rules setup data, along with the points to consider while moving the setup data in this topic.

Almost all application implementations require moving functional setup data from one instance into another at various points in the life cycle of the applications. For example, in an enterprise application implementation, a development or test instance is first deployed before deploying a production instance. You can move functional setup configurations for assignment objects or assignment rules from one application instance into another by exporting and importing configuration packages from the Manage Configuration Packages page.

To export and import assignment setup data, start by defining an implementation project for the required assignment setup task. The following are some of the examples of assignment tasks:

- Manage Customer Center Assignment Objects
- Manage Service Assignment Manager Objects

The Manage Configuration Packages setup task exports the assignment objects or rules setup data.

A configuration package contains the setup import and export definition. The setup import and export definition is a list of setup tasks and their associated business objects that identifies the setup data for export as well as the data itself. You generate the setup export and import definition by selecting an implementation project and by creating a configuration package. The tasks and their associated business objects in the selected implementation project define the setup export and import definition for the configuration package. In addition, the sequence of the tasks in the implementation project determines the export and import sequence.

You can export a configuration package once you create it, or at any time in the future. During export, appropriate setup data is identified based on the setup export definition, and is added to the configuration package. The setup data in the configuration package is a snapshot of the data in the source application instance at the time of export. Therefore, publish the assignment objects and rules before exporting them.

After the export completes, you can download the configuration package as a zipped archive of multiple XML files, move it to the target application instance, and upload and import it. Review and publish the assignment objects and rules setup data in the target application instance to make them available for assignment processing.

For more details, see the chapter about importing and exporting setup data in the Oracle Fusion Using Functional Setup Manager guide.
Points to Consider to Export and Import Setup Data

Based on your implementation, you can follow different approaches while exporting and importing assignment setup data.

Consider the following points:

- Because your implementation is using rule-based assignment, the implementation project must include both the Assignment Objects and Assignment Rules setup tasks.
- Retain the default sequence for the tasks and business objects.

The application lets you delete assignment objects, assignment attributes, rule categories, rule sets, rules, and conditions in an environment, for example test. If that setup data is exported, and then imported into another environment, for example production, the data in the target database isn't removed.

If your implementation plans to import and export setup data for assignment objects and assignment rules, ensure not to delete assignment objects, rule categories, rule sets, and rules. Set them to inactive in case you want to delete them. Additionally, don't delete assignment rule conditions. Instead, set the rule to inactive and then recreate the rule excluding the condition that's no longer needed.

Assignment Rules

Manage Assignment Objects and Assignment Rules for Help Desk

You can use assignment rules to automatically assign Help Desk requests to queues when the requests are created or updated. You can schedule these rules to run automatically.

Help Desk requests and employee objects are treated as work objects and queues are treated as candidate objects. You can define rules to select the best queue for each request. To create the work objects and corresponding rules use the following setup tasks: Manage Service Assignment Objects and Manage Service Assignment Rules.

Defining Help Desk request assignment rules requires some forethought. Before beginning this procedure, you must consider the following:

- The breakout of queues and agent assignment to the queues.
- The attributes of help desk requests you want to use as criteria for your rule assignments.
• The attributes of the employee records that you want to use as criteria for your rule assignments. The available attributes include:
  ◦ Legal Employer or Entity
  ◦ Country
  ◦ Business Unit
  ◦ Department
  ◦ Job
  ◦ Location
  ◦ Bargaining Unit
  ◦ Collective Agreement

• The rule sets you create.
• The rules to include in each role set.

| Note: | The queues must be created prior to following this procedure. |

Manage Help Desk Assignment Objects

In this procedure, you select attributes from the Help Desk request assignment object that you want to make available in your rules. This procedure however, isn’t mandatory, as ready-to-use fields are provided for all the objects.

To manage assignment objects:

1. In the Setup and Maintenance work area, go to the following:
   ◦ Offering: Help Desk
   ◦ Functional Area: Assignment and Routing
   ◦ Task: Manage Service Assignment Objects
   The Manage Service Assignment Objects page appears.
2. Add the queue attributes you want to be available when setting up your rules:
   a. Click HR Help Desk Request Queue or Internal Service Queue.
   b. In the Details region, click the Attributes subtab.
   c. Add attributes to the list by clicking the Add icon, and select View Object Attribute from the drop-down list.
   d. Click Save.
3. Add the help desk request attributes you want to be available when setting up your rules:
   a. Click HR Help Desk Request or Internal Service Request.
   b. In the Details region, click the Attributes subtab.
   c. Add attributes to the list by clicking the Add icon, and select View Object Attribute from the drop-down list.
   d. Click Save.

Manage Help Desk Assignment Rules

In this procedure you define the rules for assignment.
When assigning work items to queues, follow these guidelines when defining your matching rules:

- The rule set must be defined with Number of Candidates = 1. The application allows only one queue to be assigned to a help desk request.

- You have the option to select or deselect the **Use Score** option on a rule set. If you select **Use Score**, then for every rule in the rule set, you must indicate the amount to increase the score when the rule is true. You must then associate the rule set to queues that receive that score. All of the rules in a rule set are executed, and the queue with the highest total score is selected.

- If the rule set has multiple rules and you didn’t select the **Use Score** option, you must define the criteria for each rule to be mutually exclusive from other rules in the rule set. This ensures that the resulting queue assigned by the application is predictable in all situations.

To manage Help Desk request assignment rules:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Help Desk
   - Functional Area: Assignment and Routing
   - Task: Manage Service Assignment Rules

2. On the **Manage Service Assignment Rules** page, select the category **HR Help Desk Request Queuing Rules** or **Internal Service Request Queuing Rules**.

3. Create a new rule set by clicking the **Add** icon in the **Rule Sets** work area, and then enter the required information.

4. Create rules for the rule set by clicking the **Add** icon in the **Rules** work area. The Create Rule screen appears.

5. Enter a name for the rule in the **Name** field.

6. From the **Rule Applies If** drop-down list, select **Any** conditions met.

7. Add a condition by clicking the **Add** icon in the **Conditions** work area, and then define the required attribute.

   **For HR Help Desk:**
   - Select either the **HR Help Desk Queue**, **HR Help Desk Request**, or **HR Help Desk Request Primary Employee Contact** object and the available employee attributes are displayed in the attribute drop-down list.

   **For Internal Help Desk:**
   - Select either the **Internal Service Queue**, **Internal Service Request** or **Internal Service Request Primary Employee Contact**.

If an attribute is hierarchical, such as Category Name and Product Group, **Not In Including Children** and **In Including Children** operators are displayed as choices. They indicate the following.

- **Not In Including Children**: Indicates that the rule applies if the specified attribute value matches the top level of the attribute. This option doesn’t include the attribute values of the children of the current attribute. For example, if the condition is set for the Category Name attribute with value Benefit Enrollment, the rule applies only if the value of the top-level attribute matches Benefit Enrollment.

- **In Including Children**: Indicates that the rule applies if an attribute value matches with any of the attributes in the parent-child hierarchy of the current attribute. For example, if the condition is set for the Category Name attribute with value Benefit Enrollment, the rule applies even if the value of any of the child attributes matches Benefit Enrollment.
8. Optionally, add more conditions.
9. Select a queue to which the requests meeting the conditions must be assigned by clicking the Add icon in the Action Assign Queue work area.
10. Click Save and Publish.

The request assignment is now defined.

**Note:** Republish the assignment rules each time the rule is changed. You also must republish the rules each time the associated queue is deleted, enabled, or disabled.

**Related Topics**
- How You Define Queue Assignment Rules
- Set Up an Offering with Scope

---

**Enable Definition of Rules Based on Tags**

You can define rules based on the tags associated with help desk requests.

For example: If a help desk request is associated with the performance tag, then assign it to the Performance queue. If a help desk request is associated with the testing tag, then assign it to the Testing queue.

**Note:** This procedure is optional. You may want to use tags, but you may still not require rules related to tags.

To enable defining of rules based on help desk request tags:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Help Desk
   - Functional Area: Assignment and Routing
   - Task: Manage Service Assignment Objects
2. On the Manage Service Assignment Objects page, in the Name column, click the arrow next to the object.
3. Click Create Child.
4. In the Name field of the Create Child Assignment Object window, specify the name as Help Desk Request Tags.
5. In the View Object Instance field, select SrTagRules from the drop-down list.
6. Click OK.
7. In the Help Desk Request Tags: Details region of the page, click the Attributes tab.
8. Select the Add icon.
9. In the View Object Attribute column, select Tag from the drop-down list.
10. Click Save.

You can now define rules based on help desk request tags.
Work Assignments

Agent Capacity

Capacity indicates the maximum number of open work items of a certain type that an agent can handle. Capacity is configured at a global level for various types of work items by using the Manage Capacities page.

For example: If the global capacity for an open help desk request is 30, an agent who's working on 30 open requests is considered to be 100 percent occupied.

If a queue has multiple agents, the work item is assigned to the agent with the maximum free capacity of the relevant type. If more than one agent has the same capacity, the work item is assigned to the agent with the maximum overall free capacity.

Agent Presence

Presence indicates whether an agent who has signed in to the application is interacting with the application. Agents set their presence through the Settings and Action menu.

An agent can be online, but may not be available to handle work items. If an agent isn't signed in, then the presence is set to offline.

Agent Availability

Agent availability indicates whether an agent is available. Agents are automatically assigned SRs. They don't need to make themselves available to work help desk requests.

**Note:** Based on the SVC_OMNI_DISABLE_WORK_ITEM_AVAILABILITY_SELECTION profile option setting, the application restricts agents from blocking new work assignments. The application assigns new work to agents until their maximum capacity is reached.

Related Topics
- Enable Omnichannel
- Configure Presence and Availability Privilege

Severity and Age of Requests

Severity indicates the priority of a help desk request. A request is assigned to an agent based on its severity.
This means that a help desk request with a higher severity is taken up earlier for resolution. An administrator can set the values for severity.

The age of a help desk request is also a factor while assigning work. A request that’s waiting in the queue for a longer period of time is given higher priority.

Related Topics
- Add Severity Values to Requests
- Prevent Starvation of Low Priority Work Requests

Default Queue

If you have enabled Omnichannel, there’s a ready-to-use queue named Default. You can set the Default queue to manual or automatic, depending on your company’s requirement.

Be aware that the Default queue contains work items that you can’t place in any other queue because they don’t match any of the defined assignment rules. You can add agents and teams to the Default queue and also modify the queue properties, but you can’t disable or delete this queue.

Note:
- Help desk requests that don’t match any rules are assigned to the Default queue only when Omnichannel is enabled. When Omnichannel is enabled, here’s what happens:
  - If you set the Default queue to automatic, then the work items are automatically assigned to the agents who are available and have free capacity.
  - If you set the Default queue to manual, then the agents must manually assign the work items to themselves.

Here’s what Oracle recommends:
- The preferred way of assigning a help desk request to a queue is by using Omnichannel assignment. Let’s say you have enabled Omnichannel for help desk request assignments. And you may be assigning requests to the Default queue either manually or automatically by using assignment rules or groovy scripts. Either way, it’s important and highly recommended that you assign active agents to the Default queue, so that requests can be assigned to the agents.
- If you set the Default queue to automatic and you don’t assign agents to it, requests assigned to the Default queue could remain unattended and eventually impact performance. You could miss the SLAs and your employees don’t get responses on time.
- If you don’t assign any agents to the Default queue, then you must set the Default queue to manual. But if you set it to manual, you must ensure that the requests are answered.
- Let’s say you assign agents to the Default queue, but you prefer to use it as a catch-all queue and not for automatic assignment of requests to agents. In such cases, you can set the default queue to manual. This would depend on your company’s requirement.

Related Topics
- Enable Omnichannel
Set a Profile Value Greater Than the Average Handle Time

The average handle time is the average duration of one interaction of an agent with an employee.

You must set the profile value for the \texttt{SVC\_STARVATION\_PREVENTION\_NRT\_INTERVAL} to a much higher value than the respective average handle times.

\textit{Related Topics}
- Configure Profile Options to Prevent Work Starvation

How You Assign Work to Agents

Work assignment refers to interactions or work items such as help desk requests being assigned to queues for processing.

Work items are assigned to a queue and an agent is assigned to one or more queues. All work items in a queue are handled by the assigned agents.

A work item can be assigned to an agent manually or automatically based on whether the associated queue is automatic or manual.

\textbf{Note:} In automatic queues, the priority of a request is calculated based on severity and wait time. Help desk requests with highest severity are assigned first. If there are multiple requests with the same severity, those requests that have been in the queue for the longest time are assigned first. But this rule applies only to bigger volumes of requests and a large number of agents and not on a small scale.

Work assignment in an automatic queue is done based on the following aspects:

- Agent capacity
- Availability of the agent
- Presence of the agent
- Severity of the work item
- Age of the work item

\textbf{Note:} Omnichannel must be enabled to use the settings for presence of the agent, availability of the agent, and agent capacity.

Here are the various ways a help desk request can be assigned to an agent:

- Manually set the \textbf{Assigned To} field in the Summary tab of the Help Desk Request Details page.
- Click \textbf{Assign to Me} from the Actions menu on the Help Desk Request Details page.
- Enable Omnichannel.
**Related Topics**
- Enable Omnichannel
- Order in Which Requests are Assigned
- How to Assign Agents to Work Items

---

**Order in Which Requests are Assigned**

Here's how help desk requests in an automatic queue are assigned to agents.

The application calculates the priority of help desk requests based on severity and waiting time. Help desk requests with the highest severity are assigned first. If there are multiple requests with the same severity, requests that have been in the queue for the longest time are assigned first.

**Note:** It's possible that you may see exceptions to this rule when you're testing with a small number of agents. That's because the application is designed to work with millions of help desk requests and thousands of agents per day. And to do that, it has massive parallel processing power.

There are multiple servers in your production environment. Each server tries to assign help desk requests, competing with other servers to assign all the work among all available agents. Requests are assigned on multiple servers in parallel, otherwise the assignment tends to lag behind the incoming work.

Suppose your production environment has 15 servers. The application would act as if it's assigning help desk requests in batches of 15. The requests from 1 to 15 would be assigned before the requests 16 to 30. But the order within each batch isn't guaranteed. The first server that finds an available agent makes the assignment.

---

**How You Assign Work to a Queue**

Here are the various ways in which you can assign a help desk request to a queue:

- Open a request. From the **Queue** drop-down list, manually select the queue to which you want to assign the request.
- Enable Omnichannel, which runs the queue assignment rules when the request is created or when the queue is deleted from the request.
- Click **Run Queue Assignment** from the **Actions** menu, which runs the queue assignment rules.
- Enable the Assign Help Desk Request to Queue on Create profile option, which runs the queue assignment rules when the request is created. The process is described below.
- Schedule the Queue Assignment job that runs the queue assignment periodically and processes all the open requests that aren't assigned to a queue.

The preferred way of assigning a help desk request to a queue is by using Omnichannel assignment. Enabling Omnichannel has the following advantages:

- Enabling Omnichannel provides more features than queue assignment. It also enables the automatic assignment of agents. But if your business only requires queue assignment, you must carefully evaluate whether you need to enable Omnichannel.
• Only if you enable Omnichannel, the request is assigned to the Default queue when the Assignment Manager rules haven't been defined or when the selected request doesn't satisfy any active rule.

• When Omnichannel is enabled, automatic assignment of requests to agents is always enabled on the Default queue.

Suppose you're assigning help desk requests to an automatic queue either manually or automatically by using assignment rules or groovy scripts. If you enable Omnichannel, Oracle recommends that you also assign active agents for the automatic queue, so that requests can be assigned to the agents.

**Note:** If you don't assign agents for the automatic queues, requests assigned to those queues could grow exponentially over time. And this causes the application to slow down.

### Enable the Assign Help Desk Request To Queue On Create Profile Option to Assign a Request to a Queue

Here's how you enable the Assign Help Desk Request To Queue On Create profile option:

1. Sign in to the application as an administrator.
2. In the Setup and Maintenance work area, click the **Tasks** hamburger icon.
3. Click the **Search** link.
4. Enter Manage Administrator Profile Value in the **Search** field and click **Search**.
5. Click the **Manage Administrator Profile Value** task link.
6. Enter SVC_ASSIGN_TO_QUEUE_ON_CREATE in the **Profile Option Code** field.
7. Click **Search**.
8. In the **Profile Value** drop-down list for the Site **Profile Level**, select **Yes**.
9. Click **Save and Close**.

**Note:** If Omnichannel is enabled, this profile option is ignored.

### Add Severity Values to Requests

Help desk request severity indicates the priority of a request. A help desk request of a higher severity bypasses other requests of lower priority in a queue, and is taken up for resolution sooner.

As an administrator, you can set the severity values in the application.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Help Desk
   - Functional Area: Help Desk Request
   - Task: Manage Severities for HR Help Desk Requests or Manage Severities for Internal Help Desk Requests
2. The ORA_SVC_ISR_SEVERITY and ORA_SVC_HRHD_SEVERITY lookup types contain the lookup codes. To add a new severity value, click **Create Severity** and specify the following values.

   - **Lookup Code**: Enter the new lookup code. For example, High Priority.
     
     **Note**: The **Lookup Code** is a text value and must be used for display purpose only. The value that you specify in the **Lookup Code** field doesn't affect the actual severity of a request. The actual severity is determined by the **Severity Ranking** field.

   - **Severity Ranking**: Enter a value that depicts the priority level. A help desk request severity with a lower severity ranking is considered as having higher priority when they are routed to agents. For example, a severity ranking of 2 is considered higher in priority when compared to a severity ranking of 5.

   - **Enabled**: Select to enable the severity value. Help desk requests with disabled severity aren't displayed on the Help Desk Request page.

   - **Start Date** and **End Date**: Specify a date range within which the severity value is valid. If you don't specify a date, the severity value remains valid forever.

   - **Meaning**: Enter an optional meaning for the severity value. For example, for Priority 1, specify the **Meaning** as Critical.

   - **Description**: Enter an optional description.

   - **Tag**: Specify a tag that's used to differentiate a help desk request of a certain severity from the others. For example, specify **Tag** for Priority 1 as COLOR=#ff0000,#FFFFFF to change the color of a Priority 1 request. In this case, a Priority 1 request is displayed in red text with white background.

3. Add more lookup codes as required.

4. After you finish, click **Save and Close**.

**Related Topics**
- How You Assign Work to Agents
- Update Existing Setup Data

---

**Omnichannel**

**Enable Omnichannel**

Automatic routing of work to agents is done through Omnichannel. So, if you want the work assignments for agents to be automatically routed, you must enable Omnichannel.

If you enable Omnichannel, it's enabled for both Fusion Service and Help Desk.

**Note**: To view the Omnichannel tasks, you must enable the **Omnichannel Routing** feature under the **Communication Channels** offering.
### Profile Option Profiles

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVC_INTERACTION_RETENTION_DAYS</td>
<td>Specifies the number of days to retain interactions before they're purged from the database. Must be set to 1 or greater for the job to run.</td>
</tr>
<tr>
<td>SVC_EVENTS_RETENTION_DAYS</td>
<td>Specifies the number of days to retain events before they're purged from the database. Must be set to 1 or greater for the job to run.</td>
</tr>
<tr>
<td>SVC_INTERACTION_DISPLAY_DAYS</td>
<td>Specifies the number of days from the past since when the interactions can be viewed.</td>
</tr>
</tbody>
</table>

To enable Omnichannel and its notifications:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Communication Channels
   - Task: Manage Omnichannel Profile Options
2. In the Manage Omnichannel Profile Options window, complete the following steps for each of the listed profile options:
3. Click the profile option name.
4. Navigate to the Profile Values region of the page.
5. Set the **Profile Value** for the Site **Profile Level** as follows:
   - For the first three profile options in the table, set the value to **Yes** to enable the profile option.
   - For the remaining profile options in the table, specify a suitable value as described.
6. Click **Save**.

#### Related Topics
- Overview of Configuring Offerings
- Configure Offerings
- Update Existing Setup Data

### Set Channel Capacity

Channel capacity indicates the maximum number of active interactions in a channel that can be handled by an agent.

Help Desk supports channel capacity for non-real-time work. Active non-real-time interactions are determined by the qualifying statuses. Any interaction that's in one of the specified qualifying statuses is considered to be an active interaction.

To set channel capacity:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Help Desk
   - Functional Area: Assignment and Routing
   - Task: Manage Capacities
2. To provide queue owners and managers the ability to modify the channel capacities for individuals by overriding the global default capacities:
   In the Override Individual Capacities region, select the Enable Channel Capacities to Be Overridden for Individuals check box.

3. To change the capacity of a non-real-time work:
   a. In the Work Assignments region, modify the default value in the Capacity field to a new value for either HR Help Desk Request or Internal Service Request.
   b. The status in the Qualifying Status Values column indicates the status of the work items that determine the capacity. For example, if the status is set to New, In Progress, only the work items that are in the specified status add up to the total capacity. To specify the active statuses, click the status value.
   c. In the Qualifying Status Values window, select a status from the No Effect on Workload list and move it to the Adds to Workload list to qualify the status as active.
   d. Click Apply.
4. Click Save and Close.

Note: When you export or import the functional setup data for the Service offering by using the export and import feature in Functional Setup Manager, the Manage Capacities setup is also exported or imported. But the value of the Override Individual Capacity check box isn’t exported or imported. You must select or deselect the check box manually.

Related Topics
- How You Assign Work to Agents
- Update Existing Setup Data
- Why You Override Individual Capacity Settings

Configure Presence and Availability Privilege

To set the presence and availability, an agent must be given the Manage Omnichannel Presence and Availability privilege.

This privilege is available by default to the following job roles:
- Next Gen Human Resource Help Desk Agent
- Next Gen Human Resource Help Desk Manager
- Internal Service Request Help Desk Agent
- Internal Service Request Help Desk Manager

To grant the Manage Omnichannel Presence and Availability privilege to any other role, do one of the following in the Security Console:
- Create a role and provide the privilege to the role.
- Copy one of the default job roles with the privilege and create a role to add the privilege.

For more information about copying job roles, see the Oracle Fusion Cloud Customer Experience Securing Sales and Fusion Service guide.

Note: After you add the privilege to the new role, you must associate a user to the new role.
Prevent Work Starvation

Prevent Starvation of Low Priority Work Requests

Sometimes, a burst of high priority requests may prevent the low priority requests from being assigned to an agent for a long time.

Although high priority requests may come in later, they’re assigned first, and the low priority requests are repeatedly kept waiting. That’s because the agents are unable to keep up the pace to serve both.

As an administrator, you can dynamically raise the priority of low priority requests after a certain wait time. The benefits are as follows:

- The wait time for lower priority items is reduced, and this ensures a balance between high priority and low priority requests.
- Lower priority requests are served fairly, thereby improving employee satisfaction.

Configure Profile Options to Prevent Work Starvation

To prevent starvation of work requests having a lower priority, you must configure profile options.

The following table shows the profile options to configure for preventing work starvation.

<table>
<thead>
<tr>
<th>Profile Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVC_ENABLE_STARVATION_PREVENTION</td>
<td>Enable prevention of work starvation to avoid work requests having a lower priority from being ignored while assigning work items to an agent. The default value is No.</td>
</tr>
<tr>
<td>SVC_STARVATION_PREVENTION_NRT_INTERVAL</td>
<td>Specify the number of minutes after which the priority of an unassigned, non-real-time work request is increased for assigning to an agent. The default value is 180 minutes.</td>
</tr>
</tbody>
</table>

**Note:**
You must specify a value greater than the average handle time for a non-real-time work request in your company. For more information, see “Set a Profile Value Greater Than the Average Handle Time”.

<p>| SVC_STARVATION_PREVENTION_NRT_STEP | Specify the step size to increase the priority of a non-real-time work request. The default value is 1. |</p>
<table>
<thead>
<tr>
<th>Profile Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVC_STARVATION_PREVENTION_RT_INTERVAL</td>
<td>Specify the number of seconds after which the priority of an unassigned, real-time work request is increased for assigning to an agent. The default value is 30 seconds. <strong>Note:</strong> You must specify a value greater than the average handle time for a real-time work request in your company. For more information, see “Set a Profile Value Greater Than the Average Handle Time”.</td>
</tr>
<tr>
<td>SVC_STARVATION_PREVENTION_RT_STEP</td>
<td>Specify the step size to increase the priority of a real-time work request. The default value is 1.</td>
</tr>
</tbody>
</table>

To configure the profile options for preventing starvation of work requests having a lower priority:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Help Desk
   - Functional Area: Other Communication Channels
   - Task: Manage Work Starvation Profile Options

2. In the Manage Work Starvation Profile Options page, click **SVC_ENABLE_STARVATION_PREVENTION**.

3. In the SVC_ENABLE_STARVATION_PREVENTION: Profile Values region, set the **Profile Value** for the Site **Profile Level** as Yes.

4. Click **Save**.

5. Complete the following steps for the remaining four profile options in the table:
   a. Select a profile option.
   b. In the Profile Values region, select the Site **Profile Level**.
   c. In the **Profile Value** field, retain the default value or modify the value according to your company’s requirement.
   d. Click **Save**.

### FAQs About Help Desk Requests and Queues

**What happens if a newly created request isn't assigned to a queue?**

If a help desk request is created without an associated queue, and Omnichannel is enabled, then the routing feature selects a queue.

If the queue is automatic, then the routing feature assigns the associated agent for the request. If a request is created with an associated queue, then the routing feature selects only the agent.
What happens if an associated agent is removed from an open request?

If an associated agent is removed from an open help desk request that’s in a status of New or any other active request statuses specified in the Manage Capacities page, then the following happens:

- The routing feature selects a new agent for the help desk request from the resource pool of that queue, based on the capacity of the associated agent.

**Note:** A new agent is selected only if Omnichannel is enabled and the queue is automatic.

**Related Topics**
- Set Channel Capacity

What happens if an open request is disassociated from the current queue?

If an open help desk request is disassociated from the current queue, then the routing feature assigns the request to a new queue, provided the following conditions are true:

- Omnichannel is enabled.
- The **Assigned To** value of the help desk request is empty.

The help desk request is subsequently assigned to an associated agent if the queue is automatic and any assignment rules are rerun. If the disassociated request is in a New status or any other active status specified in the Manage Capacities page, then the agent capacity is calculated before assigning the request to an agent.

**Note:** If you disassociate a help desk request from the current queue, then you must clear the **Assigned To** value to ensure that rerouting takes place.

What happens if a request is reopened?

Here’s what happens when a help desk request is reopened:

- If the reopened request is already associated with an agent, then the request is reassigned to the same agent.
- If the reopened request isn’t assigned to any agent, and Omnichannel is enabled, then the request is assigned to a queue based on the associated assignment rules.

If the queue is automatic, then the help desk request is assigned to an associated agent. Requests are assigned based on the set channel capacity for an agent. Only if an request is in the New, In Progress, or other statuses specified in the
**Qualifying Status Values** column in the Manage Capacities page in Setup and Maintenance, it counts for capacity. If the request isn’t in one of these statuses, it doesn’t count for capacity, and the request isn’t assigned to the agent.

**Note:**
- If the status of a request changes, then it counts for capacity for the agent to whom it’s assigned. For example, when the request status changes from Waiting for Employee to In Progress.
- If the request isn’t assigned to an agent, the routing service starts looking for an agent.

**Related Topics**
- Set Channel Capacity

What happens if I mark an assignment object or one of its attributes as inactive?

When you mark an assignment object as inactive, the selected work or candidate assignment object isn’t available for assignment processing. When you mark an assignment attribute as inactive, the selected work or candidate object attribute isn’t available for assignment processing.

**Note:** The object or attribute can’t be set to inactive if there is a mapping set, mapping, or rule defined using the object or attribute.
7 Email Channels

Configure Help Desk Email

Use the following tasks to configure Help Desk email.

Configuring Outbound Email Profile Options

As one of the most common channels of communication, Help Desk Agents frequently use email to respond to employees and to forward Help Desk requests to other authorized internal resources. In addition, Help Desk uses email to send automatic system responses to employees for events such as the submission of a Help Desk request.

To configure the Help Desk email channel, a number of configuration activities are recommended.

1. In the Setup and Maintenance work area, use the following:
   - Offering: Help Desk
   - Functional Area: Email Communication Channel
   - Task: Manage Outbound Email Profile Options for HR Help Desk Requests Templates

2. Configure the following profile option types with the appropriate System Response Email Templates.
   
   **Note:** If you don't have Help Desk-specific Email Templates, refer to the Related Links section for links to Email Template documentation.

   The following list shows profile codes that end in '_HRD' and are used in HR Help Desk service requests. Non-HR Help Desk service requests can also use similar profile codes, but without '_HRD' at the end.
   - SVC_SR_RESPONSE_TEMPLATE_NAME_HRD
   - SVC_SR_FORWARD_TEMPLATE_NAME_HRD
   - SVC_SR_SYSTEM_RESPONSE_TEMPLATE_NAME_HRD

Creating a Dedicated Help Desk Inbound Email Channel

To ensure the security of sensitive Help Desk communications, Help Desk includes a dedicated inbound email channel that's separate from the email channel that serves all non-Help Desk requests. To ensure the security of Help Desk communications with employees, the behavior of the Help Desk Inbound Email Channel is different from all other Email Channels, which in turn, ensures the security of Help Desk Requests. All email addresses included in email communications through the Help Desk Inbound Email Channel are added as contacts on an associate's Help Desk Request (enabling communications about the request. No other permissions are granted to these associated contacts).

Now, you create a new email channel using the following procedure:

1. In the Setup and Maintenance work area, use the following:
   - Offering: Help Desk
   - Functional Area: Other Communication Channels
Task: Manage Communication Channels

2. Click the **Create Channel** button.

3. In the **Create Channel** view, do the following:
   - a. Expand the **Stripe Code** menu, and select either **HR Help Desk Request Stripe** or **Internal Service Request Stripe**.
   - b. Expand the **Channel Type** menu and choose the channel type you would like to create, such as E-mail.
   - c. In the **Account Name** field, provide the email address for which the channel is intended. For example, HRsupport@yourcompany.com.
   - d. In the **Channel Code** field, specify a code channel that indicates the communication channel.
   - e. In the **Display Name** field, enter the display name that you want for the channel. This is the value that employee users see.
   - f. If multi-BU is enabled, expand the **Business Unit** menu and choose the correct business unit.
   - g. Enable the record by checking the **Active** box.
   - h. Click **Save and Close**.

### Setting Up Forwarding Rules for Email Channels

Now you create a new forwarding rule on your company email server to redirect emails addressed to your organization's Help Desk email account to the Help Desk address that Oracle provided at the time of provisioning. This rule and address are different from the rule and address used for all other service requests. For example, all the support emails that are sent to HRsupport@yourcompany.com are forwarded to pod_name.fa.intservice.incoming@workflow.mail.em2.cloud.oracle.com for processing. The SVC_INBOUND_EMAIL_ADDRESSES profile option indicates the Oracle email ID to which the support mails must be forwarded. Here's how you set this profile option:

1. In the Setup and Maintenance work area, use the following:
   - Offering: Help Desk
   - Functional Area: Email Communication Channels
   - Task: Manage Inbound Email Profile Options

2. Click the **SVC_INBOUND_EMAIL_ADDRESSES** link, and do the following:
   - a. In the **Profile Values** area select New from the Actions drop-down list.
   - b. Click the **Profile Level** drop-down list, and select Site.
   - c. In the **Profile Value** field, enter the Oracle email ID where support email will be forwarded.
   - d. Click **Save and Close**.

It's recommended that you then schedule a reoccurring job to process SR and SR message records as described in the Configuring a Job to Process Inbound Emails procedure.

**Related Topics**
- Configure a Job to Process Inbound Emails
- Set Up an Offering with Scope
How Inbound Messages Are Processed

An inbound message is created when you receive an incoming service email from an employee. This flowchart describes the process flow for an incoming employee email:

1. An employee sends an email requesting support.
2. If an inbound message filter exists, then the filter is applied to the incoming message.
3. If the message is accepted, then an inbound message is created, and any associated attachments are extracted.
4. The message is verified to see if it’s related to an existing help desk request.
   - If the inbound message is related to an existing help desk request:
The related request is identified. If the related request can be edited, then the email content and attachments are added to the request. If the original request can’t be edited, then a new request is created.

- If the inbound message isn’t related to an existing request, then a new request is created.

5. The email ID of the sender is validated against the employee records in the database.

- The primary contact is set to the employee who sends the email. The Account field isn’t updated.
- If the From email ID doesn’t exist in the database, then a message is added to the request that the sender can’t be identified.
- If more than one employee with the same email ID exists in the database, then the following scenarios are possible:

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Primary Contact in the Help Desk Request</th>
<th>Acknowledgment Sent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sender’s email address matches the email address of one employee.</td>
<td>The matching contact is set as the primary contact in the help desk request.</td>
<td>An acknowledgment email is sent to the sender.</td>
</tr>
<tr>
<td>Sender’s email address matches the email address of 2 employees.</td>
<td>No primary contact is set in the help desk request.</td>
<td>An acknowledgment email is sent to the sender. The email states that the sender couldn’t be identified because multiple employees were found with the email address of the sender. Additional information is requested from the sender.</td>
</tr>
<tr>
<td>Sender’s email address matches the email address of 1 resource.</td>
<td>The matching partner is set as the primary contact in the help desk request.</td>
<td>An acknowledgment email is sent to the sender.</td>
</tr>
</tbody>
</table>

6. If any other email IDs in the message in the To or CC fields can be identified, then those IDs are added as contacts.

**Note:** If the other email IDs can’t be identified, then such email IDs aren’t added as employees or help desk request team members. But they’re displayed in the request message.

7. The incoming message content and the attachments are added to the new help desk request.

**Related Topics**
- Overview of Inbound Message Filters
- Create an Inbound Message Filter
Enable Configuration of Email Communications

You must first enable the tasks required to configure inbound and outbound email communications for help desk requests. Only then can you proceed with the configuration.

1. Sign in as an administrator or a setup user.
2. Navigate to the **Setup and Maintenance** work area and select the **Help Desk** offering.
3. Click the **Change Feature Opt In** link.
   
   The Opt In: Help Desk page is displayed.
4. For the **E-mail Communications** feature, select the **Enable** check box.
5. Click **Done**.

The ability to configure inbound and outbound communications is now enabled. Now you're ready to proceed with the configuration.

Configure an Email Channel

To send emails to your employees and to receive emails from them, you must first set up an email channel.

You can create separate email channels for different application stripe codes. For example, one for CRM and one for HCM. However, you can use the same email channel for both inbound and outbound emails:

- **Inbound email**: Indicates the service emails received from your employees. As part of your implementation, you must set up a forwarding rule on your company email server to redirect these emails to Oracle's inbound email ID. This is the same email account that Oracle provided at the time of provisioning. For example, all the support emails that are sent to TechSupport@mycompanydomain.com are forwarded to pod_name.fa.extservice.incoming@pod_name-opcwf.mail.dcsn.oraclecloud.com for processing. The SVC_INBOUND_EMAIL_ADDRESSES profile option indicates the Oracle email ID to which the support mails must be forwarded.

   If it's required for your company, you can also create different support email channels for different business units or divisions. For example, TechSupportDiv1@mycompanydomain.com, TechSupportDiv2@mycompanydomain.com,
and so on. All the support emails sent to these different support email channels are forwarded to pod_name.fa.extservice.incoming@pod_name-opcwf.mail.dcsn.oraclecloud.com for processing.

**Note:** If you're implementing HR Help Desk or Internal Help Desk, then you must define a channel with the appropriate application stripe. The account name of the channel must match the email address of your mailbox from which you're redirecting or forwarding emails to the Oracle mailbox mentioned above. If you don't define the appropriate channel, the requests created for the emails are set with the CRM application stripe. In such cases, you must run an ODI import process to update the application stripes of the SRs.

The SVC_INBOUND_EMAIL_ADDRESSES profile option contains two email IDs:

- For HR Help Desk, use the email ID that contains the text 'intservice' as a part of the ID, as the forwarding email ID.

**Note:** You must avoid updating these inbound email addresses. If you have to update these inbound email addresses for some reason, you must complete the following steps:
  - Update the corresponding forwarding rule.
  - Ensure that you register the updated inbound email addresses as access points for inbound email.

For more information, see "Register Access Points for Inbound Email".

- **Outbound email:** Indicates the emails that are sent by the Help Desk application from the help desk request. For example, when an agent responds to the primary employee contact.

To ensure that your outbound email is delivered successfully to your external recipients, you must set up a Sender Policy Framework (SPF) policy on your domain.

To enable Oracle to send out an email on your behalf, you must do the following:

- Set up an SPF policy on your domain as an authentication mechanism. The exact method of setting up an SPF policy varies from one domain provider to another. For example, v=spf1 include:spf_c.oraclecloud.com -all.
- If you want to set the support agent's name as the From name in outbound emails, set the value for the SVC_USE_RESOURCE_NAME_IN_OUTBOUND profile option to Yes. For more information, see "Set the From Name in Outbound Emails".

To configure an email channel for an employee:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Help Desk
   - Functional Area: Other Communication Channels
   - Task: Manage Communication Channels

2. In the Service Channels page, click Create Channel.
3. In the **Create Channel** window:

   a. Select a **Stripe Code**.
   b. Select the **Channel Type** as **Email**.
   c. Specify the support email ID of your company as the **Account Name**. For example: support@mycompanydomain.com

      If a forwarding rule is configured, all the mails that are sent to the specified support email ID are forwarded to Oracle's inbound email ID. If an outbound email is configured, Oracle can send mails to the customer as the specified support email ID, on your behalf.
   d. Verify whether the generated **Channel Code** is unique.

      The channel code is autogenerated and it uniquely identifies a communication channel when exporting or importing channels from one environment to another.

      - If the autogenerated channel code is unique, you can leave it unchanged.
      - If the autogenerated channel code isn’t unique, add a set of characters to the code to make it unique.
   e. (Optional) Specify a **Display Name** to indicate any information about the channel, such as the name of the deploying company for which the channel is being configured.
   f. When a new channel is being created, it’s active by default. To deactivate it, clear the **Active** option.
   g. (Optional) From the **Business Unit** drop-down list, select a Business Unit (BU).

      The BU set in the scope is selected by default, but you can select a different BU. This column appears only if the multiple business units feature is turned on.
   h. Click **Save**.

**Related Topics**

- Configure Profile Options for Inbound and Outbound Email
- Overview of Access Point Setup for Inbound Emails
- Register or Unregister Access Points for Inbound Email
- Update Existing Setup Data

---

### Inbound Message Filters

#### Overview of Inbound Message Filters

Sometimes, you may want to use inbound message filters to set one or more filter criteria. Based on these filter criteria, incoming messages from employees can be accepted or rejected.

For example, you can set a filter to reject any emails that have AutoReply in the subject.

Message filter patterns are specified using regular expressions. For example, to specify a filter pattern to accept all emails from Oracle employees, the regular expression is given as: `^[A-Za-z0-9_.%+-]*@oracle.com`

You can set more than one filter. Filters are arranged in the descending order of priority on the Manage Email Filters page. The topmost filter has the highest priority. When a message comes in, the filter criteria are checked in the order of
priority. If the first filter criterion doesn't apply to a message, the subsequent ones are checked. If any of the filter criteria match the incoming message, the message is accepted or rejected based on the filter specifications.

**Note:** It's important that you pay special attention while setting up email filters. If the User Messaging Service (UMS) setup rejects any email due to the filter setup, the rejected email can't be processed again by the application and it’s lost.

To view the existing inbound message filters or to reorder their priorities:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Help Desk
   - Functional Area: Email Communication Channel
   - Task: Manage Email Filters

   The Inbound Message Filters page displays a list of the existing inbound message filters.

2. If you want to change the priority of a filter:
   a. Select the filter whose priority you want to change.
   b. Click anywhere on the empty spaces in the selected row, and then drag the row to the required position.

**Related Topics**
- How Inbound Messages Are Processed
- Create an Inbound Message Filter
- Update an Inbound Message Filter
- Examples of Inbound Message Filters
- Update Existing Setup Data

### Create an Inbound Message Filter

To create an inbound message filter:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Help Desk
   - Functional Area: Email Communication Channel
   - Task: Manage Email Filters

2. On the **Inbound Message Filters** page, click **Create**.

3. On the **Create Message Filter** page, select a filter type. Filter type indicates the message part on which the filter is applied. A filter type can be one of the following:
   - File attachment: A filter is applied to the file type of an attachment.
   - Header: A filter is applied to a message header.
   - Mime attachment: A filter is applied to the mime type of an attachment.
   - Reply to: A filter is applied to the Reply To address.
   - Sender: A filter is applied to the sender of the message.
Subject: A filter is applied to the subject of the message.

**Note:** File attachment and Mime attachment filters prevent attachments from getting added to a help desk request or help desk request message. But they don’t prevent the creation of the help desk request or help desk request message.

4. Specify a **Field Name**. The field name is mandatory only for Header filters.
5. Specify an alphanumeric **Filter Pattern**. For examples, see "Examples of Inbound Message Filters".
6. Select an **Action on Pattern Match** to Accept or Reject.
7. Specify an optional **Description**.
8. Click **Create**.

**Note:** All filters are enabled by default. To disable a filter, update the properties as described in "Update an Inbound Message Filter."

**Related Topics**
- How Inbound Messages Are Processed
- Overview of Inbound Message Filters
- Update an Inbound Message Filter
- Examples of Inbound Message Filters
- Update Existing Setup Data

## Update an Inbound Message Filter

To update an inbound message filter:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Help Desk
   - Functional Area: Email Communication Channel
   - Task: Manage Email Filters
2. On the **Inbound Message Filters** page, click the filter type that you want to update.
3. On the **Update Message Filter** page, update the filter properties. You can update all the properties except the filter type.
   - **Note:** If you want to disable a filter, select **Yes** in the **Disabled** field. The default value is **No**.
4. After you modify the filter properties, click **Save and Close**.

**Related Topics**
- How Inbound Messages Are Processed
- Overview of Inbound Message Filters
- Create an Inbound Message Filter
- Examples of Inbound Message Filters
- Update Existing Setup Data
Examples of Inbound Message Filters

Here are some examples of regular expressions for filter patterns of inbound message filters.

**Note:** Use the ".*" wildcard characters to match 0 or more occurrences of any character.

<table>
<thead>
<tr>
<th>Filter Type</th>
<th>Regular Expression Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>File attachment</td>
<td>Attachments that are files with either .pdf, .txt, or .html file extensions: .pdf</td>
</tr>
<tr>
<td>Header</td>
<td>Emails with headers that contain the string Gentle Reminder:</td>
</tr>
<tr>
<td></td>
<td>• ^Gentle Reminder[A-Za-z0-9._%+-]*</td>
</tr>
<tr>
<td></td>
<td>• ^Gentle Reminder.*</td>
</tr>
<tr>
<td>Mime attachment</td>
<td>Content Type header with values such as text/plain, text/html, image/jpg, or application/octet-stream: text/plain</td>
</tr>
<tr>
<td>Reply to</td>
<td>Emails that are sent by the support team:</td>
</tr>
<tr>
<td></td>
<td>• support_[A-Za-z0-9._%+-]*@company.com</td>
</tr>
<tr>
<td></td>
<td>• support_.*@company.com</td>
</tr>
<tr>
<td>Sender</td>
<td>Emails that are sent by an Oracle employee:</td>
</tr>
<tr>
<td></td>
<td>• [A-Za-z0-9._%+-]*@oracle.com</td>
</tr>
<tr>
<td></td>
<td>• .*@oracle.com</td>
</tr>
<tr>
<td>Subject</td>
<td>Email subjects with string AutoReply:</td>
</tr>
<tr>
<td></td>
<td>• ^Auto Reply: [A-Za-z0-9._%+-]*</td>
</tr>
<tr>
<td></td>
<td>• ^Auto Reply.*</td>
</tr>
</tbody>
</table>

**Related Topics**
- How Inbound Messages Are Processed
- Overview of Inbound Message Filters
- Create an Inbound Message Filter
- Update an Inbound Message Filter
- Update Existing Setup Data
Configure Profile Options for Inbound and Outbound Email

You can set options for incoming and outgoing emails by configuring email profile options. For example: You can set the Reply To email ID that’s used to send out a receipt to the employee who sends a message.

Configure the inbound email profile options as specified in the following table.

<table>
<thead>
<tr>
<th>Inbound Profile Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVC_ENABLE_INBOUND_EMAIL_DEFAULT_PROCESSING</td>
<td>Indicates whether inbound emails from employees must be processed automatically by creating or updating an help desk request. If this option is disabled, only the inbound message object is created, without creating a request.</td>
</tr>
</tbody>
</table>
| SVC_INBOUND_EMAIL_ADDRESSES                                         | Indicates the inbound email IDs that are monitored by the Service application. The email IDs are separated by a comma and are automatically populated during provisioning. You must use the address to set a forwarding rule. Try to avoid updating these inbound email addresses. If you update these inbound email addresses for some reason, you must complete the following steps:  
  • Update the corresponding forwarding rule.  
  • Ensure that you register the updated inbound email addresses as access points for inbound email.  
  For more information, see “Register Access Points for Inbound Email”. |
| SVC_INBOUND_ENABLE_INLINE_ATTACHMENTS                               | Enables the display of images inline within the help desk request messages in the UI. The default value is Yes.                                                                                               |
| SVC_INBOUND_EMAIL_MAX_ATTACHMENT_SIZE                               | Indicates the maximum size in MB of attachments that are permitted in an inbound email. The default value is 10 MB.  
  Here are some key points to note:  
  • The maximum limit for the email size is 15 MB. Email size includes email headers, attachments, and the email content.  
  • If an email contains non-text content or attachments, that gets base64 encoded, and this can increase the overall size of the email. So when your users send emails that exceed a total size of 15 MB, such emails aren’t processed by the server. |
| SVC_INBOUND_MESSAGE_BATCH_SIZE                                      | Indicates the number of emails that can be processed at a given time. This is the maximum number of emails retrieved by every run of the Retrieve Inbound Email Messages scheduled process. The default value is 10. |
| SVC_EMAIL_PROCESS_UNKNOWN_CUST                                      | Indicates whether a help desk request must be created for emails sent by unknown employees.                                                                                                               |
### Inbound Profile Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVC_ENABLE_INBOUND_EMAIL_ACKNOWLEDGEMENT</td>
<td>Indicates whether an acknowledgment must be sent for an incoming email.</td>
</tr>
<tr>
<td>SVC_INBOUND_ACK_EMAIL_LIMIT_PER_USER</td>
<td>Specifies the maximum number of emails to be sent to one user within a specific time interval. This time interval is specified in the SVC_INBOUND_ACK_EMAIL_TIME_INTERVAL profile option.</td>
</tr>
<tr>
<td></td>
<td>The default value is 3.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>Let’s say you don’t want to use this feature, and you want to send an acknowledgment email for every email received from a user. In that case, you can set this profile option to a high value such as 100. It’s a good idea to simultaneously set the SVC_INBOUND_ACK_EMAIL_TIME_INTERVAL profile option to a low value such as 5 minutes.</td>
</tr>
<tr>
<td></td>
<td>This profile option also helps to prevent the creation of infinite email loops. For more information, see “How can I detect and prevent email loops?”</td>
</tr>
<tr>
<td>SVC_INBOUND_ACK_EMAIL_TIME_INTERVAL</td>
<td>Specifies the time interval for which the limit check is applied for the maximum number of emails to be sent to a user.</td>
</tr>
<tr>
<td></td>
<td>This means that only the maximum number of emails specified in the SVC_INBOUND_ACK_EMAIL_LIMIT_PER_USER profile option can be sent to one user in this time interval.</td>
</tr>
<tr>
<td></td>
<td>The default value is 60 minutes.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>Let’s say you don’t want to use this feature, and you want to send an acknowledgment email for every email received from a user. In that case, you can set this profile option to a low value such as 5 minutes. It’s a good idea to simultaneously set the SVC_INBOUND_ACK_EMAIL_LIMIT_PER_USER profile option to a high value such as 100.</td>
</tr>
<tr>
<td></td>
<td>This profile option also helps to prevent the creation of infinite email loops. For more information, see “How can I detect and prevent email loops?”</td>
</tr>
<tr>
<td>SVC_INBOUND_EMAIL_PATTERN_TO_STOP_ACK</td>
<td>Specifies the email patterns that must be blocked, so that the application stops sending acknowledgment emails to email addresses having those patterns. The default email pattern is postmaster@.*.oraclecloud.com.</td>
</tr>
<tr>
<td>ORA_SVC_ENABLE_FAILED_INBOUND_MESSAGE_PROCESSING</td>
<td>Enables the automatic processing of inbound messages that weren't processed earlier because of internal issues.</td>
</tr>
<tr>
<td></td>
<td>The default value is Yes.</td>
</tr>
<tr>
<td></td>
<td>To stop the retrieval of unprocessed messages at any time, you can set the value to No.</td>
</tr>
<tr>
<td>ORA_SVC_ADD_FIRST_ATTACHMENT_TO_SR_MESSAGE</td>
<td>Enables the agents to see the images or attachments from the first email received on a help desk request in both the request header and the request message.</td>
</tr>
<tr>
<td></td>
<td>The default value is No.</td>
</tr>
<tr>
<td>ORA_SVC_INBOUND_MSG_LAST_REPROCESSING_DAYS</td>
<td>Specifies the number of days previous to the current date since when the failed inbound messages are to be reprocessed.</td>
</tr>
</tbody>
</table>
### Inbound Profile Options

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The default value is 1.</td>
</tr>
<tr>
<td><strong>ORA_SVC_ENABLE_INBOUND_PARTIAL_STATUSES_FOR_REPROCESSING</strong></td>
</tr>
<tr>
<td>Enables the reprocessing of unprocessed inbound emails from the past.</td>
</tr>
<tr>
<td>The default value is No.</td>
</tr>
<tr>
<td>When it's enabled, reprocessing starts from the last point where the processing stopped earlier.</td>
</tr>
<tr>
<td><strong>ORA_SVC_ADD_EMAIL_RECIPIENTS_TO_SR</strong></td>
</tr>
<tr>
<td>Enables you to choose whether to add the sender and recipients of inbound emails as an SR contact or SR team member. For a new SR, the recipients in the To or Cc lists are added as SR contacts or SR team members, if their email IDs exist as valid party records in the application. For a reply email to an existing SR, the sender and the contacts or team members in the To or Cc lists are added as SR contacts or SR team members if they don't already exist in the SR.</td>
</tr>
<tr>
<td>The default value is Yes.</td>
</tr>
<tr>
<td>When you set the value to No, the sender and recipients of inbound emails aren't added to the SR.</td>
</tr>
<tr>
<td><strong>Note:</strong> The sender of the first email is always added as the primary contact on the SR, irrespective of the value of this profile option.</td>
</tr>
<tr>
<td><strong>ORA_SVC_UNREGISTER_INBOUND_ACCESS_POINT</strong></td>
</tr>
<tr>
<td>Specifies whether to make the Unregister button available. The default value is No. When it's set to the default value, the Unregister button isn't available. This setting helps to prevent unregistering of access points accidentally. Only when you specifically need to unregister an access point, you can change the value to Yes so that the Unregister button is available. After unregistering the access point, you can set the value of this profile option back to No.</td>
</tr>
</tbody>
</table>

Configure the outbound profile options for HR Help Desk and Internal Help Desk as specified in the following table.

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SVC_OUTBOUND_EMAIL_FROM</strong></td>
</tr>
<tr>
<td>Indicates the From email that's used for sending outbound emails to employees. The default value is <a href="mailto:noreply@oracle.com">noreply@oracle.com</a>. You must set the value to the no reply address for your company to prevent auto-replies from creating unintended help desk requests.</td>
</tr>
</tbody>
</table>
| This profile option can have the no reply email address with or without the display name. Example without display name: noreply@mycompanydomain.com. Example with display name: Acme Support <noreply@mycompanydomain.com>. If the profile option value doesn't contain a display name, the display name of the email channel is used in the From address. Let's say you set the value of this profile option as your support email ID such as support@mycompanydomain.com. If your From email address isn't displayed in your email received by your employee, then you would receive a verification email at support@mycompanydomain.com. You must follow the instructions in that email to verify the account. If you don't have access to the inbox for support@mycompanydomain.com, then you must do one of the following:  
  - Contact Oracle support to get your email account verified.  
  - Set the value of this profile option to another valid email address that you can access. Now when you send your first email to an employee, you receive a verification email. You must click the confirmation link in the email to complete the verification. |
| **SVC_SR_FORWARD_TEMPLATE_NAME**                                           |
| Indicates the email template name for SR messages of type Forward.          |
### Email Channels

#### Outbound Profile Options

<table>
<thead>
<tr>
<th>Description</th>
<th>Outbound Profile Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicates the email template name for SR messages of type Response.</td>
<td>SVC_SR_RESPONSE_TEMPLATE_NAME</td>
</tr>
<tr>
<td>Indicates the template name for SR messages of type System Response.</td>
<td>SVC_SR_SYSTEM_RESPONSE_TEMPLATE_NAME</td>
</tr>
<tr>
<td>Indicates the maximum permitted total size in MB of all the attachments in an outbound email that's sent from the Service application. Oracle recommends keeping this value less than or equal to 10 MB. The default value is 10 MB. Here are some key points to note:</td>
<td>ORA_SVC_SR_EMAIL_ATT_SIZE</td>
</tr>
<tr>
<td>Indicates whether an acknowledgment must be sent to users both in the To and Cc lists for every inbound email that's received.</td>
<td>SVC_ENABLE_ACKNOWLEDGMENT_TO_ALL</td>
</tr>
<tr>
<td>Indicates whether the deep links to KM articles are enabled in outbound emails and email previews. When the deep links are enabled, this helps to translate and populate the complete URL to view the articles.</td>
<td>SVC_ENABLE_DEEPLINKS_IN_OUTBOUND_EMAIL</td>
</tr>
<tr>
<td>Enables the use of the resource name as the sender name in outbound emails. The default value is No.</td>
<td>ORA_SVC_ENABLE_RESOURCE_NAME_USAGE_IN_OUTBOUND</td>
</tr>
<tr>
<td>Enables the use of the resource email as the sender email in outbound emails. The default value is No.</td>
<td>ORA_SVC_ENABLE_RESOURCE_EMAIL_USAGE_IN_OUTBOUND</td>
</tr>
</tbody>
</table>

Configure the outbound profile options for HR Help Desk, as specified in the following table.

<table>
<thead>
<tr>
<th>Description</th>
<th>Outbound Profile Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicates the From email that's used for sending outbound emails to customers. The default value is <a href="mailto:noreply@oracle.com">noreply@oracle.com</a>. You must set the value to the no reply address for your company to prevent auto-replies from creating unintended SRs. This profile option can have the no reply email address with or without the display name. Example without display name: <a href="mailto:noreply@mycompanydomain.com">noreply@mycompanydomain.com</a>. Example with display name: Acme Support <a href="mailto:noreply@mycompanydomain.com">noreply@mycompanydomain.com</a>. If the profile option value doesn't contain a display name, the display name of the email channel is used in the From address. Let's say you set the value of this profile option as your support email ID such as <a href="mailto:support@mycompanydomain.com">support@mycompanydomain.com</a>. If your From email address isn't displayed in your email received by your customer, then you would receive a verification email at <a href="mailto:support@mycompanydomain.com">support@mycompanydomain.com</a>. You must follow the instructions in that email to verify the account. If you don't have access to the inbox for <a href="mailto:support@mycompanydomain.com">support@mycompanydomain.com</a>, then you must do one of the following:</td>
<td>SVC_OUTBOUND_EMAIL_FROM</td>
</tr>
</tbody>
</table>
## Outbound Profile Options

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVC_SR_FORWARD_TEMPLATE_NAME_HRD</td>
<td>Indicates the email template for the Help Desk Service Request Forward messages.</td>
</tr>
<tr>
<td>SVC_SR_RESPONSE_TEMPLATE_NAME_HRD</td>
<td>Indicates the email template for Help Desk Service Request Response messages.</td>
</tr>
</tbody>
</table>
| ORA_SVC_SR_EMAIL_ATT_SIZE                       | Indicates the maximum permitted total size in MB of all the attachments in an outbound email that’s sent from the Service application. Oracle recommends keeping this value less than or equal to 10 MB. The default value is 10 MB. Here are some key points to note:  
  - The maximum limit for the email size is 15 MB. Emails greater than 15 MB in size aren’t processed by the email server. Email size includes email headers, attachments, and the email content. If an email contains non-text content or attachments, that gets base64 encoded, and this can increase the overall size of the email.  
  - Use this profile option to restrict the email attachment size such that the total email size doesn’t exceed 15 MB. |
| SVC_SR_SYSTEM_RESPONSE_TEMPLATE_NAME_HRD        | Indicates the email template for Help Desk Service Request System Response messages.                   |
| SVC_ENABLE_DEEPLINKS_IN_OUTBOUND_EMAIL          | Indicates whether the deep links to KM articles are enabled in outbound emails and email previews. When the deep links are enabled, this helps to translate and populate the complete URL to view the articles. |
| ORA_SVC_ENABLE_RESOURCE_NAME_USAGE_IN_OUTBOUND  | Enables the use of the resource name as the sender name in outbound emails. The default value is No. |
| ORA_SVC_ENABLE_RESOURCE_EMAIL_USAGE_IN_OUTBOUND | Enables the use of the resource email as the sender email in outbound emails. The default value is No. |

To configure email profile options:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Help Desk
   - Functional Area: Email Communication Channel
   - Task: Manage Inbound Email Profile Options, or Manage Outbound Email Profile Options
2. Click the name of the profile option to be set.
3. In the **Manage Email Profile Options** page, in the **Profile Values** section, click the plus icon to add a value.
4. Click **Save**.
**Note:** Alternatively, you can click the Manage Email Profile Options task to display the Email Profile Options page. On this page, you can view the list of all inbound and outbound email profile options and set their values. You can also search for a specific profile option code using the search bar.

### Enable the Ability to Add All Contacts and Team Members or Additional Email Recipients

Sometimes while composing an email, an employee may want to add additional email recipients who aren't contacts or resources.

For these options to be available to them, you must enable the SVC_ENABLE_ADDITIONAL_EMAIL_RECIPIENTS profile option. The default value of this profile option is No.

To enable the SVC_ENABLE_ADDITIONAL_EMAIL_RECIPIENTS profile option:

1. Sign in as a setup user or administrator.
2. Navigate to the Setup and Maintenance work area.
3. Open the Tasks panel tab and click Search.
4. Search for and select the Manage Profile Options task.
5. On the Manage Profile Options page, navigate to the Search region.
6. In the Profile Option Code field, type SVC_ENABLE_ADDITIONAL_EMAIL_RECIPIENTS.
7. Click Search. The SVC_ENABLE_ADDITIONAL_EMAIL_RECIPIENTS profile option is displayed in the Search Results: Profile Options region.
8. In the Profile Option Levels region, set the Profile Value for the Site Profile Level as Yes.
9. Click Save.

### Set the From Name in Outbound Emails

When you send emails to employees, the From name in the email is typically the channel name. But you have the option to set the resource name as the From name in outbound emails.

You can do this by configuring the ORA_SVC_ENABLE_RESOURCE_NAME_USAGE_IN_OUTBOUND profile option.

To set the employee’s name as the From name in emails:

1. Ensure that you have configured the SPF policy to enable outbound email so that your emails aren't rejected.
2. Sign in as a setup user or administrator.
3. Navigate to the **Setup and Maintenance** work area and open the **Tasks** panel tab.
4. Click **Search** from the list of displayed tasks.
5. Search for and click **Manage Administrator Profile Values**.
6. On the Manage Administrator Profile Values page, navigate to the Search region.
7. In the **Profile Option Code** field, type **ORA_SVC_ENABLE_RESOURCE_NAME_USAGE_IN_OUTBOUND**.
8. Click **Search**.

The ORA_SVC_ENABLE_RESOURCE_NAME_USAGE_IN_OUTBOUND profile option is displayed in the Search Results: Profile Options region.

9. In the Profile Option Levels region, set the **Profile Value** for the Site **Profile Level** as **Yes**.
10. Click **Save and Close**.

**Related Topics**
- Configure an Email Channel

### Define Email Templates

You can create email templates for the Forward, Response, and System Response messages of a help desk request.

You can create templates using HTML to send email notifications for help desk requests.

**To define an email template:**

1. Sign in to the application as an administrator.
2. Navigate to Application Composer.
3. In the **Application** field, select **CRM Cloud** from the drop-down list.
4. In the **Common Setup** region, click **Email Templates**.
5. On the Email Templates page, click the plus icon to create a new template.
6. In the **Object** field, select **Help Desk Request** from the drop-down list.
7. Specify a name for the template.
8. (Optional) Specify a description.
9. To add any attachments, click the plus icon, browse to the file location, and select the file.
10. A template is active by default. To disable the template, clear the **Active** option.
11. Specify the email subject.

You can use help desk request field names in the subject. For example, the subject can be **Resolved issue [$Title$]**.

12. Edit the message HTML as required. Add the **#MessageContent#** tag anywhere in the HTML code. This tag is replaced by the help desk request message content.
13. (Optional) To enable the display of the email thread, insert the **#PastConversation#** tag in the template.

Add this tag within the email body at the place where you want to insert the previous messages from the email thread. When an agent replies to an employee from the Messages tab in help desk request, the email thread is displayed.

14. In email templates that are meant for forwarding to internal users, you can include a link to the request within the template. Include the link in the following format:

   `<Link to company’s Fusion Service site>/service/faces/FuseOverview?fndGlobalItemNodeId=itemNode_service_service_requests&srNumber=<SR Number>`.  

---

**ORACLE**

---
For example, https://company123.mycompanydomain.com:10616/service/faces/FuseOverview?
findGlobalItemNodeID=itemNode_service_service_requests&pSrNumber=SR0000029093.

15. Click Save and Close.

**Note:** When help desk request is created, it may be with or without a queue. So it’s possible that an email notification is sent before the request is assigned to a queue. If you want to avoid a blank field value in the email notification, you must not use the **Queue Name** field in your email template.

**Related Topics**
- Create and Manage Email Templates

## Modify Acknowledgment Messages for Inbound Email

When you receive an email from employee to open a help desk request, an acknowledgment message is sent to them automatically. Based on your company’s requirement, you can modify the predefined acknowledgment messages provided by the application.

**Note:** You can’t add new tokens to these messages. Only the predefined tokens are used in these messages.

For Help Desk, the following predefined messages are provided:
- SVC_EMAIL_ACK_FOR_KNOWN_EMP
- SVC_EMAIL_ACK_FOR_MULTI_EMP
- SVC_EMAIL_ACK_FOR_UNKNOWN_EMP

To modify the acknowledgment messages that you send out to employees when you receive an inbound email:

1. In the Setup and Maintenance work area, go to the **Tasks** panel tab.
2. Click **Search** from the list of displayed tasks.
3. In the **Search** window, enter **Manage Messages**.
4. Click the **Manage Messages** task that’s displayed.
5. In the **Manage Messages** window, in the **Message Name** field, enter %SVC%ACK%.
6. From the list of acknowledgment messages displayed, select the message that you want to edit and click **Edit**.
7. In the **Edit Message** window, navigate to the **Message Text** region.
8. Edit the **Short Text** and **User Details** the way you want.
9. Click **Save**.
10. To translate the modified messages, click **Translation Editor**.
    - The **Edit Translations** window displays the list of available languages for translating the messages.
    - **Note:** Inbound email can’t detect the language. So it always uses the default language for your deployment.
11. Select a row and click in the **Short Text** field.
12. In the **Short Text** window, edit the message and click **OK**.
13. Click in the **User Details** field, edit the text, and click **OK**.
14. Select another row and repeat the same steps to edit the messages for all the available languages.
15. Click **OK** in the **Edit Translations** window to save the changes.
16. Click **Save and Close** in the **Manage Messages** window.

---

**Enable Deep Links to KM Articles in Help Desk Outbound Emails**

When your service agents reply to employees by email, they may sometimes need to add links to Knowledge Management (KM) articles. These articles can help resolve the issue faced by the customers in that help desk request, or they can provide additional information.

These internal links to KM articles work in the Messages tab. But for these internal links to work in emails sent to employees, they must be translated to external links.

Here's what you need to do to convert the internal links to external links:

- Enable the SVC_ENABLE_DEEPLINKS_IN_OUTBOUND_EMAIL profile option. For more information, see "Configure Profile Options for Inbound and Outbound Email".
- Use the Manage Service Request Dynamic Links task to configure the DCS URL as described in the following table.

This table shows how the links work, depending on how the agent links to the article.

<table>
<thead>
<tr>
<th>Type of link created to the KM article</th>
<th>What to append to the DCS URL to make the link work</th>
<th>How the link works</th>
</tr>
</thead>
<tbody>
<tr>
<td>Article link format:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>When the agent uses either the &quot;Insert as link&quot; in RHP or the &quot;Insert Knowledge&quot; button KM application.</td>
<td>?kmContentId={0}&amp;page=shell&amp;shell=knowledge-article</td>
<td>The parameter {0} is replaced by the internal document ID of the selected KM article, and a clickable link to the article is inserted in the email message. The title of the KM article is used as the label for the link. The article opens in the DCS portal in a separate nested tab.</td>
</tr>
</tbody>
</table>

| Knowledge article format:               |                                                |                   |
| When the agent composes a message and provides a reference to a KM article. For example, if he types in the text FAQ1234, this text is linked in the email message. | ?kmExternalId={0}&page=shell&shell=kmarticle | The parameter {0} is replaced by the internal document ID of the selected KM article. The article is linked by using the typed text as the label for the link. Example of typed text: FAQ1234. The article opens in the DCS portal in a separate nested tab. |

**Note:** The deep links don't work if they contain the # character. Also, special characters such as @, ^, and * can be used only if preceded with the backslash character \\. For example, you must use \/* instead of * in your regular expression. For more information about using special characters in regular expressions, see the open source documentation for regular expressions. After you modify the regular expression, remember to use a validator to ensure that it's still working.

To enable deep links to KM articles in outbound emails and email previews to open in DCS:

1. In the Setup and Maintenance work area, go to the following:
Access Point Setup for Inbound Emails

Overview of Access Point Setup for Inbound Emails

When your employees send emails to your support channel, the User Messaging Service (UMS) reads those emails from your inbox and delivers them to registered access points.
Access points are registered clients that are authorized to read emails from your inbox. The application then reads those emails from the access points.

For inbound email to be processed successfully, it's important to register the correct access points with the UMS. You can use the Access Point Setup region of the Inbound Email Configuration and Validation page to register access points. When you register an access point, emails are permitted to be processed further. For example, to create a help desk request. When you unregister an access point, further processing of emails is stopped, and the emails in your inbox are also lost without being processed.

**Related Topics**
- Validate Your Inbound and Outbound Email Setup
- Configure an Email Channel

**Validate Your Inbound and Outbound Email Setup**

You can verify your email channel configurations by using the Inbound Email Configuration and Validation page. On this page, you can proactively take corrective actions to fix any wrong or missing configuration. The validations on this page save you the trouble of raising a support ticket or checking the logs.

Use the Inbound Email Configuration and Validation page to do the following validations:

- Inbound email channel profile options
- Channel setup
- Access points for inbound email
- Outbound email flow
- Inbound email flow

To verify your email channel configurations:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Help Desk
   - Functional Area: Email Communication Channels
   - Task: Manage Email Configuration, Registration, and Validation

   The Inbound Email Configuration and Validation page is displayed.

2. In the Email Configuration region, click Validate.

   The following validations happen in this region:

   - **Channel Setup**: Checks whether you have done the following:
     - Configured at least one non-seeded channel.
     - Specified a Business Unit for every channel.
   - **Profile Option**: Reads the SVC_INBOUND_EMAIL_ADDRESSES profile option for email addresses and displays an error message if email addresses aren’t defined.
   - **Access Point Setup**: Checks whether the access points are registered appropriately. It's important to register the correct access points. For more information, see the remaining topics in this section.
For each setup or configuration that’s valid, a tick mark is displayed.

If the configuration is invalid or the setup isn’t done correctly, a cross mark is displayed. A suitable message is displayed, describing the corrective action that you must take.

3. In the Email Flow region, in the **Recipient** field, enter your company's test mail ID.

The email flow for the outbound and inbound emails is validated here.

4. Click **Validate**.

The following validations happen in this region:

- **Outbound Email Validation:**
  
  An outbound email is sent to the specified email address and it’s verified whether the message is delivered successfully.
  
  - If the host, port, or password are incorrect, a suitable error message is displayed and the status is displayed as DELIVERY_TO_GATEWAY_FAILURE.
  
  - If the email is delivered successfully, the status code is displayed as DELIVERY_TO_GATEWAY_SUCCESS.

- **Inbound Email Validation:**

  The following validations happen:

  i. Test emails are sent to all the email addresses specified in the SVC_INBOUND_EMAIL_ADDRESSES profile option and the delivery status is verified for each message.

  ii. If an email address isn’t registered as an access point, then you can’t receive emails from that email address. The status appears as DELIVERY_TO_CLIENT_FAILURE. An error message is displayed, explaining the suitable action to be taken.

  iii. For each email address specified in the SVC_INBOUND_EMAIL_ADDRESSES profile option, a success or failure message is displayed along with the status.

  The status is displayed as:

  - DELIVERY_TO_CLIENT_SUCCESS: When the inbound email is received successfully by the access point.
  
  - DELIVERY_TO_CLIENT_PENDING: When the message is received but not yet processed. You must verify whether the inbound poll job is scheduled.

  - DELIVERY_TO_CLIENT_FAILURE: When the access point isn’t registered. For more information about registering access points, see "Register Access Points for Inbound Email".

5. Click **Reset** to clear the **Recipient** field and all the messages related to the recipient.

**Related Topics**

- Overview of Access Point Setup for Inbound Emails
- Configure an Email Channel
Register or Unregister Access Points for Inbound Email

For your inbound emails to be processed successfully, you must register the email addresses in the SVC_INBOUND_EMAIL_ADDRESSES profile option as access points. If your inbound email address changes for some reason, then you must register the new inbound email address as an access point.

Sometimes, you may have to unregister a wrong email address that was registered by mistake. The ORA_SVC_UNREGISTER_INBOUND_ACCESS_POINT profile option controls the ability to unregister access points. Its default value is No. When it's set to the default value, the Unregister button for an access point isn't available. This setting helps to prevent unregistering of access points accidentally. Only when you specifically need to unregister an access point, you can change the value to Yes so that the Unregister button is available. After unregistering the access point, you can set the value of this profile option back to No.

**CAUTION:** When you register or unregister access points, they don't reflect in all the server instances, and some inbound emails may not be received. To prevent this from happening, you can do one of the following:
- Restart the servers to reflect the registering or unregistering of access points. You must contact Oracle Support for restarting the servers.
- Configure the Retrieve Inbound E-mail Messages job to run at a suitable frequency. See Configuring a Job to Process Inbound Emails.

To register the access points for inbound email:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Help Desk
   - Functional Area: Email Communication Channels
   - Task: Manage Email Configuration, Registration, and Validation
2. On the Inbound Email Configuration and Validation page, in the Email Configuration region, click Validate.

   The access point setup is validated in this region. For more information about validations other than the access point, see “Validate Your Inbound and Outbound Email Setup”.

   The following email addresses are displayed in the Access Point Value column of the Access Point Setup region:
   - Email addresses specified in the SVC_INBOUND_EMAIL_ADDRESSES profile option.
     - Suppose one or more of these email addresses aren't registered as an access point with the UMS. In such cases, a Register button appears in the Action column for these email addresses.
   - Email addresses that are registered as access points in the UMS.
     - All email addresses that are registered as access points with the UMS are displayed in this section. An Unregister button appears in the Action column for each email address.
     - **Note:** Don’t click Register and Unregister at this stage. You must complete the remaining steps.
3. Verify whether the email addresses specified in the SVC_INBOUND_EMAIL_ADDRESSES profile option are correct.
4. If the email addresses in the SVC_INBOUND_EMAIL_ADDRESSES profile option aren't correct, update them to show the correct values.
5. Refresh the Inbound Email Validation and Configuration page.
6. If you still see a Register button, click the button to register the email address with the UMS.
7. If you still see an Unregister button, click the button, because the email address is wrong.

The wrong email address is unregistered, and is no longer an access point with the UMS.

Note:
- When you unregister an email address, all inbound emails to that email address are lost.
- If the Unregister button appears grayed out and you can't click it, set the ORA_SVC_UNREGISTER_INBOUND_ACCESS_POINT profile option to Yes as explained earlier in this topic. Now you can click the Unregister button.

Overview of Times Displayed for the Access Points
This table describes the meaning of the different times displayed for each email address.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Read Time</td>
<td>When a time is displayed in this column, and the other two columns are blank, this indicates the following: An email address is configured with the UMS server, but the access point isn't registered. So, the UMS reads the email from the inbox but isn't able to deliver it to the access point, because an access point doesn't exist. Maps to the DELIVERY_TO_CLIENT_FAILURE status of the UMS server.</td>
</tr>
<tr>
<td>Last Successful Read Time</td>
<td>When the Last Successful Process Time is blank, this indicates that the access point is registered, but the scheduled inbound poll job hasn't run. The UMS reads the email from the inbox and delivers it to the access point, but the scheduled job hasn't run. Maps to the DELIVERY_TO_CLIENT_PENDING status of the UMS server.</td>
</tr>
<tr>
<td>Last Successful Process Time</td>
<td>Indicates the last time when the email was read by the scheduled inbound poll job. Maps to the DELIVERY_TO_CLIENT_SUCCESS status of the UMS server.</td>
</tr>
</tbody>
</table>

How You Interpret the Times Displayed for the Access Points
This table shows some examples of times displayed for each sample email address in the Access Point Setup region.
## Email Channels

<table>
<thead>
<tr>
<th>No.</th>
<th>Access Point</th>
<th>Last Read Time</th>
<th>Last Successful Read Time</th>
<th>Last Successful Process Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td><code>inbound_email1@oracle.com</code></td>
<td>7/17/2018 3:00 a.m.</td>
<td>7/17/2018 3:06 a.m.</td>
<td>7/17/2018 3:06 a.m.</td>
</tr>
<tr>
<td>2.</td>
<td><code>inbound_email2@oracle.com</code></td>
<td>7/19/2018 7:30 a.m.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.</td>
<td><code>inbound_email3@oracle.com</code></td>
<td>7/19/2018 7:36 a.m.</td>
<td>7/18/2018 7:36 a.m.</td>
<td>7/18/2018 7:36 a.m.</td>
</tr>
<tr>
<td>4.</td>
<td><code>inbound_email4@oracle.com</code></td>
<td>7/19/2018 7:36 a.m.</td>
<td>7/19/2018 7:36 a.m.</td>
<td></td>
</tr>
<tr>
<td>5.</td>
<td><code>inbound_email5@oracle.com</code></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Here’s how you interpret the above examples of times displayed for the access points in the Access Point Setup region:

### Possible scenarios

- **`inbound_email1@oracle.com`** in the previous table:
  - Last Read Time has a value.
  - Last Successful Read Time has a value.
  - Last Successful Process Time has a value.
  - One of the following conditions is satisfied:
    - All the values are synchronized.
    - The Last Successful Read Time and Last Successful process time values aren’t earlier than the Last Read Time.
  
  **What this means**: The process works correctly without any issues.

### What you need to do

- You don’t need to do anything.

- **`inbound_email2@oracle.com` and `inbound_email3@oracle.com`** in the previous table:
  
  One of the following conditions is satisfied:
  - Last Read Time is later than the Last Successful Read Time.
  - Last Read Time has a value, but Last Successful Read Time and Last Successful Process Time are blank.

  **An email is read by the UMS server, but the email isn’t delivered to the access point.**

  **Note:** After you register the access point, emails are successfully delivered to the access point.

  **What you need to do**:

  1. Starting from the Last Successful Process Time, verify till the current time and see if any Last Successful Read Time exists.

     - For `inbound_email1@oracle.com`, starting from about 30 to 40 hours earlier than the Last Read Time, verify whether anything is wrong with respect to the access point. For example, the initial setup may be wrong.

     - For `inbound_email3@oracle.com`, a Last Successful Read Time is displayed, and it’s later than the Last Successful Process Time. This implies that a mail...
### Summary of Tips to Interpret the Times Displayed for Access Points

Here’s a brief summary of tips to interpret the different times displayed for each access point and the status of the records in the UMS:

<table>
<thead>
<tr>
<th>How the Times Are Displayed for an Access Point</th>
<th>What this indicates</th>
<th>What you need to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>One of the following conditions is true:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Only the Last Read Time has a value and the other columns are blank.</td>
<td>The access point is probably not registered and you may be losing emails.</td>
<td></td>
</tr>
<tr>
<td>• The values in other columns are earlier than the value in Last Read Time.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The Last Successful Process Time is blank or earlier than the Last Successful Read time.</td>
<td>The emails aren’t being processed by the inbound scheduled job.</td>
<td></td>
</tr>
<tr>
<td>The difference between the times listed in all the three columns is less.</td>
<td>The access point is working fine.</td>
<td></td>
</tr>
</tbody>
</table>
Troubleshoot Access Point Issues

If some emails aren't processed for a particular access point, a particular sender, or within a time range, you can search for those specific records. The records retrieved from the UMS are sorted by date and they show the status in the UMS.

Use the search icon in the Access Point Setup region to search for specific records in the UMS based on the following: From Time, To Time, Sender, or Receiver. You can filter the retrieved records by the access points that are registered, by sender, or by receiver.

To troubleshoot access point issues:

1. On the Inbound Email Configuration and Validation page, navigate to the Access Point Setup region.
2. Click the Search icon.
3. Depending on your requirement, enter the details in one or more of the following fields in the Search Message window: From Time, To Time, Sender, and Receiver.
4. Click Search.
   - The Search Results are displayed. The records are sorted in the descending order of time, with the latest ones on top. The following details are displayed for each record that is retrieved:
     - Message ID
     - Recipient
     - Date
     - Status
5. View the details and take suitable action.

Example of a Scenario Where Inbound Email Fails

This is an example of a case where inbound email may fail.

Let's say that your support mailbox is support@mycompanydomain.com and you have set up a forwarding rule. When your employee sends an email to support@mycompanydomain.com, the mail is forwarded to mycompanydomain.extservice@oraclecloud.com. The email address mycompanydomain.extservice@oraclecloud.com is registered as an access point. So, the inbound emails work fine.

However, suppose you upgrade your installation and a password error occurs after the upgrade. If someone changes the email address in the SVC_INBOUND_EMAIL_ADDRESSES profile option to mycompanydomain2.extservice@oraclecloud.com, then your inbound emails stop working for the following reasons:

- The updated email address in the SVC_INBOUND_EMAIL_ADDRESSES profile option isn't registered as an access point with the UMS.
- The email address in the forwarding rule doesn't match the updated email address in the SVC_INBOUND_EMAIL_ADDRESSES profile option.

When the email address in the SVC_INBOUND_EMAIL_ADDRESSES profile option is changed, the following changes are reflected in the Access Point Setup section of the Inbound Email Configuration and Validation page:

- For the new email address that's added to the SVC_INBOUND_EMAIL_ADDRESSES profile option, a Register button appears.
• For the old email address in the SVC_INBOUND_EMAIL_ADDRESSES profile option, an Unregister button appears.

**Note:** It’s important that you first correct the email addresses and refresh the Inbound Email Configuration and Validation page. And only after that, you must click Register and Unregister as required.

### Process Inbound Emails Job

#### Configure a Job to Process Inbound Emails

You can configure a new job to retrieve emails at regular intervals, based on the specified frequency.

To configure a job to process inbound emails:

1. From the Navigator menu, select the **Scheduled Processes** option.
2. In the **Scheduled Processes** screen, click **Schedule New Process**.
3. In the **Schedule New Process** dialog box, select **Job** as the **Type**.
4. Search for and select the **Retrieve Inbound E-mail Messages** option from the **Name** drop-down list.
5. Click **OK**.
6. In the **Process Details** dialog box, click **Advanced**.
7. In the **Schedule** tab, in the **Run** options, select the **Using a schedule** option.

   For more information about scheduled processes, see the *Oracle Applications Cloud Using Common Features* guide.

8. Select **Frequency** and specify a **Start Date**.

   **Note:** You must ensure that you always select a frequency, whether it’s your test or production environment. You can select a higher frequency if required. If you try to run the job manually without setting a frequency, it may not retrieve all the emails. Only when you schedule the job to run periodically, it pulls all the emails from all the servers.

9. Click **Submit**.

A job is scheduled to process inbound emails.

**Note:** Inbound emails work properly only for help desk requests whose reference numbers have the following characters: [A-Z], [a-z], [0-9], and the special characters hyphen (-), colon (:), period (.), comma (,), or underscore (_). So you can use only one of these characters as the prefix for an help desk request reference number. You can’t use any other special character in the prefix apart from the ones mentioned.

**Related Topics**

- Overview of Scheduled Processes
- Submit Scheduled Processes and Process Sets
Display Email Thread in Preview and Outbound Email

Display Email Thread of Past Conversations

When an employee receives a response to an email from the Messages tab in a help desk request, it's a good idea to display the email thread containing the past conversations. This way, the employee easily understands the context.

This is also useful as the email thread is included when the email is previewed. Past conversations can be viewed in the thread latest replies can be written as required.

To enable the display of the email thread, you need to complete a few simple processes:

- Configure a few profile options
- Modify email templates to display the email thread

Related Topics
- Configure Profile Options to Display Email Thread
- Modify Email Templates to Display the Email Thread
- Define Email Templates

Configure Profile Options to Display Email Thread

When an employee responds to an email from the Messages tab in a service request, it's good to display the email thread. To enable the display of the email thread, you must configure the following profile options.

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVC_EMAIL_ENABLE_PAST_CONVERSATIONS</td>
<td>Indicates whether to display past conversations. To enable past conversations, set the value to Yes. The default value is No, so it's disabled by default.</td>
</tr>
<tr>
<td>SVC_EMAIL_NO_OF_PAST_CONVERSATIONS</td>
<td>Indicates the number of past conversations to be included in the email thread. The default value is 1. You can specify a value from 1 to 10. If you set the value to 0, no past conversations are included. And even if you set a value greater than 10, only a maximum of 10 conversations are displayed.</td>
</tr>
<tr>
<td>SVC_EMAIL_PAST_CONVERSATION_START_MARKER</td>
<td>Indicates the start marker for each conversation in the email thread. This value is fixed and is displayed in English by default. To translate and display this value in the language of your choice, you must set the required locale in the ORA_SVC_EMAIL_DEFAULT_LANGUAGE profile option.</td>
</tr>
<tr>
<td>Profile Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>SVC_EMAIL_PAST_CONVERSATION_END_MARKER</td>
<td>Indicates the end marker for each conversation in the email thread. This value is fixed and is displayed in English by default. To translate and display this value in the language of your choice, you must set the required locale in the ORA_SVC_EMAIL_DEFAULT_LANGUAGE profile option.</td>
</tr>
</tbody>
</table>
| ORA_SVC_EMAIL_DEFAULT_LANGUAGE | Indicates the default language to format outbound emails and parse inbound emails. The default value is blank. When it's blank, the existing values for the start and end markers are displayed for the past conversations. For details about these markers, see the preceding two rows in this table. You can specify the locale as a value for this profile option. For example: en for English, fr for French, and pt for Portuguese. When you specify the locale, the translated values for the following start and end conversation markers are displayed in the specified language:  
  - SVC_EMAIL_PAST_CONVERSATION_START_MARKER: [##Send your response as a reply to the above mail##]  
  - SVC_EMAIL_PAST_CONVERSATION_END_MARKER: [##End of conversation##] |
| SVC_EMAIL_PAST_CONVERSATION_MSGTYPES | Indicates the types of messages to include in the email thread. You must specify the codes for the message types, separated by commas. For example: ORA_SVC_INTERNAL_NOTE, ORA_SVC_RESPONSE, ORA_SVC_SYSTEM_NOTE, ORA_SVC_CUSTOMER_ENTRY, ORA_SVC_FORWARD, ORA_SVC_SYSTEM_RESPONSE. You can't specify the meaning or the display name of the message type. The default value is ORA_SVC_CUSTOMER_ENTRY. **Note:** To add codes for other message types, see the "Search for Lookup Codes of Message Types" section at the end of this topic. |
| ORA_SVC_EMAIL_PAST_CONVERSATION_SHOW_MSGTYPES | Indicates whether to include the message type in past conversations. The default value is Y. The message type is translated based on the signed-in user's locale. But the default language may be different. Let's say the signed-in agent's locale is Japanese and the default language is Chinese. So while everything gets translated to Chinese, only the message types appear in Japanese. If your customers reach out to you about this issue, you can set the value to No. The message type is no longer included in past conversations. |
| ORA_SVC_EMAIL_DEFAULT_PAST_CONVERSATIONS_IN_OUTBOUND_MSGS | Indicates whether to enable past conversations by default in outbound messages. For more information, see Configure Email Templates to Control When to Include Past Conversations. |
| ORA_SVC_EMAIL_PAST_CONVERSATION_CHANTYPES | Includes messages from only one or more specific channels in past conversations. Set the value to a comma-separated list of those specific channel types that you want. For more information, see Include Messages of Only Some Channel Types in Past Conversations. |
To configure the profile options for displaying the email thread:

1. Navigate to the Setup and Maintenance work area and open the Tasks panel tab.
2. Click Search from the list of displayed tasks.
3. In the Search field, type Manage Admin.
4. From the displayed list of tasks, click Manage Administrator Profile Values.
5. In the Manage Administrator Profile Values page, navigate to the Search: Profile Option region.
6. In the Profile Option Code field, type %.
7. Select %PAST_CONVERSATION% from the options displayed.
8. Click Search.

The Search Results: Profile Options region displays the list of profile options related to past conversations.
9. Select the profile options one by one.
10. In the Profile Values region, specify the values in the Profile Value column for the Site Profile Level as described in the table.
11. Repeat the previous step for each profile option in the search results.
12. Click Save.

### Search for Lookup Codes of Message Types

Follow these steps to search for the lookup codes of message types that you want to add in the SVC_EMAIL_PAST_CONVERSATION_MSG_TYPES profile option. You can use the same steps to search for the lookup codes of message types available in the Compose menu in the Messages subtab of a help desk request.

1. Sign in as an administrator.
2. Navigate to the Setup and Maintenance work area and open the Tasks panel tab.
3. Click Search from the list of displayed tasks.
4. Search for and select Manage Standard Lookups.
5. In the Manage Standard Lookups page, in the Lookup Type field, type ORA_SVC_MESSAGE_TYPE_CD.
6. Click Search.
7. From the Lookup Code column in the ORA_SVC_MESSAGE_TYPE_CD: Lookup Codes region of the page, copy the lookup codes that you want to specify in the SVC_EMAIL_PAST_CONVERSATION_MSG_TYPES profile option.

**Note:**
- The lookup codes ORA_SVC_CHAT_TRANSCRIPT and ORA_SVC_WRAP_UP aren't applicable to emails.
- If you disable any of the following lookup codes, the corresponding message types disappear from the Compose menu on the Messages subtab of a help desk request: ORA_SVC_INTERNAL_NOTE, ORA_SVC_RESPONSE, ORA_SVC_CUSTOMER_ENTRY, and ORA_SVC_FORWARD.

### Related Topics
- Display Email Thread of Past Conversations
- Modify Email Templates to Display the Email Thread
- Define Email Templates
Modify Email Templates to Display the Email Thread

When an employee replies to an email from the Messages tab in an help desk request, it's good to display the email thread. This way, the recipient clearly understands the context.

For this to happen, you must insert the #PastConversation# tag into the email templates for help desk requests. This tag indicates the place within the email layout where you want to insert the previous messages from the email thread.

When the #PastConversation# tag is detected, the email-sending process automatically inserts the following details of previous messages from the request:

- Type of message
- Sender
- To/Cc
- Received date and time of the message for customer entries
- Sent date and time of the message for agent responses
- Creation date and time for other messages
- Message content

When employees preview an email, the email thread is included in the preview. This helps them to verify the flow and make changes as required, so the message is clearly understood.

To modify an email template to display the email thread:

1. Sign in to the application as an administrator.
2. Navigate to Application Composer.
3. In the Application field, select CRM Cloud from the drop-down list.
4. Click Email Templates from the Common Setup region or the Overview page.
5. From the Object drop-down list in the Email Templates page, select Help Desk Request.
6. From the Active drop-down list, select Yes.
7. Click Search.
8. From the list of templates displayed, select the template that you want to modify.
9. Click Edit.
10. Navigate to the Email Body region of the email template.
11. Insert the #PastConversation# tag at the place within the email body where you want the email thread to be displayed.
12. Click Save and Close.

Related Topics

- Display Email Thread of Past Conversations
- Configure Profile Options to Display Email Thread
- Define Email Templates

Purge Inbound Email Messages

As an administrator, you must periodically purge the older inbound email messages after the help desk requests are created successfully.
Again, you may sometimes have unprocessed emails for which the corresponding help desk requests couldn’t be created. They’re typically retained so that the source of messages isn’t lost. You must also review them periodically and take suitable corrective action. Once that’s done, you can purge those emails.

**Note:** You can use Oracle BI Publisher to create periodic reports for unprocessed emails.

To purge the unprocessed inbound messages periodically, you have to complete a few simple processes:

- Configure profile options to purge inbound email messages
- Schedule a job to purge inbound email messages

## Configure Profile Options to Purge Inbound Email Messages

You must configure the following profile options for purging inbound email messages.

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVC_INBOUND_MSG_RETENTION_DAYS</td>
<td>Indicates the number of retention days for inbound email messages. After the specified number of retention days, the successfully processed email messages are deleted from the inbound message table, inbound message parts table, and inbound message batch table. The default value is 30.</td>
</tr>
</tbody>
</table>
| SVC_INBOUND_ENABLE_FAILED_MESSAGE_PURGE | Indicates whether to enable purging of inbound email messages that fail or aren’t processed successfully. The default value is No. When the value is No, inbound email messages that fail or aren’t processed successfully, are retained. After you review such email messages and take corrective action, you can set the value to Yes. When the value is set to Yes, the purge job deletes the corresponding records from the following tables:  
  - Inbound message table  
  - Inbound message parts table  
  - Inbound message batch table |

1. Navigate to the Setup and Maintenance work area and open the **Tasks** panel tab.
2. Click **Search** from the list of displayed tasks.
3. In the **Search** field, type **Manage Administrator**.
4. From the displayed list of tasks, click **Manage Administrator Profile Values**.
5. In the Manage Administrator Profile Values page, navigate to the Search: Profile Option region.
6. In the **Profile Option Code** field, type **SVC_INBOUND_%**.
7. Click **Search**. The Search Results: Profile Options region displays a list of profile options.
8. Select **SVC_INBOUND_MSG_RETENTION_DAYS**.
9. In the Profile Values region, specify the values in the **Profile Value** column for the Site **Profile Level** as described in the table.
10. Select **SVC_INBOUND_ENABLE_FAILED_MESSAGE_PURGE** and repeat the previous step.
11. Click **Save**.

Schedule a Job to Purge Inbound Email Messages

You can schedule a job that purges the successfully processed email messages from the inbound message database tables, based on the retention policy.

The retention days are set in the `SVC_INBOUND_MSG_RETENTION_DAYS` profile option. If you also want this job to purge inbound email messages that fail or aren't processed successfully, you must set the value of the `SVC_INBOUND_ENABLE_FAILED_MESSAGE_PURGE` profile option to Yes. For more information, see "Configure Profile Options to Purge Inbound Messages".

This job runs periodically to purge inbound email and related records from the following database tables, based on the above two profile options:

- Inbound message
- Inbound message parts
- Inbound message batch

You can schedule the job to run once daily. Or, depending on your company's requirements, you can decide another frequency for the job.

To set up a scheduled process to purge data from the three inbound message tables:

1. In the Navigator for your service application, click **Scheduled Processes**.
2. In the Overview page, click **Schedule New Process**.
3. Select **Job** as the **Type** option.
4. In the **Name** drop-down list, click **Search**.
5. Search for and select **Purge Inbound Messages**.
6. Click **OK**.
7. In the **Process Details** dialog box, click **Advanced**.
8. On the Schedule tab, select **Using a schedule** as the **Run** option.
9. Schedule the job to execute on a recurring basis by specifying the frequency and other details as required.
10. Click **Submit**.

FAQs About Help Desk Emails

What happens when an employee sends a help desk email?

If an employee sends an email, then the email ID in the From field is validated against the employee record in the database. If a match is found, and the email is for a new help desk request, then a new request is created.

If a match to the email ID isn't found in the database, then the following applies:

- The value for the `SVC_EMAIL_PROCESS_UNKNOWN_CUST` profile option is selected. This option specifies how to process an incoming email from unknown employees.
- If the `SVC_EMAIL_PROCESS_UNKNOWN_CUST` profile option is set to **Y**, a new request is created. However, a message is sent to the employee indicating that they can't be identified and must provide valid information for further processing of the request.
• If the SVC_EMAIL_PROCESS_UNKNOWN_CUST profile option is set to N, no request is created.

| Note: | All the recipients of the incoming email, including the unknown contacts are listed in the Messages tab. |

How can I detect and prevent email loops?

You can prevent your service application from creating additional help desk requests when there's an out-of-office reply from one of the recipients of the email.

For outbound help desk request emails, the recommended best practice is to have your administrator set the From address to a no-reply option, such as noreply@mycompanydomain.com. This way, even if one or more recipients have their out-of-office notification turned on, the out-of-office reply isn't received by your service application. So a new SR isn't created.

But let's say your administrator sets the From address to your Support email account. This could cause an infinite loop of emails and new help desk requests. That's because a new request sends an automatic acknowledgment email, which would trigger an out-of-office reply. This reply would in turn trigger the creation of another new request, and so on.

Your business requirements may not permit the use of a no-reply email address, and you may use your Support email account instead. To accommodate this requirement, the following profile options are provided to detect and prevent the creation of infinite email loops:

• SVC_INBOUND_ACK_EMAIL_LIMIT_PER_USER
• SVC_INBOUND_ACK_EMAIL_TIME_INTERVAL
• SVC_INBOUND_EMAIL_PATTERN_TO_STOP_ACK

You can configure these profile options and set the values based on your company's requirement. For more information, see Configure Profile Options for Inbound and Outbound Email.

Related Topics
• Configure Profile Options for Inbound and Outbound Email
Chapter 8
Service Entitlements

Overview of Service Entitlements

Entitlements Background and Terminology

Service entitlements are benefits or privileges you provide to employees when you extend service to them. A milestone is a type of entitlement that identifies service levels your organization has committed to its employees, and is tracked when providing service in the context of a help desk request.

Here's the ready-to-use milestones you get with the application:

- **First Response Metric**: Tracks how quickly you agree to respond to an employee after the help desk request is received.
- **Resolution Metric**: Tracks how quickly you must resolve the help desk request for the employee.

In addition, you can also set up administrator-defined milestones that define other service levels you want to track for your employees.

When you create a help desk request for an employee, milestones are automatically assigned to the help desk request based on the defined service coverages. You can apply milestones to a help desk request by defining the coverages as follows:

- **Standard Coverages**, which act as templates.
- **Default Coverages**, specify a standard coverage template as a global default that's applicable to all help desk requests.
- **Subscription Coverages** (or **Service Contracts**), which you can optionally create to apply coverages only to specific assets or products owned by a customer.

**Note**: New customers are automatically opted-in to use Subscription Management instead of Service Contracts. For existing customers implementing service entitlements for the first time, Oracle recommends the use of the subscription coverages. Customers already using Service Contracts are still supported, however new features such as product-based service level agreements (SLAs) are only available with Subscriptions. For more information, see *Enable Subscription Coverages for Entitlements*.

When the same milestone exists in coverages at multiple levels, the subscription (or contract) values take priority over customer-level default values, which in turn take priority over global default values.

Overview of the Milestone Lifecycle for Help Desk

Once milestones are assigned to a help desk request, they begin countdown to their respective due dates, and are monitored by the application automatically based on the configuration you have set up.

The **Milestone** object includes a **Status** field that indicates whether the milestone is being actively tracked, is paused, complete, or has been canceled. The **Milestone** object also includes two flags that are commonly used to trigger
object workflow according to your business needs, for example to send an email notification to proactively notify the employee, or escalate the help desk request:

- The **WarnedFlag** is updated to **Y** when the milestone's time to expiration is within the warning threshold specified in the standard coverage.
- The **ComplianceFlag** is updated to **N** when the milestone reaches the due date or the time before completion, representing a milestone that has expired (it's no longer compliant).

### Milestones and Coverages

#### How You Set Up Milestones and Coverages

You must set up milestones and coverages so that the ready-to-use milestones are automatically applied to service requests and monitored.

New customers are automatically opted-in to use Subscription Management instead of Service Contracts. For existing customers implementing service entitlements for the first time, Oracle recommends the use of the subscription coverages. Customers already using Service Contracts are still supported, however new features such as product-based service level agreements (SLAs) are only available with Subscriptions. For more information, see [Enable Subscription Coverages for Entitlements](#).

Here's the steps you require for this set up:

1. Manage milestone configuration (optional)
2. Create a coverage schedule (optional)
3. Create a standard coverage
4. Apply the standard coverage as global and customer defaults
5. Configure the scheduled process to monitor help desk milestones
6. Add current milestone fields to the help desk request layout (optional)
7. Configure email notifications or other event actions from an object workflow (optional)

### Overview of Milestones and Coverages Configuration

The First Response Metric and Resolution Metric milestones are preconfigured for every implementation.

These milestones have predefined criteria that specify when the milestone starts, pauses, and completes. You can review these criteria and modify them if required, to match your business rules.

In Setup and Maintenance navigate to:

- Offering: Help Desk
- Functional Area: Service Entitlements
- Task: Manage Service Milestone Configuration for HR Help Desk Requests or Manage Service Milestone Configuration for Internal Help Desk Requests

After you set up the milestones and coverages using the standard process steps described in the "How You Set Up Milestones and Coverages" topic, you can cover a wider variety of scenarios and adapt milestone functionality to
your specific business needs. Here’s where you can get detailed information about the advanced configuration for milestones and coverages:

- The "Set Up Additional Condition Columns for Standard Coverage Entitlement Rules" and "Set Up Administrator-defined Milestones" sections provide information about managing milestone conditions, as well as creating your own milestones.
- The "Configure Milestones for Multiple Business Units" section provides information about how to configure milestones for multiple business units.
- The "Troubleshoot with Milestone Diagnostics" section provides information about reviewing milestone diagnostics for troubleshooting.

Overview of Coverage Schedule

A coverage schedule is a service calendar containing detailed time intervals that identify when a help desk request is expected to be worked.

Coverage schedules provide flexibility to define business hours and specific intervals during the year when different operating hours are offered. For example, you can define a specific interval such as a particular week or seasonal time period where you may extend service hours on specific days. You can also treat holidays or exceptions more specifically, such as offering shortened hours on some holidays, instead of a full day inclusion or exclusion.

To determine the due date and time for a milestone, time outside the specified intervals is skipped. For example, if your coverage schedule interval is 9:00 a.m. to 5:00 p.m. Monday through Friday, a milestone that started Friday at 4:00 p.m., which is due in 120 minutes, would be due 10:00 a.m. on Monday.

Coverage schedules can also contain holidays, nonworking times, or extended working hours, which identify days to be skipped or hours to be added when determining the due date. You must configure the coverage schedule exceptions before you create or modify a coverage schedule. In the previous example, when a milestone started 4:00 p.m. Friday and had 120 minutes until due, if Monday was identified as a holiday, the milestone would be due at 10:00 a.m. on Tuesday instead.

Here’s how the application calculates the Due Date and Time Remaining fields that are displayed on the Service Request Milestone Details page:

- **Due Date**: The due date for a milestone is calculated using the schedule that's associated with the applicable entitlement or coverage rule. The schedule defines whether there are any hours of the day or week when the clock isn't running for the organization, such as evenings, holidays, lunch breaks, and so on.

  When a service request is updated, the application looks at the coverage rules and the associated schedule, calculates the date and time the milestone expires, and assigns the milestone to the service request. The milestone due date is calculated based on the time the milestone starts, which may not be the same as the time the service request was created. The application displays this due date for that milestone on the Service Request Milestone Details page.

  If the SR attributes change so that the milestone goes into a paused state, the clock stops running. The application captures the time spent on the milestone up until the milestone was paused, for future use. The due date for the milestone is no longer displayed, because it can’t be determined until the milestone resumes the countdown. After the pause is lifted and the countdown resumes, the application recalculates the milestone due date. The recalculation is based on the original time you specified for that milestone when the help desk request was created, minus the cumulative time spent by the agent up to that point.
• **Time Remaining**: The **Time Remaining** field displays one of two different values, depending on whether the milestone is actively counting, or paused. The application doesn't show time remaining for milestones that are complete or canceled.

When the milestone is actively counting down, the exact due date is known. The **Time Remaining** field shows an approximation of the amount of time between the due date and the current time. This approximation is expressed in the largest indivisible unit of time and rounded down. For example, if the current time is 3:00 PM and the milestone is due at 4:05 PM, the time remaining shows 1 hour. If the current time is 10:00 AM and the milestone is due the next day at 11:00 PM, the time remaining shows 1 day.

When the milestone is paused and the due date can't be determined, the **Time Remaining** field identifies only the time left in the milestone. The time left is determined by calculating the total time specified in the coverage, minus the time spent so far. For example, a milestone that was set for 24 hours (based on the coverage rules), and that was active for 10.5 hours before it paused, will have 13.5 hours remaining for the duration of the time it's paused. The **Time Remaining** field uses the same approximation method as described for active milestones, so 13.5 hours is rounded down to show 13 hours. Again, the actual due date isn't in 13 hours, because it's unknown when the counting will resume and therefore how the schedule might affect the due date. The 13 hours is given as an approximation of the working time you will have once the milestone restarts.

A schedule named **24 by 7** is preconfigured for all implementations. This schedule doesn't specify holidays or downtime, so the due date for a milestone that uses this schedule, is calculated without skipping any time.

---

### Enable Subscription Coverages for Entitlements

Oracle recommends the use of the subscription coverages.

The **Manage Service Entitlements Using Subscription Coverages** feature is enabled by default for new instances. If this feature is enabled, the application uses Oracle Subscription Management Cloud to define entitlement calendars, coverages, and associated setup, and uses this setup at runtime to determine service request milestones.

Here's how you can enable this feature:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Help Desk
2. Click **Change Feature Opt In**.
   - Select the **Enable** check box in the Service Entitlements row.
3. Click **Done**.

**Related Topics**

- Create a Coverage Schedule
- Create Standard Coverages

---

### Create a Coverage Schedule

To create your own coverage schedule calendars with the intervals and holidays specific to your business, do the following:
1. Sign in to the application as a sales administrator.
2. On the Navigator, click Subscription Management.
   The Subscriptions page is displayed.
3. Click Subscription Configuration.
   The Subscription Configuration page is displayed.
4. To create a coverage schedule, click Entitlements Management > Manage Availability.
   The Manage Availability page is displayed.

   Note: If you’re using Service Contracts, then you navigate to this page by clicking Navigator > Contract Management > Contracts > Tasks > Manage Availability.

5. (Optional) To add the holidays, nonworking times, or extended working hours that are applicable to the coverage schedule, click the Exceptions tab.
   a. Click Create in the Exceptions pane to create a new coverage schedule exception, or select an existing entry and click Duplicate to copy and update it.
   b. In the Availability Exceptions section, click Add Event.
   c. Enter the name of the exception event, the date and times of the event, and the availability during the event.
   d. Click Save.
   e. (Optional) To delete an exception, click Delete in the Exceptions pane.

6. On the Schedules tab, click Create in the Schedules pane to create a new coverage schedule, or select an existing entry and click Duplicate to copy and update it.

7. Specify the following details:
   o Schedule Name: Name of the coverage schedule.
   o Time Zone: Time zone for which you’re creating the coverage schedule.

8. In the Date Intervals section, create a coverage schedule interval with details of when the coverage schedule starts, ends, and the days of the week that are part of the interval.
   o Start Date and End Date: Start and end dates for the coverage schedule interval.
   o Availability: Working days, hours, and times, and break times for the selected days.

9. (Optional) To include exceptions in the coverage schedule, select an exception from the Exceptions drop-down list.
10. (Optional) To delete a schedule, click Delete in the Schedules pane.
11. Click Save.

You can create multiple coverage schedules and use them as needed in the standard coverage templates. For example, you might have a high severity help desk request milestone worked using a 24 by 7 schedule, but a lower severity service request milestone might use a different schedule that's only worked during normal business hours. For more details about using coverage schedules in standard coverages, see the “Create Standard Coverages” topic.

Create Standard Coverages

The standard coverage acts as a template that contains entitlement rules, which specify when milestones are due and for what conditions.
For example, high severity help desk requests may have earlier milestone times, and use a schedule with longer work hours and fewer holidays, than lower severity help desk requests.

1. On the Subscription Configuration page, click **Entitlements Management > Standard Coverage**.

   The Manage Standard Coverage page is displayed.

2. Create a new coverage and select **HR Service Request Subscription Entitlements** or **Internal Service Request Subscription Entitlements** as the **Entitlement Type**.

   The Edit Standard Coverage page is displayed.

   **Note:** If you’re using Service Contracts, then you navigate to this page by clicking **Navigator > Contract Management > Contracts > Tasks > Standard Coverage**. Then select **Contracts Service Entitlements** as the **Entitlement Type**.

3. Select **Actions > Add Entitlements** to configure the entitlement rules structure. The **Entitlement Rules** dialog box is displayed.

   Help desk request severity is automatically included as a condition column. If you want to vary milestones based on the help desk request channel, optionally, select **Channel Type** as an optional condition column.

   a. Click **Next**, and select all optional results columns to display all available metrics and thresholds.

      You can optionally select only one of the milestones and its threshold if applicable. For example, if help desk requests that apply to this coverage shouldn’t have a first response milestone tracked, you can deselect **First Response Metric** and **First Response Warning Threshold** from **Optional Results Columns**.

   b. Click **Finish** to apply the entitlement options and complete the configuration of the entitlement rules.

   The Edit Standard Coverage page is displayed.

4. Add entitlement rules for this coverage.

   a. In the **Entitlement Rules** section, click the **Add Row** icon.

   b. Specify the **Condition Columns** (**Severity**, and if selected, **Channel Type**).

      This row is applied when the help desk request values match the condition column values specified here.

      The algorithm applying milestones to help desk requests requires that coverages never have more than one row with condition columns that match the help desk request. If you leave a condition column value blank, the null value acts as a wildcard, and then is matched against any help desk request value. While
there are valid scenarios where this can be used, it’s important to avoid having two lines that could match the same help desk request.

The following table shows an example of a valid use of a null value in standard coverage condition columns:

- In this valid example, a help desk request with high severity will only match line 1, regardless of the channel.
- A help desk request with low severity will only match line 5, regardless of the channel.
- The medium severity help desk request can only match one of lines 2 through 4, depending on the channel type.

<table>
<thead>
<tr>
<th>Line Number</th>
<th>Severity</th>
<th>Channel Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>High</td>
<td>Blank</td>
</tr>
<tr>
<td>2</td>
<td>Medium</td>
<td>Phone</td>
</tr>
<tr>
<td>3</td>
<td>Medium</td>
<td>Email</td>
</tr>
<tr>
<td>5</td>
<td>Low</td>
<td>Blank</td>
</tr>
</tbody>
</table>

The following table that shows an example of an invalid use of a null value in standard coverage condition columns:

- This invalid example shows a situation where the medium severity help desk request with a phone channel matches lines 2 and 4.
- Similarly, a medium severity help desk request with the email channel matches lines 3 and 4.
- In both cases, the help desk request won’t have any milestones applied because more than one line from a single coverage matches the help desk request.

<table>
<thead>
<tr>
<th>Line Number</th>
<th>Severity</th>
<th>Channel Type</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>High</td>
<td>Blank</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Medium</td>
<td>Phone</td>
<td>Medium, Phone would match this line</td>
</tr>
<tr>
<td>3</td>
<td>Medium</td>
<td>Email</td>
<td>Medium, Email would match this line</td>
</tr>
<tr>
<td>4</td>
<td>Medium</td>
<td>Blank</td>
<td>Medium, Phone would also match this line</td>
</tr>
</tbody>
</table>
To configure the behavior of null values in a coverage, select the **Allow Null** and **Null is Wildcard** check boxes for the selected matrix class. You will find these check boxes on the Edit Matrix Class: Subscription Entitlements page, **Condition Columns** section. For more information about using these properties on condition columns, see the section "Set Up Additional Condition Columns for Standard Coverage Entitlement Rules".

**c.** Specify the **Result Columns** (**Calendar**, along with the metric and threshold values for each milestone).

  i. From the **Calendar** drop-down list, select the coverage schedule to use for calculating the milestones' due date.

  ii. For each milestone, enter the metric in minutes, which is used with the schedule to identify when the milestone is due.

  iii. Enter the corresponding threshold value in minutes. This threshold specifies the number of minutes before expiration that the milestone’s **WarnedFlag** is set to **Y**.

**d.** Click **Save**.

**e.** Optionally, you can add multiple entitlement rules to a standard coverage.

   Each entitlement rule row is checked against the help desk request values, and if a help desk request matches all condition column values, that rule’s milestone results (values and schedule) are used to calculate the milestone due date.

---

### Create Default Coverages

You use default coverage to apply a standard coverage template to specific customers, or globally to all customers.

When a help desk request is evaluated to assign milestones, the application considers all global coverages, and employee default coverages setup for the employee specified on the help desk request. If a milestone is applicable from both a global default and a employee default coverage, the application uses the employee default coverage values over the global defaults.

1. On the Subscription Configuration page, click **Entitlements Management > Default Coverage**.

   The Manage Default Coverage page is displayed.

   **Note:** If you’re using Service Contracts, then you navigate to this page by clicking **Navigator > Contract Management > Contracts > Tasks > Default Coverage**.

2. Click **Create** to add a new coverage.
3. Select the **Default Level** for the coverage:
   - Select **Global** to assign the coverage to all employees.
     Then select the standard coverage in the **Coverage** column that you want to apply to all employees.
   - Select **Customer** to assign the coverage to a specific employee.
     Then select the customer in the **Default Level Value** column, and then select the standard coverage in the **Coverage** column that you want to apply to that employee.

4. Enter the start and end date for the coverage.

5. Click **Save**.

### How You Monitor Milestones

You configure the Monitor Service Request Milestones scheduled process to monitor the help desk request milestone status, and set the job frequency to run the job after the specified time interval.

This process ensures that the help desk request and milestone status are up-to-date and sends an email notification if compliance issues or warning flags are found. The recommended frequency for running this job is 10 minutes.

### Configure Email Notifications to Monitor Milestones

After you set up the scheduled process, you can configure object workflows to perform actions when a milestone’s **WarnedFlag** is set to **Y** or **ComplianceFlag** is set to **N** (when the milestone expires).

For example, you can configure emails to be sent out to warn required teams and managers that a milestone is about to expire, or escalate a help desk request when a milestone expires.

1. Sign in to the application as an administrator.
2. Navigate to **Application Composer** and then click **Common Setup > Email Templates**. The Email Templates page is displayed.
3. Click **Create** to create a new template. The Create Email Template page is displayed.
4. From the **Object** drop-down list, select **Milestone**.
5. Specify the **Name**, **Email Subject**, and **Email Body** for the content of the email you want to send.
6. Click **Save and Close**.
7. After you create the template, Click **Navigator > Configuration > Sandboxes**.
8. Select and enter a sandbox.
9. In **Application Composer** select **CRM Cloud** in the **Application** drop-down list, and then select **Service** as the **Object Tags** option.
10. Click **Object Workflows**. The Object Workflows page is displayed.
11. Click **Create** to create a new object workflow. The Create Object Workflow page is displayed.
12. From the **Object** drop-down list, select **Milestone**.
13. Enter the **Name** and **Description** for the object workflow.
14. Specify the **Event Point** and **Condition** for the milestone object workflow.

   For example, to trigger a workflow action when the **WarnedFlag** is set to **Y**:
   a. For the **Event Point** option, select **When a record is updated**.
b. In the **Condition** field, enter the following expression:

```java
if (isAttributeChanged('WarnedFlag') &amp;&amp; WarnedFlag=='Y')
    return true;
```

15. Select the action you want to perform as part of the workflow. You can set up **Email Notification** and **Field Updates** for the milestone.

   a. In the **Email Notification** section, click **Create** to add a new notification.
   b. Specify the schedule and addresses to which you want to send the notifications.
   c. Click **Save** to save the milestone object workflow.

16. Republish the sandbox in which you created the object workflow.

You can create a script for specific aspects of the workflow, such as looking up the assignee and assignee manager details for sending the notification. Here's an example script you can use to get the assignee and assignee manager details and populate the **Address** field for the email notification.

```java
def resourceVO = newView('Resource')
resourceVO.appendViewCriteria("PartyId = " + AssigneePartyId")//party id of SR assignee
resourceVO.executeQuery()

def mgrPartyId
while (resourceVO.hasNext()) {
    def curResourceRow = resourceVO.next()
    mgrPartyId = curResourceRow.ManagerPartyId
}
return mgrPartyId

if (mgrPartyId != null) {
    def resourceMgrVO = newView('Resource')
    resourceMgrVO.appendViewCriteria("PartyId = " + mgrPartyId")
    resourceMgrVO.executeQuery()

    def mgrEmailId
    while (resourceMgrVO.hasNext()) {
        def curResourceMgrRow = resourceMgrVO.next()
        mgrEmailId = curResourceMgrRow.EmailAddress
    }
    return mgrEmailId
}
```

**Related Topics**
- Overview of Sandboxes
- Publish Sandboxes
- Create and Activate Sandboxes

---

### Set Up Additional Condition Columns for Standard Coverage Entitlement Rules

#### Overview of Condition Columns

The application has a default entitlement type called Subscription Entitlements (or Contracts Service Entitlements), which is a matrix class, and a corresponding service mapping that you select when you create your standard coverage.
This default matrix class defines the structure of the entitlement rules for the standard coverage, including the condition columns (Severity and Channel Type), and result columns (Calendar, and milestone values and warning thresholds). Condition columns in the coverage are compared to field values in a help desk request to determine which line is applicable, and the result columns display the schedule, milestones, and thresholds that are applied.

You can use other columns from the help desk request as condition columns in coverages, by editing the service mapping and creating your own matrix class. To do this, first modify the service mapping to add the intended attribute. After you modify the service mapping, create a matrix class including the attributes, and then select the matrix class as the entitlement type for a standard coverage.

Create a Service Mapping

Here's how you create a service mapping:

2. Click Subscription Entitlements. The Edit Service Mapping: Subscription Entitlements page is displayed.
   Note: If you're using Service Contracts, then you navigate to this page by clicking Navigator > Contract Management > Contracts > Tasks > Manage Service Mappings > Contracts Service Entitlements.
3. On the Entities tab, select ServiceRequest.
4. In the ServiceRequest: Details section, click Add Row to add your attribute and select the details, for the mapping.
   Note:
   - All attribute names must have the suffix _Custom.
   - Ensure that Write is disabled for the selected attribute.
5. Click Save.
6. Click the Sources tab (on the same page, Edit Service Mapping: Subscription Entitlements).
7. In Source, select HRHelpDeskRequest or InternalServiceRequest.
8. Select ServiceRequest in the HRHelpDeskRequest: Details > Entity Mappings or InternalServiceRequest: Details > Entity Mappings tab.
9. On the Entitlement: Details > Attribute Mappings tab, click Add Row to create the mapping for the new attribute.
10. Select the attribute that you created in step 4 from the Attribute drop-down list and enter the related View Object Attribute of the help desk request.
    Note: Ensure that Write is disabled for the selected attribute.
11. Click Save.
12. Click the Services tab (on the same page, Edit Service Mapping: Subscription Entitlements).
13. Select ServiceRequest in the GetSubscriptionEntitlements: Details > Entities tab.
14. In the ServiceRequest: Entities section, click Add Row to create the mapping for the new attribute.
15. Select the attribute that you added in Step 4 from the Attribute drop-down list and enter the values.
Note: Ensure that Write is disabled for the selected attribute.

16. Click Save and Close.

Add Condition Columns to a Matrix Class

Here's how you create a matrix class and add additional conditional columns.

   
   Note: If you're using Service Contracts, then you navigate to this page by clicking Navigator > Contract Management > Contracts > Tasks > Manage Matrix Classes.

2. Duplicate the HR Service Request Subscription Entitlements or Internal Service Request Subscription Entitlements (or Contracts Service Entitlements) matrix class. You can also edit a matrix class you previously created, or create a new matrix class.

3. On the Edit Matrix Class page for the selected matrix class, in the Condition Columns section, click Add Row to add a new condition column for the mapping that you created in the previous service mapping procedure. This condition column displays in the entitlement rules along with the default columns.

4. Enter the Name of the column and the Source Code Name.

5. In the Compare to Attribute column, select the attribute that you created in the previous service mapping procedure.

6. In the Domain column, click Edit Domain and select a domain value corresponding to the attribute you're mapping.

7. To allow null values to be specified in the coverage for this column, select the Allow Null check box, and optionally, select the Null is Wildcard check box.

   Then select the appropriate value for the Null is Wildcard option, based on the intended behavior described in the following table. The Severity condition column is used as an example in the following table.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>N</td>
<td>Not possible</td>
<td>No rows applied</td>
<td>When explicit match between help desk request and coverage row.</td>
</tr>
<tr>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Blank row applied</td>
<td>◦ If the help desk request severity isn't defined in a row, the blank coverage row is applied.  ◦ If the help desk request severity is defined in a coverage row, an</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------</td>
<td>-------------------------------------</td>
<td>--------------------------------------------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>error occurs and no values are applied. Both the blank row and the matching row are considered a match, but coverages must be set up so that only one row from a specific coverage can ever be matched. If two rows match, it results in an error condition and no rows being applied. For more information, see the step 5b in the topic “Create Standard Coverages”.</td>
</tr>
<tr>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>No rows applied</td>
<td>When explicit match between help desk request and coverage row.</td>
</tr>
<tr>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>Blank row applied</td>
<td>When explicit match between help desk request and coverage row.</td>
</tr>
<tr>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>No rows applied</td>
<td>When explicit match between help desk request and coverage row.</td>
</tr>
</tbody>
</table>

8. Click **Save and Close**.
The matrix class displays in the **Entitlement Type** drop-down list when you create a standard coverage.
Set Up Administrator-Defined Milestones

Overview of Administrator-Defined Milestones

In addition to using the predefined milestones for First Response and Resolution, you can also define additional milestones to track help desk requests. This lets you configure the application effectively, based on your own business processes and service standards.

The section "Set Up Additional Condition Columns for Standard Coverage Entitlement Rules" described how you can use other columns from the help desk request as condition columns for coverages, by editing the service mapping and creating your own matrix class. You can also add result columns to a matrix class to represent the administrator-defined milestones. In addition to adding new result columns to the matrix class, you must also do the following:

1. Modify the algorithm that specifies the entitlements to include the new columns you add.
2. Add the new milestone to the Manage Service Milestone Configuration task in Setup and Maintenance.

Add the Result Columns to the Matrix Class

Here's how you can add the result columns to the matrix class:

   
   The Manage Matrix Classes page is displayed.
   
   Note: If you’re using Service Contracts, then you navigate to this page by clicking Navigator > Contract Management > Contracts > Tasks > Manage Matrix Classes.
   
2. Duplicate the HR Service Request Subscription Entitlements or Internal Service Request Subscription Entitlements (or Contracts Service Entitlements) matrix class. You can also edit a matrix class you previously created, or create a new matrix class.
3. On the Edit Matrix Class page for the selected matrix class, in the Result Columns section, click Add Row to add the administrator-defined metric and its corresponding warning threshold.
4. Enter names for the administrator-defined metric and its corresponding warning threshold.
   
   Code values are automatically populated in the Source Code Name field. The names and codes must be unique for each milestone and its corresponding threshold value (Milestone Code and Threshold Code must be unique and should not be used already in existing milestone configurations). You should copy and save these values, because you need Source Code Name in the Manage Algorithms page and Name in the Manage Service Milestone Configuration task page.
5. In the Domain field, retain the default value Number because it denotes the time in minutes.
6. Click Save and Close.
Modify the Algorithm to Include the New Milestone and Threshold Columns

Here’s how you can modify the algorithm to include the new milestone and threshold columns you created:

   
   **Note:** If you’re using Service Contracts, then you navigate to this page by clicking **Navigator > Contract Management > Contracts > Tasks > Manage Algorithms**.

2. Select the **Get Subscription Entitlements** (or **Contracts Get Service Entitlements**) row, with the algorithm version 1 and status **Published**.

3. Select **Actions > Create Version**. A new version of the algorithm is created, with the status **In Progress**.

4. Select the new version of the algorithm. The Edit Algorithm page is displayed.

5. On the **Algorithm** tab, select **Look up matching Entitlement Rule**.

6. In the **First Row Actions** section, click in the **Actions** field.

7. Copy the existing algorithm and append it. For example:
   ```javascript
   if(Matrix.hasProperty("NextResponseMetricCode")){
   rule= EntitlementResults.insert([EntitlementResultId: getNextId()])
   rule.EntitlementId=Entitlement.EntitlementId
   rule.ScheduleId=Matrix.CalendarCode
   rule.ResultName= 'NextResponseMetricCode'
   rule.ResultValue= Matrix.NextResponseMetricCode
   rule.ResultThresholdValue=Matrix.NextResponseWarningMetricCode
   }
   ``

   **Note:** If you’re using Service Contracts, use `rule.CalendarId=Matrix.CalendarCode` instead of `rule.ScheduleId=Matrix.CalendarCode`.

8. Replace the **Source Code Name** values with the values of the administrator-defined metric and its corresponding warning threshold you saved in the previous procedure for adding the result columns to the matrix class.

   In this example, `NextResponseMetricCode` and `NextResponseWarningMetricCode` are the names defined in the matrix classes.

9. Click **Save and Close**.

10. Navigate to the Manage Algorithms page.

11. Select the modified version of the algorithm, and click **Actions > Publish**. The **Status** of the algorithm is updated to **Published**.

Add the Milestone to the Manage Service Milestone Configuration Task

Here’s how you can add the milestone to the Manage Service Milestone Configuration task:

1. In the Setup and Maintenance work area, go to the following:
The Manage Milestone Configuration page is displayed.

2. Click **Create Milestone** and specify the following milestone details:

- **Milestone Label**: Enter the name of the milestone that should be displayed on the help desk request.
- **Milestone Code**: Select the name of the milestone result column you added to the matrix class. These names are defined in the matrix classes and can't be modified.
- **Milestone Type**: Select from the following types, which determine whether milestones are reopened or repeated once complete.
  - **Can be reopened**: A milestone that can be reopened is set back to In Progress status when the complete criteria is no longer true, and continues the countdown to expiration when reopened. The Resolution Metric milestone is of this type.
  - **Can be repeated**: A milestone that can be repeated can't be reopened once closed, but another one is created when the start criteria is valid. For example, suppose you configure a Next Response Due milestone that should be repeated each time an employee update is posted to the help desk request. Once a response is sent, the milestone is complete, but upon receiving a new an employee update, another Next Response Due milestone is created and tracked.
  - **Can't be repeated**: A milestone of this type can't be reopened or repeated once it's marked complete. The First Response Metric milestone is of this type.
- **Threshold Code**: Select the name of the threshold result column corresponding to the milestone, which you added to the matrix class. This determines the threshold value that's applied to the milestone. The names are defined in the matrix classes and can't be modified.
- **Business Unit Name**: Leave as the default business unit (BU) unless you're configuring milestones for multiple business units. For more information, see the "Configure Milestones for Multiple Business Units" in this guide.
- **Allow Due Date Override**: Select this check box to let agents modify a milestone's due date on the Service Request Milestone Details page (in the Due Date field).

**Note**: If a customer wants to audit agent updates to the due date, the administrator must enable audit on the Overridden Due Date attribute.

- **Allow Agent Completion**: Select this check box to let agents manually acknowledge that they have completed a milestone and close it. On the Service Request Milestone Details page, if an agent selects the Agent Completed check box and saves the milestone, the milestone status is updated to Complete. Milestones that can be reopened are reopened if the start condition is met again.

The administrator can specify which milestones allow due date updates and which allow the update to specify a milestone has been completed. These attributes are independent of each other, so that some milestones can allow only moving the due date, others might allow the agent to mark it complete but not move the due date, and still others may allow both types of updates.

3. Enter the milestone conditions. Each milestone (both prebuilt and administrator-defined) has conditions that determine when the milestone starts, pauses, and completes. For each condition, you can define multiple attribute and value pairs that determine when the condition is applied to the milestone.

- Each tab has a text box that enables you to provide a common description that's displayed in the help desk request details when the milestone is applied to the help desk request. This description enables
an agent to understand when a milestone starts counting, when it pauses, and when it’s considered complete.

- Add conditions using the Create button in the tab. Use the Attribute column to indicate a field to compare to a value using the operator. The Attribute column lists administrator-defined fields and a subset of the service request fields that are available to use as conditions. Alternately, you can specify a static condition that doesn’t require an operator or value. You can also use object functions written in Groovy, to express more complex start, pause, and stop criteria for milestones.
  - For example, if you specify the field **Problem Type Code**, you must specify the operator (**Is One Of**, **Is Not One Of**) and the values that make this criteria true.
  - Alternately, if you specify a static condition such as **Immediate**, no operator or value is required. In this case, the criteria is considered true as soon as the service request is evaluated.
  - You can specify a logical condition in the form `<attribute> <comparison> <operator values>`. For example, you can specify **Status Type** (attribute) **Is One Of** (operator) **Closed, Resolved** (values) as the completion criteria for Resolution Milestone. You can also specify a static predefined condition such as **User Sends Response**, which evaluates to true as soon as any user sends a response message.

When an object function is written on the help desk request object in Application Composer to return a Boolean value, the function is available as start, pause, and completion criteria. Similar to the static conditions, when an administrator-defined object function is selected, the operator and values aren’t required. When the function returns true, the start, pause, or completion criteria specifying that function is triggered.

- When multiple rows are added as conditions, the results are combined logically using the AND operator, so all rows must evaluate to true for the criteria to be true.

**Related Topics**

- Update Existing Setup Data

**Troubleshoot with Milestone Diagnostics**

**Overview of Milestone Diagnostics**

Administrators can use the Help Desk Request Milestone Diagnostics page to validate or troubleshoot your milestone rules. The administrator can run a milestone diagnostics report for a specific help desk request and view the full evaluation of milestone rules.

The milestone diagnostics report provides the following information:

- Which milestones were applied?
- Which milestones and coverages were considered but not applied?
- From which coverage did an applicable milestone originate?
- Did the milestone apply or not apply based on the associated business unit?
Review Milestone Diagnostics

Here's how you can view the milestone diagnostics report:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Help Desk
   - Functional Area: Service Entitlements
   - Task: Manage Service Milestone Configuration for HR Help Desk Requests or Manage Service Milestone Configuration for Internal Help Desk Requests

2. On the Manage Milestone Configuration page, click Actions > View Milestone Diagnostics.

   The Service Request Milestone Diagnostics page is displayed.

3. Enter the help desk request number in the Service Request field.

4. Click Check Milestones.

   The milestones that are applicable to the specified help desk request are displayed in a table, with the corresponding metrics and the following details:
   - Defined for BU: Indicates whether the milestone configuration definition was created for the applicable business unit.
   - Applicable to SR: Indicates whether the milestone from the specified coverage would be applied to the help desk request.
   - Notes: Provides additional information when the milestone isn't applicable to the help desk request.
9 Set Up Action Plans

Overview of Action Plans

Action plans are used to complete a series of steps or a sequence of events to resolve different types of requests.

You can associate action plans to help desk requests if you need to complete a series of steps or a sequence of events to resolve the request.

You can attach action plans to a help desk request using an administrator-defined template, or by adding individual actions. Actions can be required or optional tasks, activities, or appointments, or help desk requests.

You can add Action Plans to the following objects:

- Internal Help Desk Requests
- HR Help Desk Requests

Agents can add either solo actions, or action plans. Actions can be required or optional tasks, activities, or appointments.

- **Solo Actions** are individual actions added to an object.
- **Action Plans** are added from an administrator-defined template. Action plans are made up of multiple actions.

By using actions and plans, users have:

- A visual aid to see the progress of a solo action or an action plan
- Any warnings on actions or plans

To use the Action Plans feature, set up actions, templates, and categories in Setup and Maintenance.

In Setup and Maintenance, navigate to Help Desk > Action Plan. If Action Plan isn't displayed, use the Change Feature Opt In to activate Action Plans.

The following table shows the name and description of each action plan setup task.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Action Plan Profile Options</td>
<td>Manage profile options for the Action Plans feature.</td>
<td>Yes</td>
</tr>
<tr>
<td>Manage Action Plan Actions</td>
<td>Create actions that can be used for solo actions or in action templates. You can specify the category, type, duration, and visibility for each action.</td>
<td>Yes</td>
</tr>
<tr>
<td>Manage Action Plan Templates</td>
<td>Create templates to group similar actions to be added to an action plan.</td>
<td>Yes</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
<td>Required</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Manage Action Categories for Action Plans</td>
<td>Action categories are used to facilitate finding actions to add to templates or directly to an action plan.</td>
<td>No</td>
</tr>
<tr>
<td>Manage Template Categories for Action Plans</td>
<td>Template categories are used by agents to filter and find templates to apply to an action plan.</td>
<td>No</td>
</tr>
<tr>
<td>Manage Mapping of Action Plan Status Values</td>
<td>Manage the global setup for status configuration. You can map task, appointment, or request attributes to an action status at a global level. Action status mapping can also be done at the individual action level.</td>
<td>No</td>
</tr>
</tbody>
</table>

**Related Topics**

- Manage Action Plan Actions
- Manage Action Plan Templates
- Map Action Plan Status Values

**Manage Action Plan Profile Options**

The following are the available action plan profile options and their descriptions.

Manage the Action Plan profile options in Setup and Maintenance. Navigate to:

- **Offering**: Help Desk
- **Functional Area**: Action Plans
- **Task**: Manage Action Plan Profile Options

The following table shows the action plan profile options and their descriptions.

| Profile Option                                      | Description                                                                                                                                                                                                 |
|-----------------------------------------------------|-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------|----------|
| SVC_ENABLE_ACTION_PLAN                              | Specify if Action Plan is enabled for help desk requests.                                                                                                                                                  |          |
| SVC_ENABLE_SUBSCRIPTION_SCHEDULES_IN_ACTION_PLANS  | Enable calculation for action plan estimated completion times based on schedules defined in Subscription Cloud.                                                                                           |          |
### Manage Action Plan Actions

Use the Manage Action Plan Actions task to create and edit actions for action templates or individual actions used in help desk requests. In this task, you specify the category, type, duration, visibility, and attribute mappings for each action.

To manage action plan actions, in the Setup and Maintenance work area go to the following:

- Offering: Help Desk
- Functional Area: Action Plan
- Task: Manage Action Plan Actions

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ORA_SVC_DEFAULT_SUBSCRIPTION_SCHEDULE</strong></td>
<td>Specifies a default subscription schedule to use as a calendar if subscription schedules are enabled (profile option SVC_ENABLE_SUBSCRIPTION_SCHEDULES_IN_ACTION_PLANS = Y) and the action plan template doesn’t have an explicitly assigned subscription schedule.</td>
</tr>
<tr>
<td><strong>ORA_SVC_AP_PROCESS_METADATA_VALIDATION_ENABLED</strong></td>
<td>Enable the validation of process metadata in action plan. Use this profile option to validate the process being associated to an action when a dynamic process action is created or updated in a REST request.</td>
</tr>
<tr>
<td><strong>ORA_SVC_AP_DEFAULT_OBJECT_LINK_TYPE</strong></td>
<td>The Object Link Type used when Object Links are created by Actions and Plans.</td>
</tr>
<tr>
<td><strong>ORA_SVC_AP_ENABLE_OBJECT_LINK</strong></td>
<td>Enable the creation of object links between supported objects in actions and plans.</td>
</tr>
</tbody>
</table>

**Note:**
If you don’t set this profile option, contract schedules are used.
Oracle recommends using subscription schedules.
If an action plan template doesn’t have an explicitly assigned valid subscription schedule, then SVC_DEFAULT_CRM_CALENDAR/SVC_DEFAULT_HCM_CALENDAR profile options are used to specify a default contract schedule to use as a calendar.
If SVC_DEFAULT_CRM_CALENDAR/SVC_DEFAULT_HCM_CALENDAR aren’t set, a 24/7 schedule is used by default to perform any date computations.

**Note:**
If an action plan template doesn’t have an explicitly assigned valid subscription schedule, then SVC_DEFAULT_CRM_CALENDAR/SVC_DEFAULT_HCM_CALENDAR aren’t set, a 24/7 schedule is used by default to perform any date computations.

**Note:**
If an action plan template doesn’t have an explicitly assigned valid subscription schedule, then SVC_DEFAULT_CRM_CALENDAR/SVC_DEFAULT_HCM_CALENDAR aren’t set, a 24/7 schedule is used by default to perform any date computations.

**Note:**
If an action plan template doesn’t have an explicitly assigned valid subscription schedule, then SVC_DEFAULT_CRM_CALENDAR/SVC_DEFAULT_HCM_CALENDAR aren’t set, a 24/7 schedule is used by default to perform any date computations.

**Note:**
Used for the Run Process through Action Plans feature. A subscription to Oracle Process Automation is required in order to take advantage of this feature.
Create a New Action

Here's how to create a new action:

1. Click **Create Action**.
2. Enter the action name.
3. If you enabled business units or stripe codes, use the drop-down lists to select the stripe code and BU.
4. Select **Category**.
   
   Select **Class**.
5. Select the **Action Type**.

   Depending on the Help Desk features you’re using, Action types can include:
   
   - Appointment
   - Article
   - Case
   - Dynamic Process
   - HR Help Desk Request
   - Internal Service Request
   - Task

   **Note:** You can create an Action type Article. You must select Stripe Code of the action and then select Sub Type of the action. Attribute mapping section needs to be populated as it’s required for any other type of actions.

   - Follow the next four steps if you’re creating a Dynamic Process Action (with the **Run Processes Through Action Plans** feature). If you aren’t using this feature, you can skip the next four steps.

6. Click the **Edit** icon in the **Process Name** field.
7. Search for and select the process you want to add to the action.

   Processes must already be created in Oracle Process Cloud and your connections to Oracle Process Cloud must be working.

   Also, the administrator must be added to the Process Application Administrator role in the process workspace UI so they can see all processes.

   **Note:** When you create processes, you must define the following case-sensitive input parameters - objectNumber, objectType, actionPlanId, actionPlanActionId, and processParentObjectType when configuring dynamic processes. For Solo Actions, input parameter `processParentObjectType` will have value ‘ActionPlan’ while for Plan based actions it will have ‘ActionPlanAction’.

8. Click **OK**.
9. Select to use the default version of the process, if you want to use the default process version instead of the version-specific process.

**CAUTION:** After a process is deployed, overriding it will remove all running instances. Oracle recommends that you create a new version for additional changes and mark it as default, if it’s required. An action which has **Use default version** selected will ensure that only the default version in Oracle Process Automation is used to create process instances. For processes whose inputs are form based, make sure the interface argument is the same.

10. Select the **Action Visibility**.

Visibility options include:
- Not Published - Only visible to the administrator. The action isn't available to add to a template and can't be added by an agent as an additional action.
- Customer Visible - Optional. Used only for user interface configurations to display or hide Actions.
- Internal Only - Visible internally only.

11. Enter a context for the action.

Context options include:
- Internal Help Desk Request
- HR Help Desk Request
- Case

12. Enter a numeric value for the **Duration** of how long the task should take. Select a unit of measure for the numeric value (days, hours, or minutes).

13. Select a **Stripe Code** (HR Help Desk Request stripe, or Internal Service Request stripe) from the drop-down list.

**Note:** If you select the type as SR, you shouldn't select stripe as ISR/HRHD. This leads to ambiguity whether the underlying object created should be CRM SR or ISR/HRHD.
- If the agent wants the associated object to be CRM SR, select the following:
  - Type: SR
  - Stripe: ORA_SVC_CRM
- If the agent wants the associated object to be ISR, select the following:
  - Type: ISR
  - Stripe: ORA_SVC_ISR
- If the agent wants the associated object to be HRHD, select the following:
  - Type: HRHD
  - Stripe: ORA_SVC_HRHD

14. Select a **Category** from the drop-down list.

15. You can define a specific relationship to be created for the action by selecting an **Object Link Type** from the drop-down list. If you don't select a specific object link type, the global setting is used.
16. Check the Copy Attachments checkbox if you want all attachments to be copied from the context object to the target object. You can select to copy all attachments for the following object types:
   - Cases
   - Service Requests
   - Help Desk Requests
   - Internal Service Requests

17. Enter a description of the action and any pertinent details.
18. If necessary, make edits on the **Attribute Mapping** or **Status Mapping** tabs. These are explained next.
19. Click **Save and Close**.

### Attribute Mapping Tab

Every action in an action plan has a related object (as in a task, appointment, opportunity, case, or help desk request) that's automatically created when the action starts.

The attribute mapping tab is where you set up the mapping of information from the action, parent help desk request, and user-defined values into the related object when it's created.

**Note:** There are no attributes to map for Dynamic Processes. If you're creating a Dynamic Process Action, there isn't anything to do on this tab.

Mapped attributes come from the fields in the related object. Required attributes are automatically listed, and you can add optional attributes. The **Mapped To** column shows where the information comes from that populates the field on the related object.

**CAUTION:** If you map attributes incorrectly, the creation of the business objects during orchestration in Action Plans will fail.

Required fields are shown in the **Required** column. Additional fields might also be listed that can't be changed. For example, Activity Type displays Task if that action type is Task or defaults to Appointment if the action type is Appointment.

Here's how you add an attribute mapping:

1. Click the **Add** icon.
2. Select the field to be populated from the **Attribute** choice list.
3. In the **Mapped To** column, select from where the fields must be populated. Choices are: service request, action, or a user-defined value.
4. Depending on the attribute you selected in the previous step, enter free-form text to the box for free-form values. For service request or action, select the field from the choice list in the last column.

For more information about mappings for an article, see the topic **Attribute Mappings for Knowledge Articles** in this chapter.

### Status Mapping Tab

The related business objects created for actions can have different user-defined status values. However, they must be mapped into a new set of status codes for an action in an action plan. You can do this at a global level for all actions, or individually for one action if it has unique attributes. When a user updates an object, the status mapping
rules determine how the status of an action updates on an action plan. For example, when a task is set to closed or completed, then the action status is completed.

**Note:** If you don't define the status mapping at the action level, then the default is the global status mapping. Also, there are no statuses to map for Dynamic Processes. If you're creating a Dynamic Process Action, there isn't anything to do on this tab. There are however, predefined status value mappings that can't be changed.

For more information about the global action status configuration, see the topic Manage Mapping of Action Plan Status Values.

The following table shows the predefined Process Automation status values that are mapped with Action Plan status values.

<table>
<thead>
<tr>
<th>Process State</th>
<th>Action Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>ORA_SVC_IN_PROCESS</td>
</tr>
<tr>
<td>Completed</td>
<td>ORA_SVC_COMPLETED</td>
</tr>
<tr>
<td>Terminated</td>
<td>ORA_SVC_COMPLETED</td>
</tr>
<tr>
<td>Closed</td>
<td>ORA_SVC_COMPLETED</td>
</tr>
</tbody>
</table>

For more information about the global action status configuration, see topic Manage Mapping of Action Plan Status Values.

You can use the Status Mapping tab on an action to override the global status mappings. For example, if the global rule is set to an action being closed when the status is complete, but instead you want it to be closed when it's canceled, you can override the global mapping so that the action closes when both conditions are met.

1. Click the **Status Mapping** tab.
2. Click the **Add** icon.
3. Select a status from the **Status** choice list. This becomes the status that ends up on the action.

   Status options include:
   - Blocked
   - Completed
   - In progress

   **Note:** Apart from these three status values, you should not set up rules for any other status.

4. Select an attribute from the choice list.
5. Select an operator.

   Operators include:
   - Contains
   - Equals
6. Select a value for the status.

**Example of a Status Mapping**

Let's say you want an action to be marked completed when a service request's status is completed or canceled.

The following table shows the values to enter on the Status Mapping tab.

<table>
<thead>
<tr>
<th>Column</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Completed</td>
</tr>
<tr>
<td>This is the status you want the action to be.</td>
<td></td>
</tr>
<tr>
<td>Attribute</td>
<td>Status</td>
</tr>
<tr>
<td>This attribute comes from the SR.</td>
<td></td>
</tr>
<tr>
<td>Operator</td>
<td>is one of</td>
</tr>
<tr>
<td>Value</td>
<td>Completed, Canceled</td>
</tr>
<tr>
<td>This is the request's status. You can select multiple values from the list.</td>
<td></td>
</tr>
</tbody>
</table>

**Dependencies Tab**

When an action is added to a template, the **Dependencies** tab shows the template name. You use this to know what templates are impacted by a change to an action. If the action is in a template, you can also view and edit the template from this tab.

**Note:** Edits made to templates don't affect active action plans that use the template.

**Action Errors Tab**

The **Action Errors** tab lets you to recreate actions for users when there are errors in action attribute mapping. For example, if the attribute in an attribute mapping is mapped incorrectly, the **Action Errors** tab is displayed. From the tab, you can see all the action plans that the action is used in, and after they are fixed, the action plan actions can be recreated directly from this tab.

This tab isn't used for Dynamic Process actions.

The Action Errors tab shows a table with the action plan number, action plan name, and the status details of the action.

Review the attribute mappings the action and correct the error. After attribute mapping for the action is corrected, you can return to the **Action Errors** tab and click **Recreate**.
Edit an Existing Action

To edit an existing action:

1. In the Manage Action Plan Actions task, select the template you want to edit.
2. Edit the action.
3. Click Save and Close.

Related Topics
- Manage Action Plan Templates
- Map Action Plan Status Values
- Update Existing Setup Data

Manage Action Plan Templates

The Manage Action Plan Templates task is used to create or edit templates that include multiple actions that must be completed to close a help desk request.

In the Setup and Maintenance work area, go to the following:
- Offering: Help Desk
- Functional Area: Action Plan
- Task: Manage Action Plan Templates

Create a New Action Plan Template

To create a new action plan template:

1. Click Create Template.
2. Enter a name for the template.
3. Select the type of business calendar for the duration and end dates of the actions.
   
   Note: The calendar comes from the list of schedules defined under Subscription Management in the Manage Availability page. For more information about calendars, see the Create a Coverage Schedule topic in this guide.

4. Enter a start date for the template.
5. Enter an end date for the template (optional).
6. Check Published to publish the template when it's ready for agents to use.
7. Enter a Description.
8. Select a Category. Categories are available only if you set them up in the Manage Action Categories for Action Plan task.
9. Select a the Context from the list of values. Context values include:
   - Article
   - Case
HR Help Desk Request
Internal Service Request

10. If business units are enabled, select the business unit for the template.
11. If stripe codes are enabled, select the stripe code for the template.
12. Select **Auto Start** to designate the action plan template to start automatically.

Any Templates with this setting, once assigned using the Action Plan REST API, are started either on the next execution of the action plan scheduled job (Monitor Action Plan Actions), or a REST call to refresh the action plan.

**Note:** You may need to create the action plan with `create & Initiate` status using the REST API. If you create it using just the Create status, it won’t consider it for Auto Start on the REST scheduled job or refresh the REST action call.

13. Add actions to the template by clicking the **Add** icon in the **Action Flow** region of the page.
14. On the **Add Actions to Template** page, search for the action to add by entering a name, category, or action type.
15. Click **Search**.
16. From the search results, add an action by clicking the **Add** icon for the action you want to add.
17. Now, search and add all the actions you want to place on the template.

**Tip:**
- You may not see all actions. Actions can be limited by stripe and business unit.
- You can delete actions from the **Actions to Add** pane by clicking the delete icon.
- You can add the same action multiple times. For example, if the action is to obtain approval from two managers, add the action twice.
- You can reorder actions using the arrow icons.
- If you can’t find an action, you can create actions. Click **Create New Action**.

18. When you have added all the actions you want on the template, click **Add to Template**.

On the Template page, the actions display in a list view. You can also view the template in a graphical view by selecting the graphic icon.

19. In the **Prerequisite** column, set any prerequisites for each action in the template. Select the action row in the **Prerequisites** column and click the **Add Prerequisites** icon.
20. Select the check box next to the actions that you want to make a prerequisite for the action.

**Tip:**
- For actions that have prerequisites, mouse over the prerequisite to show the names of the prerequisite actions.
- Use the graphical view to see the order of completion for the actions.

21. Actions are automatically set to mandatory in the **Mandatory** column. Deselect the check box to make an action optional.
If an action is identified as Optional, the agent has the ability to skip the action if it does not apply to her specific action plan. Mandatory actions can’t be skipped.

22. Click **Save and Close** to complete the template.

**Edit an Existing Template**

To edit an existing template:

1. In the **Manage Action Plan Templates** task, select the template you want to edit.
2. Make your edits.
3. Click **Save and Close**.

**Related Topics**

- Manage Action Plan Actions
- Create a Coverage Schedule
- Update Existing Setup Data

**Map Action Plan Status Values**

Use the Manage Mapping of Action Plan Status task to create or edit global status mappings from related action business objects to an action plan.

The global mapping can be overridden at the individual action level. For example, you can set an action status as complete when the related help desk request status is resolved or closed.

To manage mapping of action plan statuses, in the Setup and Maintenance work area, go to the following:

- Offering: Help Desk
- Functional Area: Action Plan
- Task: Manage Mapping of Action Plan Status Values

On the Action Status Configuration page, select from the following action types.

- Appointment
- Case
- HR Help Desk Request
- Internal Service Request
- Opportunity
- Service Request
- Task

You can edit the existing status, or click the **Add** icon to add additional status configurations.

**Note:** When assigning user-defined values, you can enter any value as a user defined value during attribute mapping. There’s no validation performed on that value.
Related Topics

- Overview of Action Plans
- Manage Action Plan Actions
- Update Existing Setup Data
- Overview of Opportunities
10 Configure Outcomes and Resolutions

Outcomes and Resolutions

Oracle Help Desk provides ready-to-use outcomes and resolutions. Administrators can configure additional outcomes and resolutions.

Oracle recommends that you use the task Manage Outcomes and Resolutions for Internal Help Desk Requests or Manage Outcomes and Resolutions for HR Help Desk Requests if you want to associate the outcomes, and display the configured items as drop-down list menu in the Resolve Service Request dialog box.

The Manage Outcomes and Resolutions for Internal Help Desk Requests or Manage Outcomes and Resolutions for HR Help Desk Requests task is used when administrators want to create new resolutions and map them to outcomes. The task must only be used when administrators want to create new resolutions and don't want to map them to outcomes.

Manage Outcomes and Resolutions

The Manage Service Request Outcomes and Resolutions tasks are used when administrators want to create new outcomes, resolutions, and map resolutions to outcomes.

Follow these steps to configure Outcomes and Resolutions, and map them:

**Step 1: Configure Outcomes**

To add an outcome:

1. Sign in to the application as an administrator.
2. In the Setup and Maintenance work area, go to the following:
   - Offering: Help Desk
   - Functional Area: Help Desk Request
   - Task: Manage Outcomes and Resolutions for Internal Help Desk Requests or Manage Outcomes and Resolutions for HR Help Desk Requests
3. Select the Outcome tab.
4. Click the Add icon to add a new outcome.
5. In the new row that displays, enter the fields such as lookup code, display sequence, meaning, description, and so on to correspond to your needs.
   - **Note:** Oracle recommends that you name the outcome lookup code starting with SVC_ to differentiate between customer-created outcomes and ready-to-use outcomes.
6. Click Save and Continue. If you have selected the Enabled check-box, the outcome is added to the Outcomes list under the Map Resolutions to Outcomes section, else the new outcome is only listed in the Outcomes list.

**Step 2: Configure Resolutions**
Administrators can configure new resolutions in the Manage Service Request Outcomes and Resolutions for Internal Help Desk Request or Manage Service Request Outcomes and Resolutions for HR Help Desk Request task.

To add resolutions:

1. In the Manage Service Request Outcomes and Resolutions for Internal Help Desk Request or Manage Service Request Outcomes and Resolutions for HR Help Desk Request task page, select the Resolution tab.
2. Click the Add icon to add a new resolution.
3. In the new row that displays, enter the fields such as lookup code, display sequence, meaning, description, and so on to correspond to your needs.
4. Click Save and Continue.

If you have selected the Enabled check-box, The resolution is added to the Available Resolutions list under the Map Resolutions to Outcomes section.

Step 3: Map Outcomes to Resolutions.

Administrators can map the outcomes to the available resolutions in the Map Resolutions to Outcomes section in the page.

To manage the outcomes and resolutions:

1. In the Map Resolutions to Outcomes section, do the following to map the outcomes to resolutions.
   - Select an outcome in the Outcomes list.
   - Select the resolutions from Available Resolutions list and move them to the Selected Resolutions list.
   - To remove an existing mapping, select the resolutions from the Selected Resolutions list and move them to the Available Resolutions list.
2. Click Save and Close.

The outcomes are now mapped to the resolutions.

Once the outcomes and resolutions have been configured, these appear in the Resolve Help Desk Request dialog box in the Outcome and Resolution Code list, and the user can enter simple and consistent resolution information about the request.

### Ready to Use Outcomes and Resolutions for Help Desk

The following table lists the ready to use outcomes and resolutions.

<table>
<thead>
<tr>
<th>Outcomes</th>
<th>Resolutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue Resolved</td>
<td>Solution Provided</td>
</tr>
<tr>
<td>Question Answered</td>
<td>FAQ</td>
</tr>
<tr>
<td></td>
<td>Knowledge Article</td>
</tr>
<tr>
<td>Employee Abandoned</td>
<td>Failed attempts to contact</td>
</tr>
</tbody>
</table>
# Configure Outcomes and Resolutions

<table>
<thead>
<tr>
<th>Outcomes</th>
<th>Resolutions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Resolved by Employee</td>
</tr>
<tr>
<td></td>
<td>No response from Employee</td>
</tr>
</tbody>
</table>
11 Adaptive Intelligence

Help Desk Request Classifications

Configure Classifications for HR Service Requests and Internal Service Requests

Overview of Request Classifications
When your employee sends a help desk email for a new issue, the email is converted to a Help Desk request. The request should have its Title, Problem Description, and Primary Point of Contact prepopulated. However, fields such as Category and Product that are useful in routing the request to its proper queue and assignee are blank. By enabling the HR Service Request Classification and Internal Service Request Classification feature, the Product, and Category can be auto populated when the request is created. The agent doesn't need to populate it manually. This feature applies to requests created by the inbound email channel.

Attribute predictions come from the Adaptive Intelligence (AI) applications platform that's already provisioned for you. Here's a brief outline of how help desk requests are classified:

1. The database contains records of all resolved requests created from past inbound emails. These requests have either product, category, or both already populated. Resolved requests are considered correct for the purpose of building the Machine Learning (ML) model within the AI application.

   Note: Accurate model predictions rest on the fact that historical resolved requests have correct labels.

2. You must activate the tenant from the Configure HR Service Request Classification and Internal Service Request Classification page. After you activate the tenant, data from closed requests is imported by the AI application.

3. The AI model automatically learns, so it returns the predicted product or category based on data from closed requests in Help Desk.

4. Based on analysis of the subject line and body of the email, the model classifies requests and returns products and categories that have the highest confidence.

5. While reviewing the assigned request, an agent can manually update the AI-labeled fields, if required.

Note: You can also get visibility into how well predictions are happening in terms of coverage and accuracy. For more information, see Use the Insights Dashboard for Analytical Reporting. You can also configure some profile options as described in Configure Profile Options.

Prerequisites for Classifying Requests
Here's a list of prerequisites required for classifying help desk requests created from inbound emails:

- Ensure that you have the promotion code provided by Oracle to activate the feature. For more information, see Activate the Feature with the Promotion Code.
- Assign the required roles to your administrators as described in Required Roles.
- Ensure that you have enough data for resolved requests in your application. You must have a minimum of 50 records to start training the model. For the best results, Oracle recommends that you train the model with
at least 10,000 records to have quality predictions. Each record must have a distinct category or product as required.

| Note: | The quality of predictions depends on the volume and quality of data that’s used to train the model. |

### Required Roles

To activate HR service request and internal service request classification in the Classification administration UI, you must first assign the following roles to your administrators:

- **CRM SVC Attribute Detection Administrator**: You can find this role in the application for AI Apps in Oracle Identity Cloud Service (IDCS).
- **Adaptive Intelligence Applications Administrator**: You can add this role from the Security Console.

Users who are assigned these roles can access the REST service of SR Classification Prediction Service and the administration UI of SR Classification.

### Required Connections and Validations

The following pages help you to make the required connections and validations, so that Help Desk can detect request attributes and make predictions.

#### Pages for the Required Connections and Validations

<table>
<thead>
<tr>
<th>Page</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure SR Classification</td>
<td>Enables the AI application to connect to Help Desk. You must specify your Help Desk user name and password here. These details are used to pull in the data from Help Desk. For more information about this page, see <em>Start the Data Ingestion and Model Training.</em></td>
</tr>
<tr>
<td>Inbound Email Configuration and Validation page in Fusion Service</td>
<td>Validates whether the configuration is complete, the model is built, and the prediction service works effectively. After the applications are connected, you can create a sample payload and see a sample prediction. You can test the AI feature to validate whether the Classification API prediction is correct. For more information about this page, see <em>Validate the Setup.</em></td>
</tr>
</tbody>
</table>

### Set Up Help Desk for HR Service Request Classification and Internal Service Request Classification

#### Steps to Set Up Request Classification

Here's the sequence of procedures that you must complete to set up classification for help desk requests:

| Note: | You must complete each step in the following order: |
Setup Steps

<table>
<thead>
<tr>
<th>Step</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Activate the Feature with the Promotion Code</td>
</tr>
<tr>
<td>2.</td>
<td>Enable Request Classification</td>
</tr>
<tr>
<td>3.</td>
<td>Configure Profile Options</td>
</tr>
<tr>
<td>4.</td>
<td>Validate the Authentication with the AI Application</td>
</tr>
<tr>
<td>5.</td>
<td>Start Data Ingestion and Model Training</td>
</tr>
<tr>
<td>6.</td>
<td>Validate the Setup</td>
</tr>
</tbody>
</table>

Activate the Feature with the Promotion Code

To classify requests, you must first activate the feature by entering the promotion code.

1. Sign in to Oracle Fusion Service as a setup user.
2. Click My Enterprise.
3. Click Enterprise.
4. Click Manage Promotion Codes.
5. On the Manage Promotion Codes page, click Enter Promotion Code.
6. In the Promotion Code field of the Enter Promotion Code dialog box, enter the promotion code: SVC39682.
7. Click Save and Close.
8. Click Done on the Manage Promotion Codes page.

Results:
The Service Adaptive Intelligence feature now appears on the Opt-In: Service page in Setup and Maintenance.

Enable Request Classification

You must enable the classification of requests created from inbound emails.

1. Sign in to Fusion Service as a setup user.
2. Navigate to the Setup and Maintenance work area and select the Help Desk offering.
3. Click Change Feature Opt In.
4. On the Opt In: Service page, click the Help Desk Adaptive Intelligence row and select the Enable check box.
5. On the same row, click Edit in the Features column.
6. On the Edit Features: Help Desk Adaptive Intelligence page, click the Enable check box for HR Service Request Classification or Internal Service Request Classification.
7. Click the Enable check box for Classify Service Email for Help Desk or Internal Service Request Email Classification.
8. Click Done.
9. Click Done on the Opt In: Help Desk page.

Configure Profile Options

You can set options for classifying help desk requests by configuring some email profile options. These profile options are predefined, but you can change their values based on your requirements.
Here are the profile options to configure followed by the procedure for configuration:

### Profile Options for Classifying HR Help Desk Requests

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_SVC_ENABLE_ATTR_DETECTION_MASTER_IDCS_APP</td>
<td>Enables the use of the master IDCS application authentication for SR classification REST API calls. The default value is No.</td>
</tr>
<tr>
<td>CAUTION: You must enable this profile option by setting the value to Yes, otherwise Help Desk can't connect to the AI application.</td>
<td></td>
</tr>
<tr>
<td>ORA_SVC_ENABLE_INBOUND_MSG_HRHD_CATEGORY_PREDICTION</td>
<td>Enables the prediction for the category attribute during the processing of inbound emails to create help desk requests. The default value is Yes. To turn off category predictions, set the value to No.</td>
</tr>
<tr>
<td>ORA_SVC_ENABLE_INBOUND_MSG_HRHD_PRODUCT_PREDICTION</td>
<td>Enables the prediction for the product attribute during the processing of inbound emails to create help desk requests. The default value is Yes. To turn off product predictions, set the value to No.</td>
</tr>
<tr>
<td>ORA_SVC_INBOUND_MSG_PREDICTION_THRESHOLD_FOR_HRHD_CATEGORY_ID</td>
<td>Specifies the threshold value to decide whether the predicted category ID can be stamped on the help desk request. The default value is: 0.6 This means that if the prediction has a confidence level of more than 60%, only then you stamp the predicted value on the help desk request. Otherwise, don’t stamp it on the request. It’s possible to run the service in the dark mode by setting the threshold value to 1.0. In the dark mode, the prediction happens but it isn’t stamped on the request. This way, you can see what the correct labels would have been if the accuracy had been set lower.</td>
</tr>
<tr>
<td>ORA_SVC_INBOUND_MSG_PREDICTION_THRESHOLD_FOR_HRHD_PRODUCT_ID</td>
<td>Specifies the threshold value to decide whether the predicted product ID can be stamped on the help desk request. The default value is: 0.7 This means that if the prediction is more than 70% accurate, only then you stamp the predicted value on the request. Otherwise, don’t stamp it on the request. It’s possible to run the service in the dark mode by setting the threshold value to 1.0. In the dark mode, the prediction happens but it isn’t stamped on the request. This way, you can see what the correct labels would have been if the accuracy had been set lower.</td>
</tr>
</tbody>
</table>

### Profile Options for Internal Help Desk Requests

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_SVC_ENABLE_ATTR_DETECTION_MASTER_IDCS_APP</td>
<td>Enables the use of the master IDCS application authentication for SR classification REST API calls. The default value is No.</td>
</tr>
<tr>
<td>Profile Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>ORA_SVC_ENABLE_INBOUND_MSG_ISR_CATEGORY_PREDICTION</strong></td>
<td>Enables the prediction for the category attribute during the processing of inbound emails to create help desk requests. The default value is Yes. To turn off category predictions, set the value to No.</td>
</tr>
<tr>
<td><strong>ORA_SVC_ENABLE_INBOUND_MSG_ISR_PRODUCT_PREDICTION</strong></td>
<td>Enables the prediction for the product attribute during the processing of inbound emails to create internal help desk requests. The default value is Yes. To turn off product predictions, set the value to No.</td>
</tr>
</tbody>
</table>
| **ORA_SVC_INBOUND_MSG_PREDICTION_THRESHOLD_FOR_ISR_CATEGORY_ID** | Specifies the threshold value to decide whether the predicted category ID can be stamped on the internal help desk request. The default value is: 0.6

This means that if the prediction has a confidence level of more than 60%, only then you stamp the predicted value on the internal help desk request. Otherwise, don't stamp it on the request.

It's possible to run the service in the dark mode by setting the threshold value to 1.0. In the dark mode, the prediction happens but it isn't stamped on the request. This way, you can see what the correct labels would have been if the accuracy had been set lower. |
| **ORA_SVC_INBOUND_MSG_PREDICTION_THRESHOLD_FOR_ISR_PRODUCT_ID** | Specifies the threshold value to decide whether the predicted product ID can be stamped on the internal help desk request. The default value is: 0.7

This means that if the prediction is more than 70% accurate, only then you stamp the predicted value on the request. Otherwise, don't stamp it on the request.

It's possible to run the service in the dark mode by setting the threshold value to 1.0. In the dark mode, the prediction happens but it isn't stamped on the request. This way, you can see what the correct labels would have been if the accuracy had been set lower. |

1. Sign in as a setup user or administrator.
2. Navigate to the Setup and Maintenance work area.
3. Open the Tasks panel tab and click Search.
4. Search for and click the Manage Internal Service Request Classification Profile Options or the Manage HR Service Request Classification Profile Options task.
5. On the Manage Internal Service Request Classification Profile Options or the Manage HR Service Request Classification Profile Options page, click the profile options listed in the previous table.
6. Do the following for each profile option:
   a. In the Profile Values region, in the Profile Level drop-down list, ensure that Site is selected.
   b. For the first three profile options, select Yes from the Profile Value drop-down list.
   c. To change the value for the last two profile options, specify a value in the Profile Value field as explained in the table.

7. Click Save.

Validate Authentication with the AI Application

Now you must validate the authentication between Fusion Service and the AI application. This step ensures that all the previous steps are completed correctly.

Use the Inbound Email Configuration and Validation page in Fusion Service to complete the validation.

1. Open the Tasks panel tab and click Search.
2. Search for and click the Manage Email Configuration, Registration, and Validation task.
3. On the Inbound Email Configuration and Validation page, navigate to the Email Attribute Detection area.
4. In the Test Authentication area, click Validate.

This step validates whether you're able to generate the token. If the validation is successful, a tick mark indicates that the authentication service is working fine, and all settings are done correctly in Fusion Service.

Filter the Data for the Machine Learning Model

Duplicate and inactive requests negatively impact the quality of predictions.

If you want to clean up the data before it's fed to the Machine Learning API, create exclusion rules for data ingestion. These rules help to filter out the duplicate or inactive data, so they're excluded from being ingested by the ML model.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Help Desk
   - Functional Area: Email Communication Channels
   - Task: Manage Email Configuration, Registration, and Validation

2. In the Inbound Email Configuration and Validation page, navigate to the SR Classification area.
3. In the Ingestion Exclusion Rule area, click Add.
4. In the Object field, select one of the following: Service Request, Internal Service Request, or HR Help Desk Request.
5. In the Attribute field, select the object attribute based on which you want to filter the data.
6. In the Operator field, select a suitable operator such as Contains, Equals, or Is Not Null, depending on the rule you're creating.
7. In the Value field, specify the value for the exclusion rule.

Here are some examples:
   - Requests created by messages from WhatsApp: Here, you could select the attribute as Channel Type, operator as Equals or Contains, and the value as WhatsApp.
   - Requests created by a user whose email pattern contains test: These requests aren't to be considered for training the ML model, because this would be test data.

8. Click Save.

Start the Data Ingestion and Model Training

Now, you can build a prediction model based on data pulled from closed and resolved requests created from inbound emails.
Before you start
Data from the last 6 months is used for the model training so the latest data is always included. You have the option to retrain the model on the latest data every 2 weeks. Every time the model is retrained, older data is discarded and new data is added.

Here's what to do
1. Sign in to Fusion Service with either the CRM SVC Attribute Detection Administrator or Adaptive Intelligence Applications Administrator role.
2. Click the Tools menu.
3. In the Quick Actions pane, click AI Apps Administration.
4. From the list of AI applications on the Application Administration page, click Service Request Classification.
   The Configure SR Classification page is displayed, and the Configuration tab is selected by default.
5. In the Credentials to connect to Fusion Service area, specify the following details:
   a. In the User Name field, enter the user name for your Fusion Service environment.
   b. In the Password field, enter the password for your Fusion Service environment.
   c. In the Endpoint field, enter the Oracle Fusion Service BIP Host name.
   d. Click Save.
   Note: After the credentials are saved, you see a Credentials Saved message, and the Activate button in the Activate Tenant area is enabled. This indicates that the AI application can ingest the data from Fusion Service.
   e. To ignore the changes, click Cancel.
6. In the Activate Tenant area, do the following:
   a. Click the Model Retraining (Biweekly) check box if you want the model to be retrained on the latest data every 2 weeks.
   b. Click Activate to schedule the data ingestion and model training.

Results:
The data ingestion and model training begins and the process runs in the background.

Validate the Setup
Validate the settings to see whether your model is working and that you're able to make a call to the prediction service.

1. Open the Tasks panel tab and click Search.
2. Search for and click the following task: Manage Email Configuration, Registration, and Validation.
3. On the Inbound Email Configuration and Validation page, navigate to the SR Classification area.
4. Navigate to the Test SR Classification API area.
   Here, you simulate an inbound email.
5. Enter a subject in the Subject field.
6. In the Plain Text Body field, enter the text for the body of the email.
7. From the Stripe Code drop-down list, select the relevant stripe code.
8. From the Business Unit drop-down list, select the relevant business unit.
9. Click Validate.
10. If the validation is successful, a tick mark is displayed. This tick mark indicates that the process is working successfully. And it indicates that you’re able to make a call to the SR Classification API that’s deployed on the Adaptive Intelligence Apps platform. The Attribute Predictions area displays the attribute name, value, and accuracy for the prediction.

**Note:** If the data set of SRs in the Fusion Service database isn’t very good, the accuracy and confidence of the prediction is low.

Test the Request Classifications

Test the Classification for New Requests

After completing the validations, you can conduct a test to see whether the category, and product are being stamped on the newly created help desk requests.

**Before you start**

**Note:** If the values of the profile options for prediction threshold are high, then it’s possible that the category and product aren’t stamped on the request. Therefore, it’s a good idea to lower the threshold values using the profile options before sending the test email.

**Here’s what to do**

1. Send a test email to the appropriate email channel that’s synced with the predicted business unit.
2. Open the request and view the details in the Summary tab.
3. Verify whether the prediction attributes are present on the request.
4. After you complete testing, you can reset the values of the profile options for prediction threshold per your requirements.

Use Insights Dashboard to Evaluate Accuracy

**About the Insights Dashboard**

The insights Dashboard helps you understand prediction accuracy and coverage trends.

The Insights Dashboard provides analytical reporting to view the trend of accuracy and coverage metrics. You don’t need to do anything to enable insights.

The Insights Dashboard provides the following categories of insights:

- **Activity and Coverage Insights.** Measured by the count of requests that are labeled, not labeled, correctly labeled, or incorrectly labeled. These insights trend
over time to give you a grasp of their variation across days, months, or years.
• **Accuracy Insights.** Measured by accuracy percentage. This is the count of correctly labeled requests expressed as a percentage of total count of requests labeled by AI. These
insights trend over time to give you a grasp of their variation across days, months, or years.

**Oracle Fusion Cloud Applications**

**Implementing Help Desk**

**Chapter 11**

**Adaptive Intelligence**

---

**Accuracy and Coverage**

<table>
<thead>
<tr>
<th>Category</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correctly Labeled</td>
<td>74</td>
</tr>
<tr>
<td>Incorrectly Labeled</td>
<td>27</td>
</tr>
</tbody>
</table>

**Coverage**

![Coverage Chart](chart.png)

- **Coverage Percentage**
- **Dates:** 2022-08-20 to 2022-08-21
• **Business Impact Insights.** Measured by the average time to resolve requests.

![Service Adaptive Intelligence - SR Classification](image)

**Accuracy and Coverage**

<table>
<thead>
<tr>
<th>Category</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correctly Labeled</td>
<td>74</td>
</tr>
<tr>
<td>Incorrectly Labeled</td>
<td>27</td>
</tr>
</tbody>
</table>

**SR Count**

- 2022-08-20:
  - Correctly Labeled: 5
  - Incorrectly Labeled: 2

- 2022-08-21:
  - Correctly Labeled: 10
  - Incorrectly Labeled: 5
You can generate a graph by selecting the required filters.

Here are some key points about the graph:

- For each of the insights, the x-axis of the graph shows the timeline.
- The graph shows two different views of the data:
  - In terms of actual volume of requests
  - In percentages, which are a proportional view
- The overall number of closed requests is divided into different categories, and each of them is shown separately in the first line.
- The graph shows the following details:
  - **Correctly Labeled**: Requests that were correctly labelled by the prediction service.
  - **Incorrectly Labeled**: Requests that were relabeled by agents because the prediction service yielded an incorrect label.
  - **Unlabeled**: Requests that remained unlabeled by the prediction service because the confidence was too low.
  - **Manually Labeled/Relabeled**: These requests are a combination of:
    - **Manually Labeled**: Requests with no initial label, or unlabeled requests
    - **Relabeled**: Incorrectly labeled requests
  - **Avg Time to Resolve**: The average time taken to resolve requests that were classified using the prediction service.

**Note:** For the Activity and Coverage insight:

- The y-axis of the graph shows the request count and cumulative percentage.
- The line graph for the correctly labeled requests is also displayed. This graph denotes the percentage of correctly labeled requests averaged over the whole time period.

### Use the Insights Dashboard

This procedure covers using the insights dashboard.

1. Sign in to Fusion Service as a user with the following roles: CRM SVC Attribute Detection Administrator and Adaptive Intelligence Applications Administrator.
2. Click the **Tools** menu.
3. In the **Quick Actions** pane, click **AI Apps Administration**.
4. From the list of AI applications on the Application Administration page, click **Service Request Classification**.
5. On the Configure SR Classification page, click the **Insights** tab.
6. On the Accuracy and Coverage page, click the **Category** or **Product** tab, depending on which report you want to view.
7. Select one of the following options from the **Insights** drop-down list:
   - **SR Count**: Shows the count of SRs that are correctly labeled, incorrectly labeled, unlabeled, and manually labeled or relabeled.
   - **Accuracy**: Shows the accuracy percentage. This is the percentage of correctly labeled SRs out of the total number of SRs that were labeled by AI.
   - **Coverage**: Shows the coverage percentage. This is the percentage of correctly and incorrectly labeled SRs out of the total number of SRs that were labeled by AI.
8. Do one of the following:
   - Set **Exact Match** to **On** if you want the label to be counted as correct when there's an exact match between actual and predicted values for product or category.
   - Set **Exact Match** to **Off** if you want the label to be counted as correct when there’s a match within the same hierarchy.

9. In the **Display by** drop-down list, select one of the following options:
   - **By Day**
   - **By Month**
   - **By Year**

10. In the first date picker, select the start date for the report.
11. In the second date picker, select the end date for the report.
12 Enable Productivity Tools

Enable Productivity Tools

Productivity tools show as features on help desk request create or edit pages.

The following table lists productivity tools that are available for help desk requests.

<table>
<thead>
<tr>
<th>Productivity tool</th>
<th>Description</th>
<th>Profile Option Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>SmartText</td>
<td>A reusable fragment of text that you can insert in messages and fields</td>
<td>SVC_ENABLE_STD_TEXT_IN_SR</td>
</tr>
</tbody>
</table>

Productivity tools are disabled by default. Here's how you enable them:

1. Navigate to Setup and Maintenance.
2. Click the Tasks icon.
3. Click the Search link.
4. Enter Manage Administrator Profile Values in the Search field.
5. Click Search.
6. Click the Manage Administrator Profile Values link.
7. Enter the profile option code you want to set.
8. Click Search.
9. In the Profile Values section, for the profile option code, select Yes in the Profile Value drop-down list.
10. Click Save and Close.
11. Click Done.

Now, you can set up and configure each tool according to your requirements.

Update the Status List Order

The status list on the Summary Details page shows a list of statuses that can be assigned to a help desk request. The order of statuses displayed in the list depends on their assigned ranking. Here's how you update the status ranking:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Help Desk
   - Functional Area: Help Desk Request
   - Task: Manage Service Request Status Values for Internal Help Desk Requests or Manage Status Values for HR Help Desk Requests
2. Update the Ranking column to position the status in the status list according to your requirements.
3. Click Save and Close.
How You Manage SmartText Entries

A SmartText entry is a reusable fragment of text that you or your users can create and use in help desk request messages.

As an administrator, you can create public SmartText entries that all users can use. Users can’t edit these entries.

You can create SmartTexts in multiple languages. You can use rich-text to create SmartText entries in help desk message fields by enabling HTML. Other request fields, such as Problem Description and Solution Description only support plain text.

You can define where to save the SmartText entry, insert variables in the entry, and choose to share the SmartText entry by using the following availability options:

- **Always**: Select this option to make the SmartText entry available to users at all times.
- **Interval**: Select this option and define the period during which this entry is available to users.
- **Disabled**: Select this option to disable the SmartText entry and display it in the public folders for the users.

Required Privileges

The following table shows the different privileges you grant to allow your users SmartText access.

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use SmartText</td>
<td>SVC_USE_STD_TXT_PRIV</td>
<td>Allows a user to view, search and insert SmartText.</td>
</tr>
<tr>
<td>Manage SmartText</td>
<td>SVC_MANAGE_STD_TXT_PRIV</td>
<td>Allows a user to create, update, and delete SmartText for their own use.</td>
</tr>
<tr>
<td>Publish SmartText</td>
<td>SVC_PUBLISH_STD_TXT_PRIV</td>
<td>Allows a user to set the scope of SmartText to GLOBAL which allows any user with the correct privilege to view and use that entry.</td>
</tr>
<tr>
<td>Administer SmartText</td>
<td>SVC_ADMIN_STD_TXT_PRIV</td>
<td>Allows the user to administer SmartText.</td>
</tr>
</tbody>
</table>
SmartText Naming Conventions

The following restrictions on special characters are applicable when you create a Public or Private SmartText:

- You can't include the following Trigger keys such as # and @ in the name, as these may cause interaction problems.
- The following special characters aren't allowed:
  - Tilde
  - Number sign
  - Percent
  - Ampersand
  - Asterisk
  - Flower Bracket
  - Backslash
  - Colon
  - Angle Bracket
  - Slash
  - Plus sign
  - Question mark
  - Pipe
  - Quotation mark
  - Double Square Bracket
- You can't use the following special characters:
  - Exclamation mark
  - Pound
  - Dollar
  - Round Bracket
  - Euro
  - Caret
  - Underscore
  - Equal to
  - Semi-colon
  - Comma
  - Dot
13 Configure Notifications

Set Notification Triggers and Preferences

Enable Notifications

A notification is an alert for users such as agents and employees, to notify them about an event on the help desk request, and enable them to take the necessary actions.

Enabling notifications is a global setup and feature opt-in step. Here’s how you enable the notifications feature for help desk requests:

1. Sign in to the application as a setup or administrator user.
2. Navigate to Setup and Maintenance.
3. Select the Help Desk offering.
4. In the Functional Areas section, select Change Feature Opt In.
5. Select the Enable check box for in the Productivity Tools row.
   
   When the Notifications feature is enabled, bell notifications are automatically enabled for help desk requests.
6. Click the Edit icon in the Features column of the Productivity Tools row.
7. Enable your required notification delivery channels:
   - To enable email notifications, select the Enable check box for Use Email as a Notification Delivery Channel.
8. Click Done on the Edit Features Productivity Tools page.
9. Click Done.

Related Topics

- Create and Manage Email Templates
- Overview of Creating Object Workflows

How You Set Up Groovy Notification Triggers

As an administrator, here’s how you configure notifications after you have enabled the notifications feature:

1. Define notification triggers as Groovy scripts in Application Composer, containing the conditions that must be met for each notification. Notifications are triggered when the defined conditions are met. For example, a trigger can be defined to send a notification when a high severity help desk request has been assigned to an agent.
   
   For more information about defining notification triggers, see the “Define Notification Triggers” section.
2. Configure the notification preferences using the Notification Preferences page. For example, to specify the notification message using SmartText, and the notification recipient.
For more information about notification preferences, see the "Set Notification Preferences" section.

**Note:**
- You can temporarily disable all notifications using the profile option SVC_DISABLE_BO_NOTIFICATIONS. Oracle recommends to use this option when you're doing a bulk import of data, so that you don't get multiple notifications.
- You can temporarily enable or disable specific notifications from the Notification Preferences page.

**Define Notification Triggers**

Here's how you define a Groovy script for a notification trigger:

1. Sign in to the application as a setup or administrator user.
2. Click Navigator > Configuration > Sandboxes.
3. Create a sandbox or select an existing one, and click Enter Sandbox to activate the sandbox. Your sandbox is activated, and you can see its name on the sandbox bar over the global header.
4. In the Navigator, click Application Composer. The Application Composer page is displayed.
5. Select Objects > Standard Objects > Internal Service Request or HR Help Desk Request > Server Scripts. The Server Scripts section is displayed.
6. Click the Triggers tab.
7. From the Action menu, click Add. The Create Object Trigger section is displayed.
8. Create a Groovy trigger:
   - Specify the Name, Error Message, and Trigger Definition details.
     - Oracle recommends you to use the trigger type **After Changes Posted to Database**. This trigger type enables you to stop potential issues if the Groovy script is accidentally written to run indefinitely. If the trigger type is set to **Before Update to Database**, with a bad script, there may be some issues.
     - If you're creating a new object, and you want to trigger a notification when the object is created, Oracle recommends you to use the trigger type **Before Insert to Database**. However, some of the Before trigger types don't have all attributes exposed yet, resulting in some fields being blank. To debug your triggers if you're not getting the expected results, follow the steps in the section "Debug Groovy Triggers".
     - The isAttributeChanged() function works only for the Before trigger types. The workaround for the After trigger types involves retrieving the old value before the database is updated, then retrieving the new value after the update, and then comparing the two values to see whether the attribute is changed. However, this workaround works only for high-level attributes such as criticalFlag and status. This workaround may not work for the ViewRow attribute, for example, when you're retrieving the team from a help desk request.

When you create a Groovy script, you need the API names of the fields you're trying to access. To create your triggers based on parent/child fields, do the following:
   i. In the Trigger Definition section, click Show/Hide Expression Palette.
   ii. Click the Fields tab.
   iii. Select an Object.
   iv. Click the Maximize Edit Script arrow. The fields for the selected object are displayed.
v. Select the API you want, and click Insert.
vi. To close the expression palette, click the Restore Edit Script arrow, and then click Show/Hide Expression Palette.
b. Click Save and Close.

9. Navigate to the Notification Preferences page to configure your preferences for the notifications.

For more information about configuring notification preferences, see the "Set Notification Preferences" topic.

**Note:** You can reuse a Groovy notification trigger if no other notification uses it.

Related Topics

- Overview of Sandboxes
- Create and Activate Sandboxes
- Publish Sandboxes

## Set Notification Preferences

The Notification Preferences page enables administrators to configure the notification rules. Users who have the ORA_SVC_INTERNAL_HELPDESK_ADMINISTRATION or ORA_SVC_HR_SR_ADMINISTRATION duty roles can access this page.

Here’s how you configure the notification rules:

**Note:** Ensure that your triggers are published.

1. Sign in to the application as an administrator.
2. In the Navigator, click Tools > Notification Preferences.
   The Notification Preferences page is displayed.
3. From the Object drop-down list, select Internal Help Desk Request or HR Help Desk Request.
   **Note:** Other supported objects are also displayed in the Object drop-down list.
   a. Click Add. A blank row is added in the table.
   b. To enable the notification trigger, select Yes from the Enabled drop-down list.
   c. To prevent users from personalizing this notification through the User Notification Preferences page, select No from the OverrideFlag drop-down list.
      **Note:** To clean up the user notification preferences data, in case the resource leaves your company or is no longer active, run the Purge Obsolete User Preferences scheduled process. This scheduled process lets your organization ensure that your data on user notification preferences isn’t stale.
   d. Select a Groovy notification trigger from the Triggering Event drop-down list.
   e. Enter the Notification Name and Description.
   f. In the Recipients column, click Edit.
      The Configuration for Trigger Name dialog box is displayed.
   g. Select the notification delivery options for the respective recipients.
For an enabled triggering event, notifications are sent to the specified recipients only if you select at least one delivery option. If any delivery method is selected for a specific recipient, that recipient will also receive bell notifications. Additionally, if you do not select the **Bell Notifications** option, then no notifications will be sent to the specified recipients.

The following tables describe the recipients and delivery options for the help desk request object:

<table>
<thead>
<tr>
<th>Recipients for Service Request Object</th>
<th>Delivery Options for Service Request Object</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Assigned To:</strong> Resource to whom the help desk request is assigned.</td>
<td><strong>Bell Notifications:</strong> Sends a bell notification to the web application.</td>
</tr>
<tr>
<td><strong>Manager of Assigned To:</strong> Manager of the resource to whom the help desk request is assigned.</td>
<td><strong>Email Notifications:</strong> Sends an email notification to the selected internal recipients' primary work email ID saved in the application.</td>
</tr>
<tr>
<td><strong>Resource Team:</strong> Additional resources that have been added to a help desk request on the Team subtab.</td>
<td><strong>Note:</strong> The from email address is configured through the SVC_OUTBOUND_EMAIL_FROM profile option. If that isn't specified, the default from email address <a href="mailto:noreply@oracle.com">noreply@oracle.com</a> is used.</td>
</tr>
<tr>
<td><strong>Queue Owner:</strong> Owner of the queue.</td>
<td></td>
</tr>
</tbody>
</table>

If you have a team of resources collaborating on a help desk request, and a trigger such as the help desk request escalating to Critical status happens, the entire team can be informed.

If your organization uses manual assignment, the queue owner can be notified when a new help desk request is associated with a queue owned by the queue owner. For information about the setup steps required to send a notification to a queue owner,
Implementing Help Desk

Chapter 13

Configure Notifications

<table>
<thead>
<tr>
<th>Recipients for Service Request Object</th>
<th>Delivery Options for Service Request Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>see the “Trigger a Notification to the Queue Owner” section.</td>
<td></td>
</tr>
</tbody>
</table>

To let users follow a specific help desk request and receive all notifications for that help desk request, select the **Enable Followers** check box.

When enabled, users with the correct permissions will see the **Follow** option in the **Actions** menu of the Help Desk Request Details page.

The notification followers receive notifications for all supported channels, when any notification event is triggered for the help desk requests they follow.

To enable this feature for the site, set the ORA_ENABLE_FOLLOW_NOTIFICATIONS profile option to **Yes**.

To follow a help desk request, users must have the SVC_GET_SR_FOLLOW_NOTIFICATIONS permission.

This privilege is added to the following ready-to-use duty roles:

- Internal Service Request Administration
- Internal Service Request Analysis
- Internal Service Request Management
- HR Service Request Administration
- HR Service Request Analysis
- HR Service Request Management

**Note:** To evaluate whether a resource is still valid and enabled to follow specific help desk requests, run the **Purge Obsolete Notification Followers** scheduled process. This scheduled process removes inactive and end-dated users from following the help desk request, so that the application doesn't get overloaded with stale data. This scheduled process lets your organization ensure that your data on notification followers isn't stale.

**i.** Click the **New SmartText** link and enter the **Notification Text** for the selected object.

For more information about using SmartText, see the "Using SmartText" topic.

4. (Optional) To delete a notification preference, select the row and click **Delete**. The associated notification text is also deleted.

    **Note:** If you delete a notification that uses a Groovy notification trigger, you can create a new notification using the same trigger, if no other notification uses it.

5. (Optional) To modify an existing notification text, click the **Update SmartText** icon for the selected row.

6. Click **Save**.

**Debug Groovy Triggers**

Within your Groovy scripts, all your println statements go to the runtime messages. Here's how you view the runtime log and debug your Groovy script:

1. Within a sandbox, navigate to **Application Composer**.
2. Select **Common Setup > Run Time Messages**. The Run Time Messages section is displayed.
3. Select the **Enable Application Script Logging** check box.
4. Trigger your notifications.
   If the Groovy script has appropriate `println` statements, you receive runtime messages when you navigate back to the **Run Time Messages** section in Application Composer.

**Related Topics**
- Overview of Sandboxes
- Create and Activate Sandboxes
- Publish Sandboxes

### Sample Groovy Scripts for Notifications

#### Help Desk Request Assigned

Here's a sample code to trigger a notification to be sent to the recipient specified in the Notification Preferences page when the help desk request is assigned:

```groovy
/* DISCLAIMER: This trigger is provided only as a reference.
* TRIGGER TYPE: Before Update in Database
* OBJECT: HR Help Desk Request
* Use Case: Send a notification when an existing SR is reassigned.
* Note: You can override the Notification Text and Recipients using the Notification Preferences page.
*/

if (isAttributeChanged('AssigneeResourceId')) {
    try {
        def recipientPartyId = AssigneeResourceId
        def messageText = 'An SR notification (default message).'
        if (recipientPartyId) {
            //Call to send notification
            adf.util.sendNotification(adf, messageText, recipientPartyId)
            //Log a confirmation that the notification has been sent. Logs can be viewed in 'Runtime Messages'.
            //println("Notification sent to " + recipientPartyId + " because the SR was assigned to them.")
        } else {
            println("No Assignee associated with this SR")
        }
    } catch (e) {
        //Log the failure in groovy logging. Logs can be viewed in 'Runtime Messages'.
        println("Failure to trigger notification from Groovy Script " + e.getMessage());
        // Throwing validation exception will show the message on the UI. This is not recommended for published sandboxes.
        // The following code is one of many to illustrate identifying an error in trigger from the UI.
        // Replace <triggerName> with the trigger name you specified when creating this trigger.
        // throw new oracle.jbo.ValidationException('Failure to trigger <triggerName> Notification from Groovy Script: ' + e.getMessage())
    }
}
```

**Note:** This sample script uses the object HR Help Desk Request. Change the object to **Internal Service Request** if you're using this script for Internal Service Requests.
Help Desk Request Resolved

Here's a sample code to trigger a notification to be sent to the recipient specified in the Notification Preferences page when the Help Desk request is resolved:

```
/* DISCLAIMER: This trigger is provided only as a reference.
* TRIGGER TYPE: Before Update in Database
* OBJECT: HR Help Desk Request
* Use Case: Send a notification to the primary contact when an SR has been resolved.
* Note: You can override the Notification Text and Recipients using the Notification Preferences page.

if (isAttributeChanged('StatusCd') && StatusCd == 'ORA_SVC_HRHD_RESOLVED') {
    try {
        def recipientPartyId = PrimaryContactPartyId
        def messageText = 'An SR notification (default message).'

        if (recipientPartyId) {
            //Call to send notification
            adf.util.sendNotification(adf, messageText, recipientPartyId)
            //Log a confirmation that the notification has been sent. Logs can be viewed in 'Runtime Messages'.
            //println("Notification sent to " + recipientPartyId + " because the SR was resolved.")
        } else {
            println("No Assignee associated with this SR")
        }
    } catch (e) {
        //Log the failure in groovy logging. Logs can be viewed in 'Runtime Messages'.
        println("Failure to trigger notification from Groovy Script " + e.getMessage());
        // Throwing validation exception will show the message on the UI. This is not recommended for published sandboxes.
        // The following code is one of many to illustrate identifying an error in trigger from the UI.
        // Replace <triggerName> with the trigger name you specified when creating this trigger.
        // throw new oracle.jbo.ValidationException('Failure to trigger <triggerName> Notification from Groovy Script: ' + e.getMessage())
    }
}
```

Help Desk Request Escalated

Here's a sample code to trigger a notification to be sent to the recipient specified in the Notification Preferences page when the Help Desk Request is escalated:

```
/* DISCLAIMER: This trigger is provided only as a reference.
* TRIGGER TYPE: Before Update in Database
* OBJECT: HR Help Desk Request
* Use Case: Send a notification to the primary contact when an SR has been escalated.
* Note: You can override the Notification Text and Recipients using the Notification Preferences page.

if (isAttributeChanged('StatusCd') && StatusCd == 'ORA_SVC_HRHD_ESCALATED') {
    try {
        def recipientPartyId = PrimaryContactPartyId
        def messageText = 'An SR notification (default message).'

        if (recipientPartyId) {
            //Call to send notification
            adf.util.sendNotification(adf, messageText, recipientPartyId)
            //Log a confirmation that the notification has been sent. Logs can be viewed in 'Runtime Messages'.
            //println("Notification sent to " + recipientPartyId + " because the SR was escalated.")
        } else {
            println("No Assignee associated with this SR")
        }
    } catch (e) {
        //Log the failure in groovy logging. Logs can be viewed in 'Runtime Messages'.
        println("Failure to trigger notification from Groovy Script " + e.getMessage());
        // Throwing validation exception will show the message on the UI. This is not recommended for published sandboxes.
        // The following code is one of many to illustrate identifying an error in trigger from the UI.
        // Replace <triggerName> with the trigger name you specified when creating this trigger.
        // throw new oracle.jbo.ValidationException('Failure to trigger <triggerName> Notification from Groovy Script: ' + e.getMessage())
    }
}
```
* TRIGGER TYPE: Before Update in Database
* OBJECT: HR Help Desk Request
* Use Case: Send a notification when an SR is escalated.
* Note: You can override the Notification Text and Recipients using the Notification Preferences page.
*/

if (isAttributeChanged('CriticalFlag') && CriticalFlag=='Y') {
  try {
    def recipientPartyId = AssigneeResourceId
    def messageText = 'An SR notification (default message).''

    if (recipientPartyId) {
      //Call to send notification
      adf.util.sendNotification(adf, messageText, recipientPartyId)

      //Log a confirmation that the notification has been sent. Logs can be viewed in 'Runtime Messages'.
      //println("Notification sent to " + recipientPartyId + " because the SR was escalated.")
    } else {
      println("No Assignee associated with this SR")
    }
  } catch (e) {
    println("Failure to trigger notification from Groovy Script: " + e.getMessage())
  }
}

// Throwing validation exception will show the message on the UI. This is not recommended for published sandboxes.
// The following code is one of many to illustrate identifying an error in trigger from the UI.
// Replace <triggerName> with the trigger name you specified when creating this trigger.
// throw new oracle.jbo.ValidationException('Failure to trigger <triggerName> Notification from Groovy Script: ' + e.getMessage())
14 Adaptive Search

Using Adaptive Search for Help Desk

Adaptive Search is a high-performance search engine that provides keyword searching and enhanced filtering capabilities. Adaptive search is used on the Help Desk Request List pages. To enable Adaptive Search for Help Desk, complete the following procedure:

1. In the Setup and Maintenance work area, open the Configure Adaptive Search task:
   - Offering: Sales
   - Functional Area: Sales Foundation
   - Task: Configure Adaptive Search
2. On the Configure Adaptive Search page, click the Setup tab.
3. On the Setup tab, Quick subtab, select the objects you want to enable for Adaptive Search:
   - HR Help Desk Request
   - Internal Service Request
   - Help Desk Contact
4. Click Publish.
   Your action runs an indexing process and an hourly index refresh for the objects you selected. You can monitor the progress of the indexing process on the Monitor tab. The process can take several minutes to complete, depending on your data volume.
5. Click the Monitor tab and Publish subtab to monitor the process. If the process completes with errors, contact your help desk.

Related Topics
- Adaptive Search and Workspace chapter of the Oracle Fusion Cloud Sales Automation Implementing Sales guide.
15 Collaborate with Slack

How You Collaborate with Slack

Using Slack, your help desk agents can securely collaborate with subject matter experts to quickly resolve employee questions and issues.

You can integrate your help desk application with Slack using two different methods. These methods are described in detail in the Slack Channels chapter of the Oracle Fusion Service Implementing Service guide.

**Note:** The Send Additional SR Fields to Slack section isn’t applicable for Help Desk. So you can ignore the following topic in that section: Send Additional Fields When an SR Is Forwarded to Slack.

**Related Topics**
- Overview of Setting Up a Slack Channel for your Fusion Application
- How You Set Up a Slack Channel for Your Fusion Application: Method 2

Create a Collaboration Action for Slack

Using the Administration UI, you can set up or create different collaboration actions.

Let’s see how to set up a collaboration action to start an internal conversation in a help desk request with a user in Slack. You can also define which attributes of the business object can be shared with Slack as part of the internal conversation.

**Note:** This example is for starting an internal conversation in help desk request. You can also use any other suitable action names different from those given in the examples. For this example:

- A child action would be to create a **Reply to Help Desk Request** button. It's a child of the first message received in Slack from Help Desk.
- Further, a child of the **Reply to Help Desk Request** child action would be to create a **Submit Reply** action. When a Slack user enters a message and clicks **Submit Reply**, the message goes to Help Desk.

These two child actions have been described in the two subsequent topics.

To set up a collaboration action using the Administration UI:

1. Sign in as an administrator.
2. Navigate to the Setup and Maintenance work area and open the Tasks panel tab.
3. Search for and click the Manage Collaboration Actions task.
   The All Collaboration Actions page opens in a new tab.
4. Click **Create Collaboration Action**.
5. In the Action Details region, specify the following details:
   a. **Action Name**: Specify a name. For example: Start Internal Conversation in SR.
b. The **Action** field is automatically populated.

c. **Description:** Add a suitable description.

d. **Action Code:** Specify an action code of your choice. For example: `start-collab-on-SR`.

e. **Business Object:** Select the business object on which you’re creating the collaboration action. For example, Help Desk Request, Opportunity, Lead, and so on.

f. **Action Type:** From this drop-down list, select **Start a Collaboration Conversation**.

**Note:** For this Start a Collaboration Conversation action, the following fields aren’t required: **Action Method**, **Display Sequence**, and **User Interface Component**.

6. Click **Next**.

7. In the Request Details region, specify the following details:

   a. **Request Content Type:** This field is automatically populated.

   b. **Request End Point:** Enter the following end point: `/crmRestApi/resources/latest/hrHelpDeskRequests?q=SrId=[[SrId]]`, or `/crmRestApi/resources/latest/internalServiceRequests?q=SrId=[[SrId]]`.

       The `/crmRestApi/resources/latest/hrHelpDeskRequests` or `/crmRestApi/resources/latest/internalServiceRequests` part is automatically populated in the field. To facilitate querying the Help Desk object using the primary key field, you’re appending the following at the end: `?q*Srid*[[SrId]]`

   c. **Request Payload:** You can skip this field.

8. Click **Next**.

9. In the Response Details region, specify the following details:

   a. **Response Visibility:** From this drop-down list, select **Public**.

   b. **Response Type:** From this drop-down list, select **Action Attributes**.

   c. **Response Content Type:** This field is automatically populated.

   d. **Response Payload:** You can skip this field.

10. Click **Next**.
11. In the Add Action Attribute region, you must add some help desk request attributes that you would like to share with Slack users when starting an internal conversation.

   a. Click Add Attribute.
   b. In the Add Action Attribute dialog box, enter the following details:

   **Note:** See the table at the end of this step for some specific details that you must set for some attributes.

   - **Attribute Name:** Select a name from the drop-down list.
   - **Display Name:** Specify a suitable display name.
   - **Data Type:** Select the appropriate value from the drop-down list.
   - **Default Value:** Specify a default value.
   - **User Interface Component:** This field can have the following values: List, Text Area, or Text Box. The default value is Text Box.
   - **Display Sequence:** Specify a high or low number depending on where you want the UI component to be displayed. For example: You can specify a higher number such as 12 if you want it to be displayed lower down on the page.
   - **Business Object Identifier:** If it's a field that's used for identifying a record, then you must select this switch.

   **Note:** Let's say a to and fro message thread about a particular request exists between Slack and Help Desk. Then the linking of the messages is done through this field. You can select help desk request ID or help desk request number as the Business Object Identifier, because they both uniquely identify as a help desk request.

   - **Included in Request:** If information is being sent from Slack to Help Desk, then select this switch.
   - **Included in Response:** If you're sending a response message from Help Desk to Slack, then select this switch.
   - **End Point:** This field is applicable only if you select the User Interface Component as List.
   - **Option Label:** This field is applicable only if you select the User Interface Component as List.
   - **Option Value:** This field is applicable only if you select the User Interface Component as List.
   - **Deep Link:** If required, provide a deep link that uniquely identifies the help desk request. For example: Link to help desk request number that shows up in the Slack UI: `crmUI/helpdesk/vp/edit-hrhd?srNumber=[[SrNumber]]` or `crmUI/helpdesk/vp/edit-isr?srNumber=[[SrNumber]]`. If you want one of the other attributes to be a link, you can add the deep link to the help desk request by editing that attribute. For example, you can add the deep link to the help desk request for the title attribute.

Here's a list of some specific details that you must set for the following common action attributes:

<table>
<thead>
<tr>
<th>Action Attribute</th>
<th>Required Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>SrId</td>
<td>Select the Business Object Identifier switch.</td>
</tr>
<tr>
<td>SrNumber</td>
<td>Select the Include in Response switch.</td>
</tr>
</tbody>
</table>
### Collaborate with Slack

**Action Attribute** | **Required Details**  
--- | ---  
SrNumber | Provide the following deep link in the Deep Link field: `crmUI/helpdesk/vp/edit-hrhd?srNumber=[[SrNumber]]` or `crmUI/helpdesk/vp/edit-isr?srNumber=[[SrNumber]]`  
Title | Select the Included in Response switch.  
Problem Description | Select the Included in Response switch.  

12. **Click Save.**

#### Create a Child Action for a Collaboration Action for Slack

A child action is an action within the main collaboration action.

For example: For the Collaboration on Help Desk Request action, you would create a **Reply to Help Desk Request** button as the child. The **Reply to Help Desk Request** button is a child of the first message received in Slack from Help Desk about needing help with a request. Along with the message, some basic information about the request is shared.

**Note:** You can use any other suitable action name instead of **Reply to Help Desk Request**. Whatever action name you use is displayed in the Slack UI.

To create a child action for a collaboration action:

1. Sign in as an administrator.
2. Navigate to the **Setup and Maintenance** work area and select the Service offering.
3. Open the **Tasks** panel tab.
4. Search for and click the **Manage Collaboration Actions** task.
   
The All Collaboration Actions page opens in a new tab.
5. From the displayed list of existing collaboration actions, click the collaboration action for which you want to create a child action.
   
The collaboration action opens, and its name is displayed in the navigation pane.
6. Click the plus symbol next to the name of the collaboration action.
7. Specify all the details for the child action as explained in Create a Collaboration Action. Considering the example of the **Reply to Help Desk Request** button, you would specify the following details:

   a. **Action Details region:**
      
      - **Action Name:** Reply to Help Desk Request
      - **Action Code:** Specify a value of your choice. For example: reply-to-hdr
      - **Business Object:** Select **Conversation Message** from the drop-down list.
That’s because we’re creating a conversation message under the request.

- **Action Type**: Select **Open a Dialog** from the drop-down list.

**b. Request Details region:**
The Request End Point is populated automatically, so you don’t have to change anything here.

**c. Response Details region:**
You can leave this page blank. That’s because clicking the **Reply to Help Desk Request** button would show a message text box in Slack. And you’re not sending a response message from Help Desk to Slack.

**d. Add Action Attribute region:**
Here, you would add only one attribute, which is **Message Content**.
- **Attribute Name**: Select **MessageContent** from the drop-down list.
- **Data Type**: Select **String** from the drop-down list.
- **User Interface Component**: Select **Text Area** from the drop-down list.
  - Select the **Included in Request** switch.

8. Click **Save**.

**Note**: Instead of clicking the **Reply to Help Desk Request** button, the subject matter expert (SME) can also reply by clicking the native **Reply** action. The SME must mention the app in the format @AppName in the native Reply. Here, **AppName** is the name of your company’s Slack app created for Oracle Help Desk. When the SME mentions your app in this format, your app adds their reply as a message on the request.

---

**Create a Second-Level Child Action for a Collaboration Action for Slack**

The child of the Reply to Help Desk Request action in Slack would be the Submit Reply action. When a Slack user enters a message and clicks Submit Reply, the message goes to Help Desk.

**Note**: You can use any other suitable action name instead of **Submit Reply**. Whatever action name you use is displayed in the Slack interface.

To create the **Submit Reply** child action to the **Reply to Help Desk Request** action:

1. Specify all the details for the child action as explained in Create a Collaboration Action. Considering the example of the **Reply to Help Desk Request** button in the previous topic, you would specify the following details:
   - **Action Name**: Submit Reply
   - **Action Code**: You can type any value of your choice here.
   - **Business Object**: Select **Conversation Message** from the drop-down list.
   - **Action Type**: Select **Call an API** from the drop-down list because it’s calling a Help Desk API.
   - **Action Method**: Select **Post** from the drop-down list because you’re creating a new message.
- **Display Sequence**: Select 1.

**b. Request Details region:**

- **Request Content Type**: This field is populated automatically.
- **Request End Point**: This field is populated automatically.
- **Request Payload**: Add the following payload in this field:

```json
{"MessageContent": "[[MessageContent]]","MessageTypeCd": "ORA_SVC_INBOUND","ParentMessageId": [[ConversationMessageId]],"SenderAlternateId": [[$system.CollabResourceId]],"SenderFreeFormAddress": "[[System.ExternalResourceDisplayName]]","MessageAlternateId": "[[System.ExternalMessageId]]","recipients": [[System.ConversationMessageRecipients]]}
```

**c. Response Details region:**

- **Response Visibility**: Select Public from the drop-down list.
- **Response Payload**: Set the value to: `{"text": "[[MessageContent]]"}`

This message content is also echoed to all the other SMEs in Slack, so they all can view the reply given by the first SME. And they can add on to it if required.
- **Response Type**: Select **User-Defined JSON Formatted Result** from the drop-down list.
- **Response Content Type**: This field is populated automatically.

**d. Add Action Attribute region:**

This page has only one attribute, which is **Message Content** because that's the only attribute for Submit Reply.

- Ensure that you select the **Included in Request** switch.

2. Click **Save**.

## Add an Event to Capture Messages Mentioning Your Slack App

Let's say an agent needs help with resolving a help desk request, and they post a question on Slack. A subject matter expert (SME) can reply to their question by clicking either the **Reply to Help Desk Request** button or the native **Reply** action.

When the SME clicks the native **Reply**, they must mention the app in the format @AppName in the native Reply. Here,AppName is the name of your company's Slack app created for Help Desk. When the SME mentions your app in this format, their reply is captured as a message on the SR. But for this to happen, you must add an event in your Slack app to capture such replies.

To add an event that captures messages mentioning your Slack app as conversation messages in Help Desk:

1. Open your Oracle app in Slack.
2. In the **Features** section of the navigation pane, click **Event Subscriptions**.
3. On the Event Subscriptions page, in the **Enable Events** area, turn on the switch to enable events.
4. In the **Request URL** field, type the following:

   https://{URL}/crmRestApi/collaborationResources/latest/slackAppMention

   | **Note:** Remember to replace `{URL}` in this link with the base URL of your pod.

5. In the **Subscribe to bot events** area, click **Add Bot User Event**.

6. Click **app_mention**.

   The `app_mention` event name is displayed in the Subscribe to bot events area, along with the description and scope.

7. Click **Save Changes**.
Collaborate with Microsoft Teams

How You Set Up a Microsoft Teams Channel

Using Microsoft Teams, your agents can collaborate with subject matter experts to resolve employee questions and issues faster. Here’s the sequence of steps that you must complete to set up the integration of your service application with Microsoft Teams:

*Note:* Each of these steps is described in a separate topic, and you must complete them in the given order.

<table>
<thead>
<tr>
<th>Step no.</th>
<th>Name of topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a Microsoft Teams App for Help Desk</td>
</tr>
<tr>
<td>2</td>
<td>Set Up a Bot User for Your Microsoft Teams App</td>
</tr>
<tr>
<td>3</td>
<td>Register Your Microsoft Teams App in the Azure Portal</td>
</tr>
<tr>
<td>4</td>
<td>Enable Collaboration With Microsoft Teams in FSM</td>
</tr>
<tr>
<td>5</td>
<td>Update FSM with Credentials of Your Microsoft Teams App</td>
</tr>
<tr>
<td>6</td>
<td>Create a Microsoft Teams Channel in Help Desk</td>
</tr>
<tr>
<td>7</td>
<td>Enable Notifications to Microsoft Teams</td>
</tr>
<tr>
<td>8</td>
<td>Create a Collaboration Action</td>
</tr>
<tr>
<td>9</td>
<td>Create a Child Action for a Collaboration Action</td>
</tr>
<tr>
<td>10</td>
<td>Create a Child Action for the Reply to Help Desk Request Child Action</td>
</tr>
<tr>
<td>11</td>
<td>Configure the FND_IDP_PROXY_USER_WHITELIST Profile Option</td>
</tr>
<tr>
<td>12</td>
<td>Upload Your Microsoft Teams App</td>
</tr>
<tr>
<td>13</td>
<td>Install Your Microsoft Teams App and Add It to Your Team</td>
</tr>
</tbody>
</table>
Create a Microsoft Teams App

To create a Microsoft Teams app for Help Desk:

1. In Microsoft Teams, click **Apps** in the navigation pane.
2. On the Apps page, search for and add **App Studio**.
3. In the **Manifest editor** tab of **Apps Studio**, click **Create a new app**.
4. On the **App details** page, specify the details in the following sections:
   a. **App names**: Enter the short and full names for your app. The short name that you specify automatically appears in the navigation pane.
   b. **Identification**: Remember to click **Generate** below the **App ID** field to generate the app ID.
   c. **Descriptions**: Enter the short and full descriptions for your app.
   d. **Developer information**: Enter your company name and website.
   e. **Partner information**: If a partner organization is building the app for you, you must enter their Microsoft Partner Network ID. This section is optional and isn’t applicable if your company is building the app.
   f. **App URLs**: Provide the links to your policy statement and terms of use.
   g. **Branding**: Upload the two icons for your app as required, and follow the instructions to select an app accent color.
5. Go to the **Capabilities** section of the navigation pane to set up a bot user for your Microsoft Teams app.
   For more details, see **Set Up a Bot User for Your Microsoft Teams App**.
6. Go to the **Finish** section of the navigation pane and click **Test and distribute**.
7. Click **Download**.
   The Microsoft Teams app that you created for Oracle Help Desk is downloaded as a compressed file.

Set Up a Bot User for Your Microsoft Teams App

To set up a bot user for your Microsoft Teams app:

1. In Microsoft Teams, go to the **Capabilities** section of the navigation pane.
2. Click **Bots**.
3. The **Set up a bot** dialog box displays two tabs:
   o **New bot**: Click this tab to create a new bot user for your app.
     i. In the **Name** field, enter a name for your new bot.
     ii. In the **Messaging bot** and **Calling bot** regions, select the check boxes that are relevant for your company.
     iii. In the **Scope** region, select the **Personal**, **Team** check boxes.
     iv. Click **Create bot**.
   o **Existing bot**: Click this tab to configure an existing bot user for your app.
     i. In the **Bot** dialog box, in the **Bot ID** region: You can either select from an existing bot or connect to a different bot ID by specifying the ID.
ii. In the **Messaging bot** and **Calling bot** regions, select the check boxes that are relevant for your company.

iii. In the **Scope** region, select the **Personal, Team** check boxes.

iv. Click **Save**.

4. On the **Bots** page, in the **App passwords** region, click **Generate new password**.

   **Note:** You must save this generated password. This password is used later as the client secret when you configure the MS Teams credentials in .

5. In the **Messaging endpoint** region, enter the bot endpoint address. For example: `https://environment-name/crmRestApi/collaborationResources/latest/activities`

   Here, environment-name refers to the environment where you have deployed Oracle Help Desk.

### Register Your Microsoft Teams App in the Azure Portal

Ensure that have an Azure account before you register your Microsoft Teams app in the Azure portal.

To register your app in the Azure portal:

1. Go to the Azure Portal at: `portal.azure.com`
2. Navigate to the Manage Azure Active Directory region and click **View**.
3. In the navigation pane, click **App registrations**.

   In the App registrations page, you can see the new Microsoft Teams app that you created.

4. Click your app.
5. Copy the following information from the **Essentials** region:
   
   - **Application (client) ID**: You must enter this application client ID while updating FSM with the credentials of your Microsoft Teams app.
   - **Directory (tenant) ID**: You use this ID as the account name of the Microsoft Teams channel that you create in Fusion Service.

### Update Functional Setup Manager with Credentials of Your Microsoft Teams App

To update the Functional Setup Manager (FSM) in Fusion Service with the credentials of your Microsoft Teams app:

1. Sign in to as a setup user or administrator.
2. In the Setup and Maintenance work area, go to the **Tasks** panel tab.
3. Search for and click **Manage Microsoft Teams Credentials**.

   The Manage Collaboration Network Credentials page is displayed.

4. In the Collaboration Network Application Credentials region, enter the required information in the following fields:
Create a Microsoft Teams Channel

To create a Microsoft Teams channel in Oracle Help Desk:

1. Sign in as an administrator or a setup user.
2. Navigate to the Setup and Maintenance work area and open the Tasks panel tab.
3. Click Search from the list of displayed tasks.
4. Search for and select Manage Communication Channels.
5. In the Service Channels page, click Create Channel.
6. In the Create Channel window, select CRM in the Stripe Code field.
7. Select the Purpose as Collaboration.
8. Select the Channel Type as Microsoft Teams.
9. In the Account Name field, enter the directory tenant ID that you copied from the Azure portal.
   For more information, see Register Your Microsoft Teams App in the Azure Portal.
10. The Channel Code field is autogenerated.
    The channel code uniquely identifies a communication channel when exporting or importing channels from one environment to another.
    - If the autogenerated channel code is unique, you can leave it unchanged.
    - If the autogenerated channel code isn’t unique, add a set of characters to the code to make it unique.
11. Enter a Display Name for the Microsoft Teams channel.
12. Select the Business Unit from the drop-down list.
   | Note: You can see this field only if you have enabled multiple business units for your deployment.
13. Select the Active check box.
14. Click Save and Close.

Related Topics
- Register Your Microsoft Teams App in the Azure Portal

Enable Notifications to Microsoft Teams

All outbound messages from Oracle Help Desk to Microsoft Teams use the notifications framework. So, for outbound messages to be delivered to Microsoft Teams, you must enable notifications.

- Client ID: Enter the Application Client ID that you copied from the Azure portal. For more information, see Register Your Microsoft Teams App in the Azure Portal.
- Client Secret: Enter the password that you generated in the App passwords region of the Bots page. For more information, see step 3 in Set Up a Bot User for Your Microsoft Teams App.
5. Click Save and Close.
For more information about how to enable notifications, see "Enable Notifications for Service Requests".

**Related Topics**
- Enable Notifications for Service Requests

## Create a Collaboration Action

Using the Administration UI, you can set up or create different collaboration actions.

Let's see how to set up a collaboration action to start an internal conversation in an help desk request with a user in Microsoft Teams. You can also define which attributes of the business object can be shared with Microsoft Teams as part of the internal conversation.

**Note:** This example is for starting an internal conversation in an help desk request. You can also use any other suitable action names different from those given in the examples. For this example:
- A child action would be to create a **Reply to Help Desk Request** button. It's a child of the first message received in Microsoft Teams from Help Desk.
- Further, a child of the **Reply to Help Desk Request** child action would be to create a **Submit Reply** action. When a Microsoft Teams user enters a message and clicks **Submit Reply**, the message goes to Help Desk.

These two child actions have been described in the two subsequent topics.

To set up a collaboration action using the Administration UI:

1. Sign in as an administrator.
2. Navigate to the **Setup and Maintenance** work area and open the **Tasks** panel tab.
3. Search for and click the **Manage Collaboration Actions** task.
   
   The All Collaboration Actions page opens in a new tab.
4. Click **Create Collaboration Action**.
5. In the Action Details region, specify the following details:
   - **Action Name**: Specify a name. For example: Start Internal Conversation in help desk request.
   - **The Action** field is automatically populated.
   - **Description**: Add a suitable description.
   - **Action Code**: Specify an action code of your choice. For example: start-collab-on-SR.
   - **Business Object**: Select the business object on which you're creating the collaboration action.
   - **Action Type**: From this drop-down list, select **Start a Collaboration Conversation**.
   
   **Note**: For this Start a Collaboration Conversation action, the following fields aren't required: **Action Method**, **Display Sequence**, and **User Interface Component**.
6. Click **Next**.
7. In the Request Details region, specify the following details:
   - **Request Content Type**: This field is automatically populated.
   - **Request End Point**: Enter the following end point: `/crmRestApi/resources/latest/hrHelpDeskRequests?q=SrId=[[SrId]], or /crmRestApi/resources/latest/internalServiceRequests?q=SrId=[[SrId]`
The \crmRestApi\resources\latest\hrHelpDeskRequests (or internalServiceRequest) part is automatically populated in the field. To facilitate querying the Help Desk object using the primary key field, you're appending the following at the end: \?q*Srid*[[Srid]]

c. **Request Payload**: You can skip this field.

8. Click **Next**.
9. In the Response Details region, specify the following details:
   a. **Response Visibility**: From this drop-down list, select **Public**.
   b. **Response Type**: From this drop-down list, select **Action Attributes**.
   c. **Response Content Type**: This field is automatically populated.
   d. **Response Payload**: You can skip this field.

10. Click **Next**.
11. In the Add Action Attribute region, you must add some Help Desk attributes that you would like to share with Microsoft Teams users when starting an internal conversation.
   a. Click **Add Attribute**.
   b. In the **Add Action Attribute** dialog box, enter the following details:

   **Note**: See the table at the end of this step for some specific details that you must set for some attributes.

   - **Attribute Name**: Select a name from the drop-down list.
   - **Display Name**: Specify a suitable display name.
   - **Data Type**: Select the appropriate value from the drop-down list.
   - **Default Value**: Specify a default value.
   - **User Interface Component**: This field can have the following values: List, Text Area, or Text Box. The default value is Text Box.
   - **Display Sequence**: Specify a high or low number depending on where you want the UI component to be displayed. For example: You can specify a higher number such as 12 if you want it to be displayed lower down on the page.
   - **Business Object Identifier**: If it's a field that's used for identifying a record, then you must select this switch.

   **Note**: Let's say a to and fro message thread about a particular help desk request exists between Microsoft Teams and Help Desk. Then the linking of the messages is done through this field. You can select SR ID or SR number as the Business Object Identifier, because they both uniquely identify an SR.

   - **Included in Request**: If information is being sent from Microsoft Teams to Help Desk, then select this switch.
   - **Included in Response**: If you're sending a response message from Help Desk to Microsoft Teams, then select this switch.
   - **End Point**: This field is applicable only if you select the User Interface Component as List.
   - **Option Label**: This field is applicable only if you select the User Interface Component as List.
   - **Option Value**: This field is applicable only if you select the User Interface Component as List.
   - **Deep Link**: If required, provide a deep link that uniquely identifies the help desk request. For example: Link to request number that shows up in the Microsoft Teams UI: \crmUI\helpdesk\vp\edit-hrhd\srNumber=\{SrNumber\} or \crmUI\helpdesk\vp\edit-isr\srNumber=\{SrNumber\}. A To and From message thread about a particular Help Desk requests exists between Microsoft Teams and
HR Help Desk. Then the linking of the messages is done through this field. You can select SR ID or SR number as the Business Object Identifier, because they both uniquely identify a request. Here’s a list of some specific details that you must set for the following common action attributes:

<table>
<thead>
<tr>
<th>Action Attribute</th>
<th>Required Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>SrId</td>
<td>Select the Business Object Identifier switch.</td>
</tr>
<tr>
<td>SrNumber</td>
<td>Select the Include in Response switch.</td>
</tr>
<tr>
<td>SrNumber</td>
<td>Provide the following deep link in the Deep Link field: crmUI/helpdesk/vp/edit-hrh?srNumber=[[SrNumber]] or crmUI/helpdesk/vp/edit-isr?srNumber=[[SrNumber]]</td>
</tr>
<tr>
<td>Title</td>
<td>Select the Included in Response switch.</td>
</tr>
<tr>
<td>Problem Description</td>
<td>Select the Included in Response switch.</td>
</tr>
</tbody>
</table>

12. Click **Save**.

**Create a Child Action for a Collaboration Action**

A child action is an action within the main collaboration action.

For example: For the Collaboration on Service Request action, you would create a **Reply to Help Desk Request** button as the child. The **Reply to Help Desk Request** button is a child of the first message received in Microsoft Teams from Oracle Help Desk about needing help with a help desk request. Along with the message, some basic information about the request is shared.

**Note:** You can use any other suitable action name instead of **Reply to Help Desk Request**. Whatever action name you use is displayed in the Microsoft Teams interface.

To create a child action for a collaboration action:

1. Sign in as an administrator.
2. Navigate to the **Setup and Maintenance** work area and select the Service offering.
3. Open the **Tasks** panel tab.
4. Search for and click the **Manage Collaboration Actions** task.
   
   The All Collaboration Actions page opens in a new tab.
5. From the displayed list of existing collaboration actions, click the action for which you want to create a child action.
   
   The collaboration action opens, and its name is displayed in the navigation pane.
6. Click the plus symbol next to the name of the collaboration action.
7. Specify all the details for the child action as explained in Create a Collaboration Action. Considering the example of the Reply to Help Desk Request button, you would specify the following details:

   a. Action Details region:
      - **Action Name**: Reply to Service Request
      - **Action Code**: Specify a value of your choice. For example: reply-to-sr
      - **Business Object**: Select Conversation Message from the drop-down list.
        That’s because we’re creating a conversation message under the request.
      - **Action Type**: Select Open a Dialog from the drop-down list.

   b. Request Details region:
   The Request End Point is populated automatically, so you don’t have to change anything here.

   c. Response Details region:
   You can leave this page blank. That’s because clicking the **Reply to Help Desk Request** button would show a message text box in Microsoft Teams. And you’re not sending a response message from Service Center to Microsoft Teams.

   d. Add Action Attribute region:
   Here, you would add only one attribute, which is **Message Content**.
      - **Attribute Name**: Select MessageContent from the drop-down list.
      - **Data Type**: Select String from the drop-down list.
      - **User Interface Component**: Select Text Area from the drop-down list.
      - Select the **Included in Request** switch.

8. Click **Save**.

**Note:** Instead of clicking the **Reply to Help Desk Request** button, the subject matter expert (SME) can also reply by clicking the native **Reply** action. The SME must mention the app in the format `@AppName` in the native Reply. Here, `AppName` is the name of your company’s Microsoft Teams app created for Help Desk. When the SME mentions your app in this format, your app adds their reply as a message on the request.

---

Create a Child Action for the Reply to Request Child Action

The child of the Reply to Help Desk Request action in Microsoft Teams would be the Submit Reply action. When a Microsoft Teams user enters a message and clicks Submit Reply, the message goes to B2B Service.

**Note:** You can use any other suitable action name instead of **Submit Reply**. Whatever action name you use is displayed in the Microsoft Teams interface.
To create the Submit Reply child action to the Reply to Help Desk Request action:

1. Specify all the details for the child action as explained in Create a Collaboration Action. Considering the example of the Reply to Help Desk Request button in the previous topic, you would specify the following details:

   a. Action Details region:
      - **Action Name:** Submit Reply
      - **Action Code:** You can type any value of your choice here.
      - **Business Object:** Select Conversation Message from the drop-down list.
      - **Action Type:** Select Call an API from the drop-down list because it's calling a Help Desk API.
      - **Action Method:** Select Post from the drop-down list because you're creating a new message.
      - **Display Sequence:** Select 1.

   b. Request Details region:
      - **Request Content Type:** This field is populated automatically.
      - **Request End Point:** This field is populated automatically.
      - **Request Payload:** Add the following payload in this field:

          ```
          {"MessageContent": "[[MessageContent]]","MessageTypeCd": "ORA_SVC_INBOUND","ParentMessageId": [[ConversationMessageId]],"SenderAlternateId": [[$system.CollabResourceId]],"SenderFreeFormAddress": "[[system.ExternalResourceDisplayName]]","MessageAlternateId": "[[system.ExternalMessageId]]","recipients": [[system.ConversationMessageRecipients]]}
          ```

   c. Response Details region:
      - **Response Visibility:** Select Public from the drop-down list.
      - **Response Payload:** Set the value to `{"text": "[[MessageContent]]"}`

          This message content is also echoed to all the other SMEs in Microsoft Teams, so they all can view the reply given by the first SME. And they can add on to it if required.
      - **Response Type:** Select User-Defined JSON Formatted Result from the drop-down list.
      - **Response Content Type:** This field is populated automatically.

   d. Add Action Attribute region:
      - This page has only one attribute, which is **Message Content** because that's the only attribute for Submit Reply.
      - Ensure that you select the **Included in Request** switch.

2. Click Save.

Configure the FND_IDP_PROXY_USER_WHITELIST Profile Option

Let's say your agent sends a message to a Microsoft Teams user, seeking help to resolve a customer issue. When the Microsoft Teams user replies, their reply reaches Oracle CX B2B Service only if the FND_IDP_PROXY_USER_WHITELIST profile option is set to the default value FUSION_APPS_CRM_SOA_APPID.
That’s because the FUSION_APPS_CRM_SOA_APPID user’s credentials are used to create all messages sent from Microsoft Teams to B2B Service.

**Note:** Typically, the profile option is automatically set to the default value. But sometimes, it may have a blank value. If the value isn’t set to FUSION_APPS_CRM_SOA_APPID, you can follow these steps to set the value.

(Optional) To configure the FND_IDP_PROXY_USER_WHITELIST profile option:

1. Sign in as a setup user or administrator.
2. Navigate to the **Setup and Maintenance** work area.
3. Open the **Tasks** panel tab and click **Search**.
4. Search for and select the **Manage Administrator Profile Values** task.
5. On the Manage Administrator Profile Values page, navigate to the Search region.
6. In the **Profile Option Code** field, type FND_IDP_PROXY_USER_WHITELIST.
7. Click **Search**.

   The FND_IDP_PROXY_USER_WHITELIST profile option is displayed in the Search Results: Profile Options region.
8. In the FND_IDP_PROXY_USER_WHITELIST: Profile Values region, ensure that the **Profile Value** for the Site **Profile Level** is set to FUSION_APPS_CRM_SOA_APPID.
9. Click **Save**.

**Upload Your Microsoft Teams App**

To upload the Microsoft Teams app that you created for Oracle Help Desk:

1. In the Microsoft Teams navigation pane, click **Apps**.
2. In the Apps page, click **Upload a custom app** from the list.
3. Click **Upload for app name**.
   
   Here, app name stands for the name of the Microsoft Teams app that you created for Oracle Help Desk.
4. In the **Open** dialog box, search for the compressed file for your Microsoft Teams app. You downloaded this compressed file in the last step in Create a Microsoft Teams App for Oracle Help Desk.
5. Click **Open**.

   The app that you created is now uploaded to Microsoft Teams.

**Related Topics**
- Create a Microsoft Teams App

**Install Your Microsoft Teams App and Add It to Your Team**

After you upload your app, you must install the app and add it to your team in Microsoft Teams.
1. In Microsoft Teams, go to the **Apps** tab and click **More apps**.

   In the **Built by your org** region of the Apps page, you can see the Microsoft Teams app that you created for Oracle Help Desk.

   | **Note:** If you have created multiple apps, you can see all of them here.

2. Click the app that you want to install.

3. From the **Open** drop-down list, click **Add to a team**.

   In the **Type a team or channel name** region, your channel is selected by default.

4. If you have created multiple apps, you can select the app of your choice by clicking the cross mark.

5. Click **Set up a bot**.

   Your Microsoft Teams app is now installed for the team associated with the channel selected in step 3.

6. Navigate to **Teams** in the navigation bar.

7. Click the ellipsis next to your app name.

8. Click **Manage teams**.

   A page with your team name is displayed.

9. Click the **Apps** tab.

   Your Microsoft Teams app is now displayed in the list of apps.
17 Build Insightful Reporting with Help Desk Analytics

How to View Analyses Using OTBI

Oracle Transactional Business Intelligence (OTBI) is a real time, self-service reporting solution bundled with your application.

It provides prepackaged analytic content built on the Oracle Business Intelligence (BI) platform. These include subject areas for building your own dynamic analyses using an intuitive interface, industry standard metrics, and role-based, best practice reports and dashboards that deliver up-to-the-minute business insight across the entire extent of your service-related business operations.

Here's how you can view the analyses:

- To access BI Catalog, select Navigator > Tools > Reports and Analytics. The Reports and Analytics page is displayed.
  - Click the Hierarchical Selector >> icon and select My Folders or Shared Folders from the menu. Alternately, you can click the Browse Catalog button. The BI Catalog is displayed, where you can view your personal and shared analyses. You can also create your own analyses based on your business requirements using subject areas. You need to have the necessary privilege for authoring analyses.
- To access the Analytics page, from the Home page, click the Service group icon, and then click the Analytics icon. The Analytics page is displayed. You can search for the analyses available in BI Catalog, and mark your favorites. These favorites stay on the Analytics page as long as they remain favorites. This page also shows the analytics recently viewed by the signed in user.
- The Help Desk Dashboard is accessed from the Help Desk Request list page. Click on the Dashboard icon.

How You Manage Service Infolets

For the prebuilt Service roles, the Service Infolets page displays the infolets based on the user's role. For administrator-defined roles, administrators must enable the Service Infolets page for each new role.

The procedures to create, manage, and enable Service infolets are the same as that for Sales infolets.

- For information about how to build analytics, see Create and Edit Analyses Using a Wizard.

Related Topics

- Analytics Resources
Help Desk Analytics Roles


Analyses and the underlying data is secured through a set of delivered OTBI transaction analysis duty roles. These duty roles are assigned to the help desk agents, managers, and administrators and determine what analyses can be accessed by each. These OTBI transaction analysis duty roles control the subject areas and analyses a user can access. These roles also control the data that the signed in user can see in the analyses. This aligns with the data security privileges for the user in the transaction system.

The administrator defines which users, application roles, and catalog groups have the following privileges:

- Receive the delivery content of an agent.
- Have permission to access a section or alert section in a dashboard.
- Have permission to use a saved modification.
- Have permission to add or edit an existing catalog group.
- Assign permissions to a catalog object.

The OTBI transactional analysis duty roles for your service application are described in detail in the topic "About Security Roles". Here’s a table that shows the job and duty role mapping required for a user to access the Service analyses:

<table>
<thead>
<tr>
<th>Infolet Name</th>
<th>Job Role</th>
<th>BI Duty Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Desk Requests Pending My Actions</td>
<td>• Internal Help Desk Agent</td>
<td>• Internal Help Desk Agent Transaction Analysis Duty</td>
</tr>
<tr>
<td></td>
<td>• Internal Help Desk Administrator</td>
<td>• Internal Help Desk Administrator Transaction Analysis Duty</td>
</tr>
<tr>
<td></td>
<td>• Next Gen Human Resource Help Desk Administrator</td>
<td>• Next Gen HR Help Desk Administrator Transaction Analysis Duty</td>
</tr>
<tr>
<td></td>
<td>• Next Gen Human Resource Help Desk Agent</td>
<td>• Next Gen HR Help Desk Agent Transaction Analysis Duty</td>
</tr>
<tr>
<td>Help Desk Requests Pending Worker Action</td>
<td>• Internal Help Desk Agent</td>
<td>• Internal Help Desk Agent Transaction Analysis Duty</td>
</tr>
<tr>
<td></td>
<td>• Internal Help Desk Administrator</td>
<td>• Internal Help Desk Administrator Transaction Analysis Duty</td>
</tr>
<tr>
<td></td>
<td>• Next Gen Human Resource Help Desk Administrator</td>
<td>• Next Gen HR Help Desk Agent Transaction Analysis Duty</td>
</tr>
<tr>
<td></td>
<td>• Next Gen Human Resource Help Desk Agent</td>
<td>• Next Gen HR Help Desk Agent Transaction Analysis Duty</td>
</tr>
<tr>
<td>My Resolve Time</td>
<td>• Internal Help Desk Agent</td>
<td>• Internal Help Desk Agent Transaction Analysis Duty</td>
</tr>
<tr>
<td></td>
<td>• Internal Help Desk Administrator</td>
<td>• Internal Help Desk Administrator Transaction Analysis Duty</td>
</tr>
<tr>
<td></td>
<td>• Next Gen Human Resource Help Desk Administrator</td>
<td>• Next Gen HR Help Desk Agent Transaction Analysis Duty</td>
</tr>
<tr>
<td>Infolet Name</td>
<td>Job Role</td>
<td>BI Duty Role</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• Next Gen Human Resource Help Desk Agent</td>
<td>• Next Gen HR Help Desk Administrator Transaction Analysis Duty</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Next Gen HR Help Desk Agent Transaction Analysis Duty</td>
</tr>
<tr>
<td>Critical Help Desk Requests</td>
<td>• Internal Help Desk Manager</td>
<td>• Internal Help Desk Manager Transaction Analysis Duty</td>
</tr>
<tr>
<td></td>
<td>• Internal Help Desk Administrator</td>
<td>• Internal Help Desk Administrator Transaction Analysis Duty</td>
</tr>
<tr>
<td></td>
<td>• Next Gen Human Resource Help Desk Manager</td>
<td>• Next Gen HR Help Desk Manager Transaction Analysis Duty</td>
</tr>
<tr>
<td></td>
<td>• Next Gen Human Resource Help Desk Administrator</td>
<td>• Next Gen HR Help Desk Administrator Transaction Analysis Duty</td>
</tr>
<tr>
<td>Unassigned Help Desk Requests by</td>
<td>• Internal Help Desk Manager</td>
<td>• Internal Help Desk Manager Transaction Analysis Duty</td>
</tr>
<tr>
<td>Queue</td>
<td>• Internal Help Desk Administrator</td>
<td>• Internal Help Desk Administrator Transaction Analysis Duty</td>
</tr>
<tr>
<td></td>
<td>• Next Gen Human Resource Help Desk Manager</td>
<td>• Next Gen HR Help Desk Manager Transaction Analysis Duty</td>
</tr>
<tr>
<td></td>
<td>• Next Gen Human Resource Help Desk Administrator</td>
<td>• Next Gen HR Help Desk Administrator Transaction Analysis Duty</td>
</tr>
<tr>
<td>My Team Average Time to Resolve</td>
<td>• Internal Help Desk Manager</td>
<td>• Internal Help Desk Manager Transaction Analysis Duty</td>
</tr>
<tr>
<td>Closed SRs</td>
<td>• Internal Help Desk Administrator</td>
<td>• Internal Help Desk Administrator Transaction Analysis Duty</td>
</tr>
<tr>
<td></td>
<td>• Next Gen Human Resource Help Desk Manager</td>
<td>• Next Gen HR Help Desk Manager Transaction Analysis Duty</td>
</tr>
<tr>
<td></td>
<td>• Next Gen Human Resource Help Desk Administrator</td>
<td>• Next Gen HR Help Desk Administrator Transaction Analysis Duty</td>
</tr>
</tbody>
</table>

**Related Topics**

**Help Desk Analytics Subject Areas**

Creating analyses begins with subject areas. A subject area is a functional grouping of the contextual entities (also called dimensions) by which the metrics (also called facts) can be analyzed. Subject areas are the building blocks of analytic content in OTBI.

For example, the columns in a tabular report showing the number of open SRs (metric or fact) by Agent Name (context or dimension) are sourced from one of the subject areas. Multiple subject areas can be joined to produce reports, when cross functional analysis is needed.

The Help Desk application comes with a variety of standard subject areas for you to select from when you’re building or editing your analytics.
HR Help Desk Subject Areas

- Help Desk - HR Service Requests Real Time
- Help Desk - HR Service Request Messages Real Time
- Help Desk - HR Service Request Lifecycle
- CRM/Help Desk - Omni Channel Events Real Time
- CRM/Help Desk - Inbound Messages Real Time

Internal Help Desk Subject Areas

- Help Desk - Internal Service Requests Real Time
- Help Desk - Internal Service Request Messages Real Time
- Help Desk - Internal Service Request Lifecycle
- Help Desk - Internal Help Desk Request Milestones Real Time
- CRM/Help Desk - Omni Channel Events Real Time
- CRM/Help Desk - Inbound Messages Real Time

Additional subject areas focused on analyzing knowledge articles and their usage in service requests are available for knowledge managers and analysts. For more information, see the Oracle Fusion Cloud B2B Service Implementing Knowledge Management guide.

Help Desk Analytics Saved Queries

Saved queries are canned analyses that enable you to construct reports efficiently. The saved queries are pre-calculated data filters that can be conveniently applied on any analyses that you want to build. They're also useful in cross-subject-area reporting.

Here's how you access the saved queries:

1. Click Navigator > Tools > Reports and Analytics.
2. Click Browse Catalog.
   The Oracle Business Intelligence Catalog page is displayed.
3. In the Folders pane, click Shared Folders > Service > Subject Area Contents > Saved Queries - OTBI HR HelpDesk - New or Saved Queries - OTBI Internal HelpDesk.

Here's a table that provides details about the available saved queries:

<table>
<thead>
<tr>
<th>Analyses Name</th>
<th>Description</th>
<th>Job Role</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Five Queues by Unassigned SRs</td>
<td>Saved query to retrieve the top five queues with unassigned SRs</td>
<td>- Next Gen Human Resource Help Desk Administrator&lt;br&gt;- Next Gen Human Resource Help Desk Manager&lt;br&gt;- Next Gen Human Resource Help Desk Agent</td>
<td>Shared Folders &gt; Service &gt; Subject Area Contents &gt; Saved Queries - OTBI HR Help Desk - New</td>
</tr>
<tr>
<td>Analyses Name</td>
<td>Description</td>
<td>Job Role</td>
<td>Location</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------------------------------------</td>
<td>-----------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Top Five Queues by Unassigned SRs</td>
<td>Saved query to retrieve the top five queues with unassigned SRs</td>
<td>• Next Gen Human Resource Help Desk User</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Internal Help Desk Manager</td>
<td>Shared Folders &gt; Service &gt; Subject Area Contents &gt; Saved Queries - OTBI Internal Help Desk</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Internal Help Desk Agent</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Internal Help Desk User</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Internal Help Desk Administrator</td>
<td></td>
</tr>
</tbody>
</table>
18 Import and Export

Overview of Import and Export Management

You can import and export a wide range of application data using import and export management in your service application.

For example, you can use the export management feature to export object data so that you can then import it into another instance. You can also import records to the applications so that you don't have to create the records in the user interface. Only users with the Help Desk administrator roles can import and export objects. For more information, see the Oracle Fusion Understanding Import and Export Management for Sales and Service guide.

Overview of Import Objects

You can import several objects into the application using the import management framework.

To import objects, Click **Tools > Import Management > Import Objects**.

The following is a sample list of top-level and sublevel objects that you can import into the service application. For more information on these and other objects available for import, see the Oracle Fusion Understanding Import and Export Management for Sales and Service guide.

- Help Desk Requests
  - Messages
  - Contact Members
  - Resource Members
  - References
- Queues
  - Queue Party Resources
  - Queue Team Resources
- Categories

**Note:** Since the request data is dependent upon queues and categories, you must import the queues and categories before importing your help desk requests.

- Interactions: You can't import interactions into the application, but you can export the interactions for the help desk requests.
- Inbound email
- Inbound Message Filters: You can import the inbound message filters through Setup and Maintenance.
- Milestone Configuration: You can import and export milestone configurations only through Setup and Maintenance.
• Channels
  ◦ Channel Resources
• Standard Text Folders: The import facility doesn’t support importing hierarchical data directly. To import folders hierarchies, such as parent and child relationships, you must import the standard text folders data twice. The first time you import the file, the object data is added, and the second time you import the same file, the relationships are created.
• Standard Text Variables
• Standard Text
  ◦ Standard Text Relations
• Self-Service Roles

Overview of Export Objects
You can extract large volumes of data from the application using bulk export. You can either extract a full set of records for an object, or perform incremental extracts. For example, you can extract the complete set of service requests data or extract an updated set of records every week.

To export objects, Click **Tools > Export Management > Export Objects**. For more information, see the Oracle Fusion Understanding Import and Export Management for Sales and Service guide.

Related Topics
• Overview of Bulk Data Export
• How You Import Custom Objects

Use Functional Setup Manager to Import, Export, and Compare Categories Between Environments

Your users can import, export, and compare service categories between environments using Functional Setup Manager. Users to create or update setup service category data in bulk as well as compare differences between two environments.

For example, a user wants to import service category data into a production environment that has been exported from a test environment after making changes to the setup data. Before the user imports the data, the user can compare the exported data of the test environment with the existing production data, and preview how the setup data in production will change after the data is imported.

Any implementation usually requires migrating setup data from one environment to another at various points in the subscription lifecycle. For example, a subscribed offering is typically set up in the test environment first, and is moved to the production environment only after proper testing and verification. Setup export and import processes help you migrate setup data from test to production.

**Note:** You must have the Application Implementation Consultant role (ORA_ASM_APPLICATION_IMPLEMENTATION_CONSULTANT_JOB) to export, import, and compare setup data.
For more information, refer to the Related Topics section for a link to the Oracle Fusion Using Functional Setup Manager guide.

**Related Topics**
- Export and Import CSV File Packages

## Before You Import

Since the help desk request data is dependent upon queues and categories, you must import the queues and categories before importing your help desk requests. Before you import help desk requests, queues, or categories, you must first import the following dependent objects:

- **Contacts**: The list of contacts for each account that can be associated with the help desk request. For information about importing contacts, see "Import Your Contact Data" in the guide specified in Related Topics.
- **Resources**: The list of resources to which you can assign work objects in the help desk request. For information about importing resources, see "Import Resource Data" in the guide specified in Related Topics.
- **Product Groups**: A product group is a group of related products. For information about importing product groups, see "Import Your Product Group Data" in the guide specified in Related Topics.
- **Products**: List of products against which you can raise a help desk request. For information about importing products, see "Import Your Product Data" in the guide specified in Related Topics.
- **Asset**: List of assets associated with the account. For information about importing assets, see "Import Your Asset Data" in the guide specified in Related Topics.
- **Categories**: The categories associated with the help desk request. For information about importing categories, see "Import Your Service Request Data" in the guide specified in Related Topics.
- **Queues**: The queues to which your help desk requests are assigned. For information about importing queues, see "Import Your Queue Data" in the guide specified in Related Topics.
- **Channels**: Import the channels that are already associated with your help desk requests. For information about importing channels, see "Import Your Service Request Data" in the guide specified in Related Topics.
- **Tags**: The administrator-defined tags to be associated with help desk requests. For information about importing tags, see "Import Your Service Request Data" in the guide specified in Related Topics.

**Related Topics**
- Oracle Fusion Understanding Import and Export Management for Sales and Service

## Import Objects

After you import the dependent objects, create an import activity to upload details of objects you want to upload. Here’s how you import an object:

1. Set up the import options.
You select the object you're importing, specify the file format and different import options, and upload the file with your data. The options that are available depend on the object that you're importing. Some import objects, for example, permit you to upload a ZIP or Java archive (JAR) file of attachments. These attachments are then attached to the records in the application after the import is complete.

2. Map the fields.

For this task, you create a mapping of the data in your file and the attributes in the application. You can also reuse a mapping that you have created in past import activities. Any mapping you create in an activity is automatically saved. This mapping can be reused in subsequent imports and can be managed using the Manage Mapping page.

3. Schedule the import.

You can schedule to run the import at a time you specify or run it immediately.

4. Review and activate the import activity.

Review your import details and click **Activate** to activate the import activity.

You can use predefined .csv templates for your requests, queues, and categories that are provided in the application. You can also import user-defined objects.

### Overview of Bulk Data Export

You can extract large volumes of data using bulk export. You can either extract a full set of records for an object, or perform incremental extracts.

For example, you can extract complete set of account data or extract updated set of records every week. Bulk export creates comma separated or tab delimited files, which are attached to the export process.
19 Manage Knowledge

Implement Knowledge for Help Desk

Administrators and authors can use Knowledge to create and manage a knowledge base. Agents can use the knowledge base to help resolve Help Desk requests, and employees can use My Help employee portal to find answers in the knowledge base.

If you're implementing Help Desk, and haven't previously implemented Knowledge for HR Help Desk, you implement knowledge in Help Desk by doing the following:

- Do the setup tasks described in the *Oracle Fusion Cloud B2B Service Implementing Knowledge Management* guide.
- Add specific roles to enable agents to use knowledge in Help Desk requests.

If you have already implemented Knowledge for HR Help Desk, you can implement Knowledge for Help Desk by doing the following:

- Use your existing HR Help Desk implementation.
- Add specific roles to enable agents to use knowledge in Help Desk requests.

You use the Classic setup and maintenance pages to implement and administer Knowledge for Help Desk. When you complete the implementation, Help Desk agents and employees will use Knowledge features when they work with Help Desk requests and search for answers in My Help. Knowledge base authors and managers will use classic knowledge authoring pages to create, update, and publish knowledge base articles.
20 Implement Cases for Help Desk

About Case Management

Case Management provides the ability to manage long running processes to meet an organization's needs managing escalations, investigations, problems, applications, and other complex issues.

For example, a case can be created when a help desk complaint requires a formal grievance or disciplinary action process. In this way cases allow an organization to address issues that stretch over a long periods of time, require complex business processes for successful completion, or have outcomes that can be difficult to predict or measure.

If your organization is using the Cases feature as part of its Help Desk implementation, see the Using Case Management guide to learn how to create and manage cases. For more information about implementing case management, see the Implementing Case Management guide.
**21 Associate Assets and Work Orders to Help Desk Requests**

**Associate Assets and Work Orders to Help Desk Work Requests**

Help Desk Requests can be used as work requests to report facility and asset-related maintenance issues. The requests can be associated with an asset and ultimately a work order for resolution.

The requests contain information about the nature of the discrepancy, asset (if known), and a description of the problem. Work Requests are sorted and then assigned for resolution using maintenance work orders.

**Create the Enable Work Request Profile Option**

Before you enable work requests, you must create the work request profile option.

In Setup and Maintenance go to the following:

1. Click the **Tasks** icon.
2. Click the **Search** link.
3. Enter Manage Profile Options in the **Search** field.
4. Click the **Search** icon.
5. Click the **Manage Profile Options** link.
6. On the Manage Profile Options page, in the **Search Results** region click the **Add** icon.
7. On the Create Profile Option page, enter the following:
   - **Profile Option Code**: SVC_NG_ENABLE_MAINTENANCE_HELPDESK
   - **Profile Display Name**: SVC_NG_ENABLE_MAINTENANCE_HELPDESK
   - **Application**: Service
   - **Module**: Service
   - **Description**: Add a description
   - **Start Date**: Add a Start Date
   - **End Date**: Add an End Date if applicable.
8. Click **Save and Close**.
9. Click **Save and Close** on the Manage Profile Options page.
10. Click **Done**.

**Setup and Enable the Work Request Profile Option**

To enable this functionality you must license and enable the Help Desk offering for Internal Service Requests. Additionally, you must set the profile option you just created to expose Asset and Work Order details in the pages.

1. Click the **Tasks** icon.
2. Click the Search link.
3. Enter Manage Administrator Profile Values in the Search field.
4. Click the Search icon.
5. Click the Manage Profile Options link.
6. On the Manage Administrator Profile Values page, enter the Profile Option Code: SVC_NG_ENABLE_MAINTENANCE_HELPDESK
7. Click Search.
8. In the Profile Values region, set the Profile Value for Site to Y.
9. Click Save and Close.
10. Click Done.

**Note:** To submit a Work Request for an Asset, you don’t need any additional subscription. However, to manage a Work Request for an Asset and create Work Orders, you must have an Oracle Sales and Service Enterprise Subscription.

---

### Enable the Maintenance Help Desk Profile Option for REST API

Enable the Maintenance Help Desk profile option so that it's available in REST APIs

In Setup and Maintenance go to the following:

1. Click the Tasks icon.
2. Click the Search link.
3. Enter Manage Profile Categories in the Search field.
4. Click the Search icon.
5. Click the Manage Profile Categories link.
6. In the Search Results region of the Manage Profile Categories page, click the Add icon.
7. Enter the Category Code: ORA_FND_AUTH_REST_ACCESS.
8. Click Search.
9. In the ORA_FND_AUTH_REST_ACCESS: Profile Options, click Add.
10. Enter Profile Name SVC_NG_ENABLE_MAINTENANCE_HELPDESK.
11. Click Save and Close.
12. Click Done.
22 Manage Digital Assistant for Help Desk

Manage Digital Assistant for Help Desk

You can configure Next Generation Help Desk as a skill in Digital Assistant, which makes it available to Help Desk users in multiple supported channels.

For example, SMS, Slack, and messenger applications. End users benefit from Digital Assistant's artificial intelligence-driven conversational engagement while creating, searching, and updating Help Desk requests.

The Help Desk delivered skill is 'Helpdesk' and it includes two intents; Create Request and Get Request. The Create Request intent prompts users for information such as request description, category, attachment and asset (for non-HR help desk requests). The Get Request intent includes both searching for and updating a help desk request. When a user enters a phrase, digital assistant checks whether that phrase matches a Help Desk intent. For example, these user phrases match the create help desk request:

- Create ticket
- Create a help desk request
- Create request

Help Desk skills are integrated with Knowledge skills. Starting a flow with a knowledge search can move into the create service request skill and then will pass the category from the last reviewed knowledge article.

Digital assistant uses its training data to extend matching to similar phrases over time. You can also extend digital assistant skills to meet specific business requirements. Learn more about skills and extending skills in the Digital Assistant guide.

Related Topics
- Oracle Fusion Cloud Applications Getting Started with Oracle Digital Assistant for Fusion Applications
23 Channels for Collaboration

Control the Display of Channels Used Only for Internal Conversations

You can disable the channels that you don’t want to be displayed in the application when an agent composes a response message or captures a customer message.

1. Sign in to Service Center as a setup user or administrator.
2. In the Setup and Maintenance work area, go to the Tasks panel tab.
3. Search for and click the Manage Service Request Channel Type Visibility task.
4. On the Manage Service Request Channel Type Visibility page, if you don’t see the channels you want to disable, click Sync on the toolbar of the table.
5. For any channel that you select, you see two rows with different values for Property Name:
   - **Enabled for Collaboration:** To enable the selected channel to collaborate with internal users to resolve customer issues, set the Property Value for this property name to Yes.
   - **Enabled for Customer Interaction:** To enable using the selected channel for interaction of your service agents with your customers, set the Property Value for this property name to Yes.

   **Note:** You can also use the drop-down list in the toolbar for the Property Name field to filter the list by each property name.

6. Set the Property Value to No to disable the selected channel.

   **Note:**
   - For messages of type Customer Entry and Response:
     - SMS and Slack channels are disabled by default because they aren't supported for customer communications. You can enable or disable the other channels.
   - For internal conversations, only the Email, Microsoft Teams, Slack, Web, and custom channel types that you created are supported. You have the option to disable the channel types that you want to hide when starting an internal conversation. For example, if you don't use Slack in your organization, you can disable Slack for collaboration.

7. Click Save and Close.

   The disabled channels aren't displayed when an agent composes a message.
Create an Email Channel for Collaboration or Internal Conversations

Let's say an agent needs to reach out to a subject matter expert (SME) to resolve a customer issue.

To facilitate this type of internal conversation, you must create a separate email channel and set the Purpose field for the channel to Collaboration. And the agents must use this channel for their internal conversations. To communicate with the SME, the agent starts an internal conversation. They select a channel and the SME as the recipient, and compose a message. When the SME replies, their message comes into this conversation.

For internal conversations, Service Center has the Conversation Message object. When an SME replies, that message is posted as a Conversation Message because the SME replied to the agent's internal conversation. When a customer replies, the message is posted as an SR Message. This feature is built into the processing of the incoming email.

For this process to happen, you must ask the agents to select the appropriate email channel:

- While communicating with an SME, the agent must use the channel that you have created for internal conversations. For example: internal@mycompanydomain.com. Now when the SME replies, this reply is captured as a Conversation Message. That's because the SME replied to the agent's internal conversation.
- While communicating with a customer, the agent must use the channel that you have created for conversations with customers. For example: support@mycompanydomain.com. Now when the customer replies, this reply is captured as an SR Message.

Related Topics
- Configure an Email Channel
24 Extend Help Desk

Using Visual Builder Studio for Help Desk

The following topics in this chapter contain procedures for using Oracle Visual Builder Studio using the Service Request object. For Help Desk, use the same procedures, but with the corresponding Help Desk object.

Overview of Extending Your Application

Your application is built using Oracle Visual Builder Studio and Oracle JET components. Visual Builder Studio is a single place where organizations can manage projects, environment and repositories; a Visual Builder Designer is where you can extend your application. From VB Studio, you can open many different designers.

Visual Builder Studio is the browser-based tool that your organization can use to make modifications and extensions to the Redwood user interface. Using the extension framework, you can make changes to the user interface such as displaying custom fields on forms, creating dynamic layouts for a form, or embedding custom content in a dynamic container in a page.

Your VB Studio instance is paired with your Test instance of Fusion Applications. This means that your design time experience will be based on data in the Test instance database and a sandbox in the Test instance (if you’re working within a sandbox).

The changes you make using VB Studio are stored in an artifact called an application extension. An application extension can be something as simple as a field added to a cloned, custom, or new form, or a new container of forms. You can create extensions, then preview them to see how they look in your UI. To create a extension that impacts the data model, you must use a sandbox within Application Composer, then use the Edit Pages in Visual Builder option to expose your changes in the UI.

You navigate to the VB Studio Designer directly from within the Redwood application. VB Studio is a **design at runtime tool**, which allows you make UI changes and then immediately preview the results before publishing the changes to other users.

VB Studio is just one tool that administrators can use to make application changes. As previously mentioned, you extend the underlying object model used by the Redwood application with Application Composer. The model changes you make in Application Composer are reflected in the RESTful API for those objects, and thereby become available to the VB Studio Designer for use in UI extensions.

**Related Topics**

- Configuring Applications Using Application Composer
- How Do I Use Visual Builder Studio to Extend Oracle Cloud Applications?
Configure Visual Builder Studio for Help Desk

This topic explains the Next Generation Help Desk delivered page layouts for configuration with Visual Builder Studio.

**Note:** Oracle recommends having only one active extension at a time, and that extension should contain all of the changes you've made. Independent extensions aren't synced, so having two actively deployed extensions can result in one overriding changes in the other. Having one extension also gives you a complete view of all of the changes that have been made to date.

**My Help**
My Help is a landing page that contains one dynamic container with three sections:

- Popular Articles
- Help Desk Request List
- Quick Links (hidden section for adding quick links for commonly asked questions)

**Help Desk Request Create Page**
The Help Desk Request Create page contains one dynamic container with two sections:

- Help Desk Request header (dynamic form to add, remove, reformat, and conditionally render format)
- Attachments

**Help Desk Request Summary**
The Help Desk Request Summary contains one dynamic container:

- Left Hand Panel Spotlight (dynamic form to add, remove, reformat, and conditionally render format)

**Help Desk Request Full Edit Page**
The Help Desk Request Full Edit page has one dynamic container with multiple sections:

- Help Desk Request header (dynamic form to add, remove, reformat and conditionally render format).
- Contacts, Teams, and Maintenance Work Orders (dynamic tables to add and remove fields)
- The dynamic container is extendable and can be used to do two things.
  - Rearrange the existing content.
  - Add your own components to the display, as long as certain conditions are met at runtime.

For more information, see the Extending Oracle Cloud Applications with Visual Builder Studio guide link at the end of this topic.
Action Plan

Action Plan is a dynamic form on the Help Desk Request Summary page.

Related Topics

Set Up Visual Builder Studio

Before your team can start creating application extensions, you must first set up Visual Builder Studio and configure it. For more information on setting up VB Studio, refer to the Using VB Studio guide listed in the Related Topics.

Provision a Project

After you set up your VB Studio environment, you can then provision a project to extend your Service Center instance. The workflow is as follows:

- You get access to VB Studio.
- You provision a project based on the Service Center template that's included with VB Studio.
- You then drill down on the project to use the Visual Builder Designer to extend Service Center.

Related Topics
- Using VB Studio
- Video: Setting Up Visual Builder Studio for Oracle Cloud Application Extensions
- Set Up VB Studio Users
- Set Up the Project to Deploy for Production

Work with Dynamic UI

Get to Know Layouts

After you launch VB Studio, VB Studio Designer displays the form you were examining in Help Desk.

You can extend components within the Create Help Desk Request page, the Edit Help Desk Request page, and other pages within the application. For this example we'll work with the Create Help Desk Request page.

The following image shows the various components of the VB Studio UI:
Directly Editing the Dynamic UI

Here's an overview of how you edit directly in the dynamic UI.

1. When you're on a Redwood page, such as Create New Help Desk Request, click the Settings and Actions menu and select **Edit Page in Visual Builder**.
2. In the application extension explorer, expand App UIs > Oracle Fusion Helpdesk UI Extensions App > helpdesk.
3. All the sub-components are displayed under the component.

   **Note:** This is where you would go to extend child objects.

**Related Topics**
- What are Dynamic Components?
- Understand the Designer
Dynamic Forms That You Can Extend

As described in the preceding topic, the Help Desk UI is highly extensible. This topic gives you an overview of what layouts in the Help Desk UI then you can extend using Visual Builder Studio.

The following two tables list many of the dynamic forms that you can configure, and many of the dynamic tables, used for help desk requests, that you can extend.

**HR Help Desk Requests Dynamic Forms**

<table>
<thead>
<tr>
<th>Dynamic Form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy HRHD Agent Flow</td>
<td>Copy HR Request Form - Agent flow</td>
</tr>
<tr>
<td>Copy HRHD Employee Flow</td>
<td>Copy HR Request Form - Employee flow</td>
</tr>
<tr>
<td>Create HRHD Agent Flow</td>
<td>Create HR Request Form - Agent flow</td>
</tr>
<tr>
<td>Create HRHD Emp Flow</td>
<td>Create HR Request Form - Employee flow</td>
</tr>
<tr>
<td>Edit HRHD Agent Flow</td>
<td>Edit HR Request Form - Agent flow</td>
</tr>
<tr>
<td>Edit HRHD Emp Flow</td>
<td>Edit HR Request Form - Employee flow</td>
</tr>
<tr>
<td>HRHD Detail Agent Flow</td>
<td>HR Request Overview - Agent flow (Left hand panel / Spot light region)</td>
</tr>
<tr>
<td>HRHD Detail Emp Flow</td>
<td>HR Request Overview - Employee flow (Left hand panel / Spot light region)</td>
</tr>
<tr>
<td>Milestone Edit</td>
<td>Milestone Edit Form</td>
</tr>
<tr>
<td>SR Resolve Form</td>
<td>SR Resolve Form - Agent</td>
</tr>
</tbody>
</table>

**HR Help Desk Request Dynamic Tables**

<table>
<thead>
<tr>
<th>Dynamic Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Contacts</td>
<td>Used in Copy Request</td>
</tr>
<tr>
<td>HRHD Contacts EditMode Layout</td>
<td>Used in HR Request Edit Page</td>
</tr>
<tr>
<td>Copy Team Member</td>
<td>Used in Copy Request</td>
</tr>
<tr>
<td>HRHD Team EditMode Layout</td>
<td>Used in HR Request Edit Page</td>
</tr>
<tr>
<td>Display Milestones</td>
<td>Used in HR Request Edit Page</td>
</tr>
<tr>
<td>Display Milestones RHP</td>
<td>Used in HR Request Overview Page</td>
</tr>
</tbody>
</table>
**Internal Service Requests Dynamic Forms**

<table>
<thead>
<tr>
<th>Dynamic Form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy ISR Agent Flow</td>
<td>Copy Internal Request Form - Agent flow</td>
</tr>
<tr>
<td>Copy ISR Employee Flow</td>
<td>Copy Internal Request Form - Employee flow</td>
</tr>
<tr>
<td>Create ISR Agent Flow</td>
<td>Create Internal Request Form - Agent flow</td>
</tr>
<tr>
<td>Create ISR Employee Flow</td>
<td>Create Internal Request Form - Employee flow</td>
</tr>
<tr>
<td>Edit ISR Agent Flow</td>
<td>Edit Internal Request Form - Agent flow</td>
</tr>
<tr>
<td>Edit ISR Employee Flow</td>
<td>Edit Internal Request Form - Employee flow</td>
</tr>
<tr>
<td>SR Detail Agent Flow</td>
<td>Internal Request Overview - Agent flow (Left hand panel / Spot light region)</td>
</tr>
<tr>
<td>SR Detail Employee Flow</td>
<td>Internal Request Overview - Employee flow (Left hand panel / Spot light region)</td>
</tr>
<tr>
<td>Milestone Edit</td>
<td>Milestone Edit Form</td>
</tr>
<tr>
<td>SR Resolve Form</td>
<td>SR Resolve Form - Agent</td>
</tr>
<tr>
<td>WorkOrder</td>
<td>Work Order Create Form</td>
</tr>
</tbody>
</table>

**Internal Service Request Dynamic Tables**

<table>
<thead>
<tr>
<th>Dynamic Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contacts Edit Mode Layout</td>
<td>Used in Copy Request</td>
</tr>
<tr>
<td>Copy Contact</td>
<td>Used in HR Request Edit Page</td>
</tr>
<tr>
<td>Copy Team Members</td>
<td>Used in Copy Request</td>
</tr>
<tr>
<td>Team Edit Mode Layout</td>
<td>Used in HR Request Edit Page</td>
</tr>
<tr>
<td>Display Milestones</td>
<td>Used in HR Request Edit Page</td>
</tr>
<tr>
<td>Display Milestones RHP</td>
<td>Used in HR Request Overview Page</td>
</tr>
<tr>
<td>Work Order List</td>
<td>Used in HR Request Edit Page</td>
</tr>
</tbody>
</table>

Let's first look at the New Help Desk Request layout:
New Help Desk Request

<table>
<thead>
<tr>
<th><strong>Subject</strong></th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Primary Point of Contact</strong></th>
<th><strong>Queue</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Matt Hooper</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Assigned To</strong></th>
<th><strong>Category</strong></th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Channel Type</strong></th>
<th><strong>Critical</strong></th>
</tr>
</thead>
</table>

**Detailed Description**

Type # to bring up a list of SmartText.

**Category**

- Miscellaneous

**Drag and Drop**

Select or drop files here.
Now let's look at the different extensible layouts from the Help Desk page.

My Open HR Help Desk Requests

What would you like to do?

New Request

Request Number
HRHD0000006058

Primary Point of Contact
Matt Hooper
sendmail-test-discard@oracle.com

Status
New

Severity
Low

Queue
AutoQueueHRHD

Contacts (1)
Matt Hooper
sendmail-test-discard@oracle.com

Now, to view Help Desk Request details layouts, you click the Edit button in the Summary field as shown in the following graphic:
New Request

Request Number
HRHD0000006058

Primary Point of Contact
Matt Hooper
sendmail-test-discard@oracle.com

Status
New

Severity
Low

Queue
AutoQueueHRHD

Contacts (1)
Matt Hooper
sendmail-test-discard@oracle.com
Work with Dynamic Forms

Duplicate a Form

This example, using the Create Help Desk Request form, will show you how to extend or modify a form.

**Note:** It's highly recommended that you duplicate any form that you work with before you modify or extend it.

1. Click the App UIs tab, then Oracle Fusion Service UI Extension App > helpdesk > agent > service-request-create > service-request-create-start.
2. In the Properties pane, click the **Components** tab, and select **service-request-create-start**, and then click **Open Rule Set Editor**.
3. In the Designer, you'll see the available layouts, along with the display logic of that layout.
4. Select a layout.
5. In the Built-in layouts area, hover in the default layout, and select the **Duplicate** button.
6. In the **Duplicate Layout** dialog box, enter a name for the layout and click **Duplicate**.

View Form Properties

Now let's just look at some of the properties of the new form. The Rule Set properties list the form's properties along with a list of templates.

1. After you duplicate the form, select it in the Designer.
2. Click the **Fields** tab to view available fields for the form.

Add Conditions to a Form

In this example, we'll add a condition that specifies that a form displays only if a certain Help Desk severity level is reached. First duplicate the layout, or choose your layout, then do the following:

1. Click the **Click to add condition** link.
2. From the **Attribute** drop-down list, select the severity code value: `$fields.SeverityCd.value()`, then in the Value field, enter: `ORA_SVC_SEV1` as shown in the following example:

   ![Example](image.png)

3. Now the layout will only display when a Help Desk request has a severity code of 1.

### Add, Hide, or Rearrange Fields

This topic show you how to work with form fields in VB Studio. As with previous examples, we'll use New Help Desk Request.

1. In the Rule Set editor, from the Dynamic Form list, select the New Help Desk Request form.
2. Duplicate the layout, then select the duplicate record.
3. Click the **Open** icon.

   The layout is displayed with its included fields, and in the explorer, all available fields.

4. To add a field, click the check box of any field shown in the field explorer.

   The added fields, including custom fields added with Application Composer, will appear at the end of the layout.
5. To reorder fields, click the control beside the field, and drag and drop the field to where you want it to go in the layout order.

The following screen capture shows the control you use to drag and drop fields in the layout.

6. To hide a field either deselect the field in the field list, or hover in the field in the layout and click the X.

Create a Custom Field

You create custom fields that retain changes to the database using Application Composer. Custom fields that you create in VB Studio are read only.

This example shows you how to create a custom field using Application Composer.

**Note:** You will need to create and activate a sandbox to perform this task. Use the same sandbox used for this task when you add the field in VB Studio, which is described in the next task.

1. Sign in to your application as an administrator.
2. Click **Navigator > Configuration > Application Composer**.
3. Expand the **Standard Objects** list, then expand the HR Help Desk Request object node.
4. Click **Fields**.
5. On the Fields screen, click the **Custom** tab, then click the **Action** drop-down list and select **Create**.
6. Select **Text** because for this example, we’ll just create a text field.
7. Click **OK**.
8. In the Create Text Field screen enter the field name into the **Display Label** field.

   The Display Label field displays the field name in the UI. The Name field autofills after you complete the display label, and is only for internal use. It won’t be displayed in your UI.

9. Choose the number of characters you want to allow in the new text field.

   The default number of characters is 30, but you can set it for less or for more.

10. If you want the field to be searchable, select the **Searchable** check box in the Constraints area.

11. Click **Save and Close**.

12. To add the field in VB Studio, follow the steps in the next procedure.

---

**Add a Custom Field Created in Application Composer**

Use this topic to add a field that you created in Application Composer. Fields that you create in Application Composer allow you to retain changes to the database, whereas custom fields created in VB Studio are read only.

This topic shows you how to add a custom field that you created in Application Composer to a layout in VB Studio.

**Before you start**

Make sure VB Studio is connected to the same sandbox that you used when creating the custom field.

**Here’s what to do**

1. In VB Studio, click the **Layouts** icon in the explorer.

   ![Layouts Icon](image)

2. Locate the object you want to add the field to.

3. In this example, we’ll use the **SrMilestone** object, so click that object.

4. Display the rule sets, and then choose the one you want to add the field to.
5. For this example, choose Milestone Edit.

6. Duplicate the form using the following task: *Duplicate a Form*.
7. Open the duplicate you created.
8. The workspace displays the fields that are contained in the form, and those that can be added.
9. From the list of available fields, locate your new field, using the filter field to search if necessary.
10. Drag the new field to the form, and position it in the order you want. You can use *Add, Hide, or Rearrange Fields* for reference.
11. The field is now added to the form. Click the *Preview* button to view your changes in the application UI.

### Add a Read Only Custom Field Using VB Studio

Now, we'll create and add a custom field in VB Studio then add it to a layout. For this example, we'll be creating a custom field based on the SR severity.

**Note:** Custom fields created in VB Studio are read only. To create a custom field that will retain changes to the database, you must use Application Composer. To create a custom field in Application Composer, refer to *Create a Custom Field*.

1. In the Applications Extensions explorer, navigate to **App UIs > Oracle Fusion Service UI Extension App >HrHelpDeskRequests >SrMilestone**.
2. Click the **Fields** tab.
3. Click the **Custom Field** button.

4. In the **Custom Field** pop up window, enter the field name that you would like reflected in the UI.
5. Click **Create**.
6. From the list of fields, select the newly created custom field.
7. In the Properties pane, add referenced fields by doing the following:
   a. Click the **Add** link for the Referenced Fields property.
   b. In the **Referenced Field** text field, start entering the word and then choose the **SeverityCd** field from the results that appear and then click **Add Field**.
8. Now, click the Expression editor:
9. Now in the Expression Editor, set the conditions that govern when the field is displayed by doing the following:

a. From the Context explorer, expand the fields list.

```
- Context
  - $application
  - $componentContext
  - $device
  - $fields
    - AccountPartyEmailAddress...
    - AccountPartyFormattedPhone...
    - AccountPartyId
    - AccountPartyName
    - AccountPartyNumber
    - AccountPartyPreferredContact...
```

b. Locate the SeverityCd field in the list, expand it, and drag and drop value into the editor.

c. Add the following to the expression:

```
==='ORA_SVC_SEV1'?'High Severity SR':'Not a high Severity SR'
```

d. Click Save.

Now the custom field will only display if a value has a severity code of 1.

10. Click Rule Sets to return to the layout.

11. In the Fields explorer, enter the name for the custom field.

12. Click the check box to include the field in the layout.

13. Drag and drop the field to where you want it to appear in the UI.

14. Use the Field properties window to choose one of the default templates from the Template drop down list.

15. Click the Create link if you want to create your own template.

16. Click the Preview button to view your changes.

Details on creating a template are in the Create Your Own Field Template topic in this chapter.

### Make Fields Conditionally Required or Read Only

This topic gives you an overview of read only and required properties for dynamic forms. For this example, we'll use the layout.

**Note:** Required and Read Only are only available if a field in a layout isn't associated with a template.
First duplicate the default form if necessary, or choose your own layout, and then do the following:

1. Select the layout.
   The layout is displayed with the fields shown.
2. Note the Read Only and the Required check boxes in the Form properties area.
3. To make the field read only, simply click the Read Only check box.
4. To make the field required, just click the Required check box.
5. To make a field conditionally required, do the following:
   a. Hover over, and then click the **Expression Editor**.
   b. Select a variable from the drop down list.
   c. To edit the conditions of the variable, hover over then, select the **Expression Editor**.
   d. In the Expression Editor, expand the **fields** variable list.
   e. Expand the SeverityCd variable and drag and drop **value** on to the editor workspace as shown in the following example:

   ![Expression Editor](image)

   f. Add the following value to the expression: `=== 'ORA_SVC_SEV1'`.
   g. Click **Save**.
   Now the field only displays when is reached

### Field Groups

Field groups are a way for an application developer to group multiple fields. A field group can have properties such as column span, maximum columns, label, and so on. These properties apply to the whole group.

Field groups can also be conditionally hidden. These conditions apply to all the fields in the group.

To create a field group, just do the following:

1. Select a **Dynamic form** layout.
2. Click the **Open** icon for the layout.
3. Click the **New Group** icon as shown in the following graphic.
The field group is added to the layout.

4. Enter a name for the new field group, then click the check mark.

5. In the Properties window, enter values for the label of the group along with other properties such as maximum columns and `colspan` which determines the width of columns in your layout.
6. Add any fields you want into the group by dragging and dropping them from the explorer:

Preview, Share, and Publish an Application Extension

Use the Preview and Share actions to view or have your team view your application extensions.

Publish your extensions using the Publish action. For information on all three actions, refer to the Related Topics links.

Related Topics
- How Do I Create and Publish an App Extension?
- Preview and Share Your Application Extension
- Publish the Application Extension
25 Configure HCM Pages with the Help Desk Link

How to Provide User Access to Help Desk

This topic walks you through the steps to make Help Desk accessible to users through different entry points.

Access through the Springboard

Here's how to add Help Desk as an App to be displayed as a springboard icon.

1. Login as an Administrator.
2. Enter a Sandbox with Structure and Page Composer as the Active Tools.
3. In the sandbox, select Structure from the Tools drop down.
4. Expand the group where you want to add the icon in the Springboard.
5. Select Create Page Entry from the Create drop down.
6. Enter a Name for the Icon.
7. Search for, and select an Icon to use on the Springboard.
8. Select a Group from the Group drop down. This is the group where the icon will appear.
9. Select Yes for Show on Navigator.
10. Select Yes for Show on Springboard.
11. Select Yes for Mobile Enabled.
12. Select the URL type you're using from the Link Type drop down.
13. Check the check box if the URL is a Secure Destination.
14. Enter a Destination URL.
15. Click Save and Close.
16. Verify it was added on the Navigation Configuration page.

Now you can see the app on the Springboard.

Access through a Quick Action

Here's how to add Help Desk as a Quick Action.

1. Log in as an Administrator.
2. Enter a Sandbox with Structure and Page Composer as the Active Tools.
3. In the sandbox, select Structure from the Tools drop-down list.
4. Expand the group where you want to add the quick action.
5. Select the top-level group where you want to add the quick action.
6. Select the Quick Action tab.
7. Select Create.
8. Enter a Name for the Icon.
9. Search for, and select an Icon to use on the Springboard.
10. Select a Group from the Group drop-down list.
11. Select Yes for Visible.
12. Select Yes for Mobile Enabled.
13. Select the URL type you’re using from the Link Type drop-down list.
14. Check the check box if the URL is a Secure Destination.
15. Enter a Destination URL.
16. Click Save and Close.
17. Verify it was added on the Quick Actions page.
18. Click Cancel to leave the Edit Group page.

Add Link to any HCM Page that's Page Composer Enabled

You can add a link to Help Desk from any Page Composer-enabled page. When users click the link, a new Help Desk request is opened in a new browser window.

1. Log in as an Administrator.
2. Navigate to the page where you want to add the link.
3. Click Page Composer from the Tools drop-down list.
4. Click the Structure tab.
5. Select the area where you want to add the link and go into Edit mode.
6. Edit the <Hyperlink> component display options by adding the Next Gen Help Desk link.

For more information about how to use Page Composer, see the Page Content and Layout topics in the Oracle Fusion Cloud Applications Configuring and Extending Applications guide.
26 Appendix: HR Help Desk Classic Configuration

About This Appendix

This appendix is the implementation guide for the current ADF HR Help Desk. The topics in this chapter don’t apply to Next Gen Help Desk.

Overview of Configuring HR Help Desk

Workers use the HR Help Desk application to create and submit service requests (SRs). HR Help Desk agents use the application to access the SRs and take action on them.

This topic provides an overview of tasks you must perform to set up and configure the HR Help Desk application.

Setup Tasks for Service Request Management

You must complete the setup tasks related to service request management, prior to configuring HR Help Desk. Setup tasks include:

- Enabling the Service Offering
- Configuring Service Request Lookups and Scheduled Processes
- Managing Service Request Profile Options
- Enabling Oracle Social Network Objects for Service Requests

For more information about these setup tasks, see the Oracle Fusion Cloud B2B Service Implementing B2B Service guide.

Setup Tasks for HR Help Desk

In addition to the tasks for setting up Service Request Management, you must complete the following tasks for HR Help Desk:

- Enable HR Help Desk
- Configure the HR Help Desk UI using Application Composer
- Enable the HR Help Desk profile option
- Configure HR Help Desk email
- Manage assignment objects and assignment rules for HR Help Desk
- Manage service request categories and product usage groups for HR Help Desk
- Provision roles to enable access to HR Help Desk. These roles include:
Appendix: HR Help Desk Classic Configuration

- Human Resource Help Desk Agent
- Human Resource Help Desk Manager
- Human Resource Help Desk Administrator

**Note:** The ability for the Agent, Manager and Administrator to find workers in the Primary Point of Contact field is enabled using the Human Resource Analyst role.

- Knowledge Analyst
- Knowledge Manager
- Employee

**Note:** Copy the delivered Employee role and add the Knowledge Search HCM role and the HR Help Desk Service Request Creation duty role.

**Note:** HR Help Desk Users that own SRs (for example, agents and managers) must be set up as Resources. The way this happens is that during the creation of an Employee record in the Manage Users UI. Once you save the new employee record with a selected Resource Role, a TCA party is created for the resource. A new resource then shows up in the Resource Directory, which may or may not be associated with a Resource Organization. From the Resource Directory, you can put the resource into the correct Resource Organization at the correct level. Refer to "About Resources and Resource Management Explained." Ensure the resource hierarchy is complete.

- Each resource must have a resource role in a resource organization and a resource manager.
- Each manager in the hierarchy must have a resource role and a resource organization (the same one the manager's direct reports belong to) and a resource manager.
- The hierarchy must be complete from top level to bottom level.

**Note:** The predefined Employee role doesn't inherit the HR Help Desk Service Request Creation duty role. If you want employees to use this function, you must create a custom Employee role, add the duty role to the role, and provision the custom Employee role to employees.

A complete list of privileges is available in the Security Console and an administrator can assign the appropriate roles to users through the Security Console. For more information, see the Oracle Fusion Cloud HCM: Securing HCM guide.

**Related Topics**
- Overview of Resources and Resource Management

### Enable HR Help Desk

HR Help Desk isn't enabled by default in Oracle CX Sales. To enable HR Help Desk in Oracle CX Sales and activating specific features for HR Help Desk, you must perform the following steps.

---

226
1. Sign in to Oracle HCM Cloud applications as an HCM Administrator.
2. Select Navigator > Setup and Maintenance to open the Setup and Maintenance work area.
3. In the Setup and Maintenance work area, from the Setup menu, select Service.
4. Click the View Configuration link. 
   The Opt In: Service page appears.
5. In the Service row, select the Edit icon from the Features column.
   The Edit Features: Service page appears.
6. In the Service Usage row, select the Edit icon from the Enable column.
7. In the Feature Name: Service Usage dialog box, select HR Help Desk, and click Save and Close.
8. Select Done.

Note: Some setup tasks will only appear in the table of contents after you enable the associated feature. For example, some of the email setup tasks don’t appear in the task list unless the email feature is enabled.

Configure the HR Help Desk UI Using Application Composer

Use Application Composer to configure and activate the HR Help Desk UI for your organization.

For example, the service request page contains a field that you probably may not use for HR Help Desk, such as the serial number field. By configuring the UI in Application Composer, you can hide fields that aren’t relevant to your HR Help Desk.

You must first copy the standard layout to create the HR Help Desk layouts. After creating the HR Help Desk layout, you can configure and activate the pages. You can create HR Help Desk layouts from the standard layouts of the following layouts:

- Creation Page Layouts
- Details Page Layouts
- Service Request Spotlight Region

To configure and activate the HR Help Desk UI, follow these steps:

1. Sign in to Oracle HCM Cloud applications as an HCM Administrator.
2. Ensure you’re working in a sandbox.
3. Select Navigator > Tools > Application Composer to open the Overview page.
4. Select the Service object tag from the Application list.
5. Expand Objects, and then expand Standard Objects.
6. Expand the Service Request object, and then click Pages to open the Service Request page.
7. In the Creation Page Layouts section, click to select the Standard layout row, and then click Duplicate from the Actions menu.
8. Enter the new layout name.
9. In the Source Layout list, click Standard layout.
10. Click Save and Edit to open the layout page. In this page, you can configure what fields appear on the HR Help Desk page.
11. Click the **Edit** icon.
12. Move fields to and from the **Available Fields** list depending on what fields you want the user to see.
   
   **Note:** There are some fields in the **Available Fields** list that don't apply to HR Help Desk and should be removed.
   - Account and any of the account type fields
   - Any fields related to Assets
   - Loyalty Member
   - Partner

   On the other hand, the Affected Party field is available and specifically relates to HR Help Desk. It isn't visible by default, and must be added using Application Composer. The Affected Party field displays on both the service request Summary and Contacts tabs and can be used when an employee is submitting a service request about someone else.

13. Click **Save and Close**, and then click **Done**.
14. Click the **Enter expression to determine which page layout to display** icon in the **Advanced Expression** column for the HR Help Desk layout you created. The Advanced Expression page is displayed.
15. Enter `1 StripeCd=="ORA_SVC_HCM"` as the advanced expression for the page.
16. Click **OK**.
17. Select the check box in the **Active** column for the HR Help Desk layout you just completed.
18. In the **Details Page Layouts** section, click to select the **Standard layout** row, and then click **Duplicate Layout**.
19. Repeat the steps 8 through 17 for the Detail Page layout.
20. In the **Service Request Spotlight Region** section, click to select the **Standard layout** row, and then click **Duplicate Layout**.
21. Repeat the steps 8 through 17 for the Service Request Spotlight Region layout.
22. When you're ready to share your changes with all users, ensure that you publish the sandbox.

**Related Topics**
- Overview of Using Application Composer

### Enable the HR Help Desk Profile Options

You must enable the HR Help Desk profile option to permit users to use the HR Help Desk application.

To enable the profile option, follow these steps:

1. Select **Navigator > Setup and Maintenance** to open the Setup and Maintenance work area.
2. Click the Setup menu icon to expand the options, then select **Service**.
3. In the **Search Tasks** box, enter **Manage Service Request Profile Options for HR**, and then click the Search icon.
4. Click the task name link in the search results.
   - The Manage Service Request Profile Options for HR Help Desk page appears.
5. Click the SVC_HCM_PROD_CATALOG_USAGE profile option.
6. Enter HRHELPDESK in the Profile Value field of the Site row.
7. Click Save and Close.
8. Click the SVC_DEFAULT_HCM_CALENDAR profile option.
9. Select your HCM calendar from the Profile Value drop-down list in the Site row.
10. Click Save and Close.

Profile Option for Visibility of National ID

You can use the profile option SVC_HD_HIDE_NATIONAL_ID to control whether the National ID field is visible in the Primary Point of Contact search results.

By default the profile option is set to No which does display the National ID in the search results. Set the profile option to Yes to hide the National ID.

To change an employee's National ID visibility:

1. Select Navigator > Setup and Maintenance to open the Setup and Maintenance work area.
2. Click the Setup menu icon to expand the options, then select Service.
3. In the Search Tasks box, enter Manage Administrator Profile Values, and then click the Search icon.
4. Click the task name link in the search results.
   The Manage Administrator Profile Values page appears.
5. Search for the Profile Option Code SVC_HD_HIDE_NATIONAL_ID.
6. In the Profile Values region, set the value to No if you want the National ID visible and Yes if you want the National ID hidden.
7. Click Save and Close.

Related Topics
- Define a Catalog for the Service Offering

Restrict Contact Search Results

You can restrict the user's visibility of contacts in the contact picker based on HCM data security visibility.

By default, all contacts are displayed in the contact picker for the Human Resource Analyst. To restrict their visibility, use the ORA_HELPDESK_CONTACT_DATASECURITY profile option. Here's how to enable that profile option:

1. Navigate to Setup and Maintenance.
2. Click the Tasks icon.
3. Click the Search link.
4. Enter Manage Administrator Profile Values in the Search field.
5. Click Search.
6. Click the Manage Administrator Profile Values link.
7. Enter the Profile Option Code ORA_HELPDESK_CONTACT_DATASECURITY.
8. Click Search.
9. In the Profile Values section, change the default PublicPerson to Person. This limits results by HCM data security. The default "PublicPerson" displays all contacts.
10. Click Save and Close.
11. Click Done.
Control User Types Displayed in Contact Picker

You can configure the types of HCM contacts that are visible in the contact picker.

Here’s how you set the profile options to control visibility in the contact picker:

1. Navigate to Setup and Maintenance.
2. Click the **Tasks** icon.
3. Click the **Search** link.
4. Enter Manage Administrator Profile Values in the **Search** field.
5. Click **Search**.
6. Click the **Manage Administrator Profile Values** link.
7. In the **Search** field, enter the profile option code from the following table.
8. Click **Search**.

**Profile Options to Control What's Displayed in Contact Picker**

<table>
<thead>
<tr>
<th>Profile Option Name</th>
<th>Profile Option Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_HELPDESK_CONTACT_PRIMARY_ASSIGNMENT</td>
<td>Primary All</td>
<td>Determines if all assignments or only the primary assignment is displayed in the search results.</td>
</tr>
<tr>
<td>ORA_HELPDESK_CONTACT_TERMINATED_EMPLOYEES</td>
<td>Active All</td>
<td>Determines if both active and terminated employees or only active employees are displayed in the search results.</td>
</tr>
<tr>
<td>ORA_HELPDESK_CONTACT_ASSIGNMENT_TYPE</td>
<td>E, C E, C, P, N</td>
<td>Help Desk supports assignment types of Employee (E), Contingent Worker (C), Non-Worker (N) and Pending Worker (P). This profile option lets you either include all types in the contact picker results or just the Employees and Contingent Workers.</td>
</tr>
</tbody>
</table>

9. Select the appropriate profile value.
10. Click the link for the profile option in the search results.
11. Click **Save and Close**.
12. Click **Done**.

The default value for each profile option is All.
Synchronize Worker Data Loaded Through HDL in HR Help Desk

After loading the worker data using HCM Data Loader, Oracle recommends running the "Synchronize Person Records" ESS job to synchronize worker data in HR Help Desk.

The Synchronize Person Records job is used to create or update corresponding TCA person party records for HCM workers.

To Ensure Workers are Properly Synchronized
To ensure workers are properly synchronized, set the following parameters for the Synchronize Person Records job:

- From Date: Enter the load start date
- To Date: Enter the load end date
- After Batch Load: Yes

Note: In the case where the worker data is loaded for more than seven days, you must repeat the process multiple times. In other words, if you have more than seven days, repeat the process (with a maximum date range of seven days) until you're done.

Here are the steps to run the ESS job.

1. From the Navigator, navigate to Tools > Scheduled Processes.
2. Click the Schedule New Process button.
3. Search for and select "Synchronize Person Records" in the Name field of the Schedule New Process window.
4. Click OK.
5. Enter the From Date.
6. Enter To Date.
7. Select Yes from the After Batch Load drop-down list.
8. Click Submit.

You can confirm the synchronization when you see the worker is available in the Primary Point of Contact attribute picker.

Note: The Human Resource Help Desk Administrator job role is required to view all worker data in the picker.

Maintain Party and Location Record Information

In order to support additional user types like pending workers and nonworkers, Maintain Party and Location Current Record Information creates or updates person party records with the party usage. This is required for these additional worker types to display in the contact pickers.

For more details about this job and corresponding profile options, see Maintain Party and Location Current Record Information.
Configure Notifications

A notification is an alert that notifies agents and managers to take certain actions on a service request. Learn more about how to configure notifications in the *Oracle Fusion Cloud B2B Service Implementing B2B Service* guide.

**Related Topics**

Manage Assignment Objects and Assignment Rules for HR Help Desk

You can use assignment rules to automatically assign HR service requests to queues when the service requests are created or updated. You can schedule these rules to run automatically.

HR service requests and employee objects are treated as work objects and queues are treated as candidate objects. You can define rules to select the best queue for each service request. To create the work objects and corresponding rules use the following setup tasks: Manage Service Request Assignment Objects and Manage Service Request Assignment Rules.

Defining HR service request assignment rules requires some forethought. Before beginning this procedure, you must consider the following:

- The attributes of queues you want to use as criteria for your rule assignments.
- The attributes of service requests you want to use as criteria for your rule assignments.
- The attributes of the employee records that you want to use as criteria for your rule assignments. The available attributes include:
  - Bargaining Unit Code
  - Business Unit
  - Commective Agreement Name
  - Country
  - Department
  - Job
  - Legal Entity Name
  - Legislation Code
  - Location
  - Territory Code
  - Union Code
- The rule sets you create.
• The rules to include in each role set.

**Note:** The queues must be created prior to following this procedure. You must create queues by navigating from the Springboard. Don't create queues from Setup and Maintenance. See the link for Creating a Queue at the end of this topic.

### Manage HR Help Desk Service Assignment Objects

In this procedure, you select attributes from the HR service request assignment object that you want to make available in your rules. This procedure however, isn't mandatory, as ready-to-use fields are provided for all the objects.

To manage service request assignment objects:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Communication Channels
   - Task: Manage Service Assignment Objects
     The Manage Service Assignment Objects page appears.

2. Add the queue attributes you want to be available when setting up your rules:
   - Click **HR Queue**.
   - Click the **Attributes** tab.
   - Add attributes to the list by clicking the **Add** icon, and select **View Object Attribute** from the drop-down list.
   - Click **Save**.

3. Add the service request attributes you want to be available when setting up your rules:
   - Click **HR Service Request**.
   - Click the **Attributes** tab.
   - Add attributes to the list by clicking the **Add** icon, and select **View Object Attribute** from the drop-down list.
   - Click **Save**.

### Manage HR Help Desk Service Assignment Rules

In this procedure you define the rules for service assignment.

When assigning work items to queues, follow these guidelines when defining your matching rules:

- The rule set must be defined with Number of Candidates = 1. The application allows only one queue to be assigned to a service request.
- You have the option to select or deselect the **Use Score** option on a rule set. If you select **Use Score**, then for every rule in the rule set, you must indicate the amount to increase the score when the rule is true. You must then associate the rule set to queues that receive that score. All of the rules in a rule set are executed, and the queue with the highest total score is selected.
- If the rule set has multiple rules and you didn't select the **Use Score** option, you must define the criteria for each rule to be mutually exclusive from other rules in the rule set. This ensures that the resulting queue assigned by the application is predictable in all situations.
To manage HR service request assignment rules:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Communication Channels
   - Task: Manage Service Assignment Rules

   The Manage Service Assignment Rules page appears.

2. Select the category HR Service Requests Queuing Rules.

3. Create a new rule set by clicking the Add icon in the Rule Sets work area, and then enter the required information.

4. Create rules for the rule set by clicking the Add icon in the <Rule Name> Rules work area.

   The Create Rule screen appears.

5. Enter a name for the rule in the Name field.

6. From the Rule Applies If drop-down list, select Any conditions met.

7. Add a condition by clicking the Add icon in the Conditions work area, and then define the required attribute. For HR Help Desk, select the HR Service Request Primary Contact object and the available employee attributes are displayed in the attribute drop-down list.

   If an attribute is hierarchical, such as Category Name and Product Group, Not In Including Children and In Including Children operators are displayed as choices. They indicate the following.

   - Not In Including Children: Indicates that the rule applies if the specified attribute value matches the top level of the attribute. This option doesn’t include the attribute values of the children of the current attribute. For example, if the condition is set for the Category Name attribute with value Benefit Enrollment, the rule applies only if the value of the top-level attribute matches Benefit Enrollment.

   - In Including Children: Indicates that the rule applies if an attribute value matches with any of the attributes in the parent-child hierarchy of the current attribute. For example, if the condition is set for the Category Name attribute with value Benefit Enrollment, the rule applies even if the value of any of the child attributes matches Benefit Enrollment.

8. Optionally, add more conditions.

9. Select a queue to which the service requests meeting the conditions must be assigned by clicking the Add icon in the Action Assign Queue work area.

10. Click Save and Publish.

   The service request assignment is defined.

   **Note:** Republish the assignment rules each time the rule is changed. You also must republish the rules each time the associated queue is deleted, enabled, or disabled.

**Related Topics**

- Create a Queue
- How You Define Queue Assignment Rules
- Set Up an Offering with Scope
Manage Service Request Categories and Product Usage Groups for HR Help Desk

Human resource (HR) service request categories can help identify the nature of issues reported in service requests. For example, categories can help group service requests related to General HR in one category, and service requests related to Benefits in another category. Further, categories and child categories can be created to narrow the type of service request within one of the ordered groupings.

HCM Administrators can create categories and category hierarchies to group and organize service requests depending on their organizational needs. Before creating categories, do the following:

- Create a list of your top-level categories.
- For each top-level category, create a list of child categories.

To create service request categories, follow these steps:

1. Select Navigator > Setup and Maintenance to open the Setup and Maintenance work area.
2. Search for the Manage Service Request Categories for HR Help Desk task.
3. Click the task name link in the search results. The Manage Service Request Categories for HR Help Desk page appears.
4. Create a top-level category. To do this, follow these steps:
   
   a. In the Create Category list, select Create Top-Level Category.
   b. Enter a name in the Category Name field.
   c. Specify if the category must be active, by selecting a value in the Active list.
   d. Enter a unique Short Code for the category.
   e. Create additional top-level categories, as needed.
5. Create child categories. To do this, follow these steps:
   
   a. In the Service Request Categories list, select the top-level category for which you want to create child categories.
   b. In the Create Category list, select Create Child Category.
   c. Enter a name in the Category Name field.
   d. Specify if the category must be active, by selecting a value from the Active list.
   e. Create additional child categories, as needed.

Product Usage Groups

Similar to categories, products can also help narrow down service request issues in HR Help Desk. For example, products can be Payroll Application or Benefits Application. To set up products, use the Manage Product Group Usage setup task in the Setup and Maintenance work area and add products for the HR Help Desk category.

Related Topics
- Define a Catalog for the Service Offering
HR Help Desk Email

Configure HR Help Desk Email

Use the following tasks to configure HR Help Desk email.

Configuring Outbound Email Profile Options

As one of the most common channels of communication, HR Help Desk Agents frequently use email to respond to employees and to forward service requests to other authorized internal resources. In addition, HR Help Desk uses email to send automatic system responses to employees for events such as the submission of a service request.

To configure the HR Help Desk email channel, a number of configuration activities are recommended.

1. In the Setup and Maintenance work area, use the following:
   - Offering: Service
   - Functional Area: Communication Channels
   - Task: Manage Outbound E-Mail Profile Options for HR Help Desk

2. Configure the following profile option types with the appropriate System Response Email Templates.

   **Note:** If you don’t have HR Help Desk-specific Email Templates, refer to the Related Links section for links to Email Template documentation.

   The following list shows profile codes that end in '_HRD' and are used in HR Help Desk service requests. Non-HR Help Desk service requests can also use similar profile codes, but without '_HRD' at the end.

   - SVC_SR_RESPONSE_TEMPLATE_NAME_HRD
   - SVC_SR_FORWARD_TEMPLATE_NAME_HRD
   - SVC_SR_SYSTEM_RESPONSE_TEMPLATE_NAME_HRD
   - SVC_OUTBOUND_EMAIL_FROM
   - SVC_SR_EMAIL_ATT_SIZE
   - SVC_ENABLE_DEEPLINKS_IN_OUTBOUND_EMAIL
   - SVC_ENABLE_ACKNOWLEDGMENT_TO_ALL

Creating a Dedicated HR Help Desk Inbound Email Channel

To ensure the security of sensitive HR Help Desk communications, HR Help Desk includes a dedicated inbound mailbox that’s separate from the mailbox that serves all non-HR Help Desk service requests. All email addresses included in email communications through the HR Help Desk Inbound Email Channel are added as contacts on an associate’s HR Help Desk Service Request (enabling communications about the service request. No other permissions are granted to these associated contacts).
Now, you create a new email channel using the following procedure:

1. In the Setup and Maintenance work area, use the following:
   - Offering: Service
   - Functional Area: Communication Channels
   - Task: Manage Communication Channels

2. Click the Create Channel button.

3. In the Create Channel view, do the following:
   a. Expand the Strip Code menu, and select HCM.
   b. Expand the Channel Type menu and choose the channel type you would like to create, such as E-mail.
   c. In the Account Name field, provide the email address for which the channel is intended. For example, HRsupport@yourcompany.com.
   d. In the Channel Code field, specify a code channel that indicates the communication channel.
   e. In the Display Name field, enter the display name that you want for the channel. This is the value that employee users see.
   f. Expand the Business Unit menu and choose the correct business unit.
   g. Enable the record by checking the Active box.
   h. Click Save and Close.

Setting Up Forwarding Rules for Email Channels

Now you create a new forwarding rule on your company email server to redirect emails addressed to your organization’s HR Help Desk email account to the HR Help Desk address that Oracle provided at the time of provisioning. This rule and address are different from the rule and address used for all other service requests. For example, all the support emails that are sent to HRsupport@yourcompany.com are forwarded to pod_name.fa.intservice.incoming@workflow.mail.em2.cloud.oracle.com for processing. The SVC_INBOUND_EMAIL_ADDRESSES profile option indicates the Oracle email ID to which the support mails must be forwarded. Here’s how you set this profile option:

1. In the Setup and Maintenance work area, use the following:
   - Offering: Service
   - Functional Area: Communication Channels
   - Task: Manage Communication Channels

2. Click the Manage Inbound E-Mail Profile Options link.

3. Click the SVC_INBOUND_EMAIL_ADDRESSES link, and do the following:
   a. In the Profile Values area select New from the Actions drop-down list.
   b. Click the Profile Level drop-down list, and select Site.
   c. In the Profile Value field, enter the Oracle email ID where support email will be forwarded.
   d. Click Save and Close.

It's recommended that you then schedule a reoccurring job to process SR and SR message records as described in the Configuring a Job to Process Inbound Emails procedure.
Related Topics
- Configure a Job to Process Inbound Emails
- Set Up an Offering with Scope

FAQs for HR Help Desk Email

What happens when a customer sends an HR Help Desk email?
If an employee sends an email, then the email ID in the From field is validated against the employee record in the database.

If a match is found, and the email is for a new service request, then a new HR Help Desk request is created. If the email is regarding an existing HR Help Desk request, then the email content is added as a message to the relevant request.

If a match to the email ID isn't found in the database, then the following applies:
- The value for the SVC_EMAIL_PROCESS_UNKNOWN_CUST profile option is selected. This option specifies how to process an incoming email from unknown customers.
- If the SVC_EMAIL_PROCESS_UNKNOWN_CUST profile option is set to Y, a new HR Help Desk request is created. However, a message is sent to customers indicating that they can’t be identified and must provide valid information for further processing of the request.
- If the SVC_EMAIL_PROCESS_UNKNOWN_CUST profile option is set to N, no HR Help Desk request is created.

Note: All the recipients of the incoming email, including the unknown contacts are listed in the Messages tab.

Manage Other HR Help Desk Features

About Managing Service Entitlements in HR Help Desk
Entitlements is a feature native to Oracle CX Sales that can be used with HR Help Desk. See the Entitlements Background and Terminology topic which may be relevant to your implementation.

Related Topics

Overview of Setting Up Service Entitlements
Service entitlements allow your Help Desk organization to define the internal service level target for your entire employee base.

The entitlements are defined by a global default coverage that specifies the amount of time targeted for each type of Service Request milestone. Optionally, you can include the SR Business Unit as a criteria in the coverage rules, allowing you to set different target time frames for each milestone for each Business Unit. Once coverage is enabled, Help Desk
agents can see warnings on each SR about upcoming or expired milestones. You can also configure object workflows to send out notifications about upcoming milestones.

Related Topics
- How You Monitor Milestones

Overview of Survey Integration

The survey integration framework lets you initiate requests to send your SurveyMonkey surveys based on HR Help Desk SR events. You can set who receives a survey, what survey SurveyMonkey should send, and when to send a survey.

The survey integration framework connects with SurveyMonkey using Enterprise Oracle Integration.

To use this feature, you must have a paid plan with SurveyMonkey. For details on how to set up this feature, see the Set Up Surveys chapter in the Oracle Fusion Cloud B2B Service Implementing B2B Service guide.

Related Topics

About Oracle Knowledge in HR Help Desk

Oracle Knowledge is a feature native to Oracle CX Sales that you can use with HR Help Desk. See the related topics section for topics which may be relevant to your implementation.

Related Topics
- Use Knowledge with Service Requests
- Add Knowledge to Service Requests

About Reporting and Analytics in HR Help Desk

Reporting and Analytics are features native to Oracle CX Sales that you can use with HR Help Desk. See the related topics section for topics which may be relevant to your implementation.

Note: The HR Help Desk infolets are available for Agents and Managers. If the infolets are required for the HR Help Desk administrator role, add these privileges.
- SVC_VIEW_HR_HELPDESK_AGENT_DASHBOARD_PRIV
- SVC_VIEW_HR_HELPDESK_MANAGER_DASHBOARD_PRIV
Note: If you are not using CX Sales and Fusion Service, you must complete the following tasks to see and drill down from OOTB infolets:

- Calendar
- Org Hierarchy
- Enable SR Audit

Related Topics
- How to View Analyses Using OTBI

About Productivity Tools in HR Help Desk

There are many productivity tools which are native to Oracle CX Sales that you can use with HR Help Desk. See the related topics section for topics which may be relevant to your implementation.

Related Topics
- Enable Productivity Tools
- How You Manage SmartText Entries
- Manage Keyboard Shortcuts

About Action Plans for HR Help Desk

You can associate action plans with HR Help Desk service requests to help facilitate a series of steps or a sequence of events that may be required to resolve SRs.

Agents can attach action plans to an SR using an administrator-defined template, or by adding individual actions. Actions can be tasks, activities, or appointments, and can be required or optional.

Action plans also provide:

- A visual aid to see the progress of an action plan
- Warnings for both the action plan and individual actions

To use action plans with HR Help Desk service requests, see the Set up Action Plans chapter in the Oracle Fusion Cloud B2B Service Implementing B2B Service guide.
Related Topics

About Service Request Outcomes and Resolutions for HR Help Desk


Configure HCM Pages for HR Help Desk

Use Page Composer to configure page content and layout. You can use Page Composer to insert a link on any page to log an HR Help Desk service request.

For example, if a user is working in an HCM page and receives an error, or doesn't understand the process, they can log a service request from right there rather than navigating to the Help Desk. The link you add passes some parameters from the page depending on the configuration.

Here's the steps required to insert a link (also known as a resource Catalog) to HCM pages:

1. Activate a Sandbox.
2. Open the HCM page that you want to configure in Page Composer.
3. From the Settings and Actions menu, select Edit Pages to open Page Composer.
4. In the Edit Pages window, select Edit for the Site layer.
5. Click OK.

The Page Composer toolbar displays.
6. Select Source from the View menu on the Page Composer toolbar.
7. Select the component on the page you want to edit by hovering over and clicking the component.
8. Click Edit on the Confirm Task Flow Edit window.
9. In the Source View region, select the container component in the selection pane. For example, if you're editing the Biographical Information component, select <>panelGroupLayout: vertical.
10. Click Add in the Source view toolbar.
11. In the Add Content window, click Add in the Service Requests row.
12. Click Close.

A service request header with a link for Create Service Request now displays in the component.

13. Highlight the new service requests header for the component in the Page Composer toolbar. For example, highlight <>showDetailFrame: Service Requests.
14. Click the Show Properties icon in the toolbar.

On the Component Properties: Service Requests window Parameters tab, the following attributes can be passed to the service request. The fields are optional except SVC App Context, which is the stripe code that must be populated with HCM.

- SR Category Short Name
15. Select the **Display Options** tab.

Here, you can remove the Service Request header so that only the link for Create Service Request appears in the component.

16. Deselect **Display Header**.

17. Select the **Content Style** tab.

Here, you can define the style of the link. For example, color, font, or size of the text.

18. Click **Apply**.

19. Click **OK**.

20. Click **Close** on the **Page Composer** toolbar to close Page Composer.

You can now see the link displayed on the page. When the user clicks the Create Service Request link from that HCM page, the Create Service Request page opens.

**Note:** When a user enters Create Service Request from a link on an HCM page, there is a Done button on the Create Service Request page. When the user clicks Done, they're taken back to the HCM page. If they click Save and Close, they're returned to the HR Service Requests list page. A Done button is also on the HR Service Requests list page that returns the user to the HCM page.

---

**Related Topics**

**Setting Up Delegation for Users to Create HR Service Requests on Behalf of Others**

HR Help Desk predefined roles enable managers to log HR service requests for anyone in their employee hierarchy, however employees are restricted to logging HR service requests for only themselves.

A manager can delegate their role to anyone in their employee hierarchy allowing them to log HR Service Requests on their behalf.

For example, if a manager goes on vacation and wants to give access to an employee to logging service requests on their behalf while they're away, they can delegate their role to that employee. The delegated person can use the employee picker on the service request to select another employee in the manager's hierarchy as the primary point of contact.

The remainder of this topic details the tasks an administrator must complete to enable the delegate role, how a manager delegates the role, and what an employee must do to log a service request on behalf of their manager.

The following figure shows the flow of tasks that are required when you set up the delegation of users.
Create a Security Profile

To create a security profile:

1. Sign in as an administrator.
2. Navigate to Setup and Maintenance.
3. Search for and select the Manage Person Security Profile task.
4. Click Create.
5. On the Create Person Security Profile page, enter a Name for the security profile. For example, enter Delegate Security Profile.
7. In the Manager Hierarchy region, select Secure by Manager Hierarchy.
8. Select Both from the Hierarchy Content choice list.
9. Click Save and Close.
10. Click Done.

Create a Custom Data Role and Assign Security Profile

Now, you must create a custom data (or delegate) role and assign the security profile to the data role.

1. Sign in as an administrator.
2. Go to Setup and Maintenance.
3. Search for and select the Manage Data Role and Security Profiles task.
4. Click Create.
5. On the Create Data Role: Select Role page, enter a name for the Data Role. For example, Delegate Role.
6. Search for the job role Human Resources Analyst.
7. Select Human Resources Analyst from the search results.
8. Click OK.
10. Click Next.
11. In each of the following regions select the indicated value from the choice list:
   - Organization Security Profile Value - View All Organizations
   - Position - View All Positions
   - Legislative Data Group - View All Legislative Data Groups
   - Document Type - View All Document Types
   - Payroll - View All Flows
12. In the Person region, select the new security profile you just created. For example, Delegate Security Profile.
13. In the Public Person region, select the new security profile you just created. For example, Delegate Security Profile.
14. Click Next through the remaining train stops.
15. Click Submit on the Create Data Role: Review page.

Add Custom Data Role to Security Profile

Now, add the custom data role to the manager's security profile.

For more information about security console, refer to the Oracle Fusion Cloud HCM Securing HCM guide.

Delegate Custom Role to Employee

The manager now can delegate the custom role to an employee in their hierarchy.

1. Sign in as a manager.
2. Navigate to Roles and Delegations.
3. On the Edit User Account Details page, scroll to the Roles and Approvals Delegated to Others region.
4. On the Roles Delegated to Others tab, click the Create icon.
5. Enter the Role Name.
6. Enter Start and End Dates.
7. Search for and select the employee to delegate in the Delegated To drop-down list.
8. Click Save.

The designated employee can now log a service request on behalf of the manager. When logging the service request, the employee selects anyone in the manager's hierarchy as the Primary Point of Contact on the service request.

Related Topics

About Computer Telephony Integration (CTI) in HR Help Desk

Computer telephony integration (CTI) allows integration of third party media toolbars with Oracle Cloud Applications.
Enable the Help Desk Mobile UI for Employees

With HR Help Desk, you can have employees access UIs on their mobile device for some functions. Once enabled, the mobile UI can be accessed from any HCM page where the link has been enabled with page composer.

Capabilities include:
- Service Request List of My SR's
- Create Service Request
- Edit or Update Service Request
- Search Knowledge (Requires adding the View Knowledge within Service Request privilege (SVC_VIEW_KNOWLEDGE_IN_SR_PRIV) to the role.)

You first need to enable the profile option. Here's how:

1. Sign into Setup and Maintenance.
2. Search for the Manage Administrator Profile Values task.
3. Search for the Profile Option Code: HCM_HD_RESPONSIVE_PAGES_ENABLED.
4. Set the profile option to Yes.

Once enabled, the mobile UI can be accessed from links that have been added to HCM pages using Page Composer.

See the topic Configure HCM Pages for HR Help Desk for details on how to add the links.

**Note:** The mobile UI is can't be accessed from Navigator.

Set Up Business Units for HR Help Desk

How Business Units for Service Are Set Up

With business units (BUs) for Service, you can deploy more than one service center within a single instance of your service application. This topic gives an overview of the steps that you must perform to complete the business units setup.

You can use multiple BUs in the following ways:
- Segment SRs between BUs so that users can search and identify SRs from multiple BUs.
- Use product catalogs, categories, channels, and email templates specific to a BU.
- Assign SRs to queues by writing rules based on BU.
• Create service request BI reports specific to a BU.

Currently, the following objects aren't supported by multiple BUs in Service: accounts and contacts, users, resources, and lookups.

For more detailed information about BUs, see the "Setting Up Multiple Business Units" chapter of the Oracle Fusion Automation Implementing Sales guide.

For more detailed information about users and security, see the Oracle Fusion Getting Started with Service Logistics Implementation guide.

To set up business units in Service, you must perform the following tasks in the given order.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting Up Business Units for Service</td>
<td>Add the Manage Business Unit functional area to the Service offering by using the Change Feature Opt In link in Setup and Maintenance.</td>
</tr>
<tr>
<td>Manage Common Profile Options</td>
<td>Set the profile options to enable the multiple-BU functionality in the Manage Common CRM Business Unit Profile Options task.</td>
</tr>
<tr>
<td>Manage Internal Resource Organizations</td>
<td>Define internal resource organizations to be associated with the BU.</td>
</tr>
<tr>
<td>Manage Resource Organization Hierarchies</td>
<td>Add the internal resource organizations to the internal resource organization hierarchy.</td>
</tr>
<tr>
<td>Create Business Unit</td>
<td>Create a BU to be associated with the resource organization in the Manage Business Unit Task.</td>
</tr>
<tr>
<td>Associate Resource Organization to Business Unit</td>
<td>Associate the internal resource organization to the BU you created. Use the Resource Directory.</td>
</tr>
<tr>
<td>Create Employees</td>
<td>Add users to the organization in the Users, Roles and Delegations task, and make one of the resources a manager for the organization.</td>
</tr>
<tr>
<td>Reset Passwords for Users</td>
<td>Reset the password for the users.</td>
</tr>
<tr>
<td>Set the Scope in Service Setup Tasks and complete Service Setup tasks.</td>
<td>Set the scope for Service tasks and set up the remainder of the Service offering.</td>
</tr>
<tr>
<td>Add additional BU fields in the SR if users are associated with multiple BUs.</td>
<td>Change the layouts of the SR pages if required. Use Application Composer to include multiple BU fields in the SRs.</td>
</tr>
<tr>
<td>Note:</td>
<td>Only required if a user is associated with multiple business units.</td>
</tr>
<tr>
<td>Configure Multiple Business Units with Digital Customer Service</td>
<td>If you implement multiple business units for Digital Customer Service, you must complete some additional configuration. For more information, see the Oracle Fusion Service Implementing Digital Customer Service guide.</td>
</tr>
</tbody>
</table>
Manage Common CRM BU Profile Options for Service BUs

To enable multiple business units (BUs) for Service, you must set the following profile options:

1. Multiple Business Units Enabled (HZ_ENABLE_MULTIPLE_BU_CRM): Set this profile option to Yes. The default value is No.
2. Customer Relationship Management Business Unit Default (HZ_DEFAULT_BU_CRM): Set this to the default business unit for your service application.

**Note:** You must ensure that the value of the HZ_DEFAULT_BU_CRM profile option doesn't remain blank, and the value is set to a BU. Otherwise, agents may see an error while creating SRs.

To set the profile options for Service BUs:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Company Profile
   - Task: Manage Common CRM Business Unit Profile Options

   The Manage Common CRM Business Unit Profile Options page shows the two profile options.
2. Click the HZ_ENABLE_MULTIPLE_BU_CRM profile option.
3. In the HZ_ENABLE_MULTIPLE_BU_CRM: Profile Values region, set the Profile Value for the Site Profile Level to Yes.
4. Click Save and Close.
5. Click the HZ_DEFAULT_BU_CRM profile option.
6. In the HZ_DEFAULT_BU_CRM: Profile Values region, specify the Profile Value for the Site Profile Level.
7. Click Save and Close.

Manage Internal Resource Organizations for Service BUs

For every business unit (BU) that you set up, you can define internal resource organizations to be associated with the BU.

A resource organization represents the internal organization and structure for the business unit. Resource organizations are hierarchically structured, and the organization hierarchy helps to derive the reporting relationships.

To define the internal resource organization for a Service BU:

1. In the Setup and Maintenance work area, go to the following:
2. Click **Create** to add a new resource organization.
3. Select the **Option 2: Create New Organization** option to create a new organization.
4. Click **Next**.
5. On the Create Organization: Enter Basic Information page, enter a **Name** for the organization.
6. In the Organization Usages region, click **Add Row**.
7. From the **Usage** drop-down list, select **Service Organization**.
8. Click **Finish**.

**Related Topics**
- Update Existing Setup Data
- Set Up an Offering with Scope

**Manage Resource Organization Hierarchies for Service BUs**

After you define internal resource organizations to be associated with business units (BUs), you must add them to the internal resource organization hierarchy. A resource organization hierarchy is a hierarchically structured representation of the way resources are grouped within a resource organization.

To add internal resource organizations to the resource organization hierarchy:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Users and Security
   - Task: Manage Resource Organization Hierarchies

2. In the Manage Resource Organization Hierarchies page, search for the resource organization that you created in the “Manage Internal Resource Organizations for Service BUs” procedure.
3. Click the link for the resource organization that you want to edit.
4. Select **Edit This Hierarchy Version** from the **Actions** menu.
5. Expand the organization list in the **Internal Resource Organization Hierarchy** region.
6. Select the organization that you created in the “Manage Internal Resource Organizations for Service BUs” procedure, to add it to the organization hierarchy.
7. Click **Add**.
8. In the **Add Tree Node** window, click **Search**.
9. In the **Search Node** window, search for the organization that you created in the **Manage Internal Resource Organizations** task.
10. Click **OK** to add the organization.

To add more organizations, select the parent node to add a child node. Repeat the steps to search and add as many times as needed.
11. Click **Save and Close**.
12. Click **Yes** on the warning message, which states that the hierarchy version is to be updated and the corresponding reporting hierarchy regenerated.
Create a Business Unit for Service

You can use a business unit (BU) to separate or share the following:

- Service setup data such as product catalog
- Transactional data such as service requests

To support the multiple-BU features, you must first create the required BUs.

To create a BU for the Service offering:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Company Profile
   - Task: Manage Business Unit
2. In the Manage Business Unit page, click **Create**.
3. In the Create Business Unit page, enter a name for the BU.
4. In the **Default Set** drop-down list, click **Search**.
5. In the **Reference Data Set Name** field, search for **Common**.
6. Select **COMMON** from the search results.
7. Click **OK**.
8. On the Create Business Unit page, click **Save and Close**.

To add another BU, select the **Manage Business Unit** task again and repeat the steps.

Associate Resource Organizations with Business Units

You can associate a resource organization with multiple business units (BUs). By associating resource organizations with BUs, you can control access to the transactional data available to service resources in business objects such as service requests.

**Note:** If you enable multiple BUs, ensure that each user is associated with a resource organization, and the resource organization is associated with one or more BUs. Otherwise, the default BU set on the HZ_DEFAULT_BU_CRM profile option is associated with SRs.
To associate a resource organization with business units:

1. Sign in to the application as an administrator or a setup user.
2. In the Navigator, select Resource Directory.
4. In the Resource Organizations region, click View Organizations.
5. On the View Organizations page, search for the organization that you created.
6. In the Search Results region, click the link for the organization.
7. Select the Business Units tab.
8. Click Add Row.
9. Select the business unit from the drop-down list.

**Note:** The first BU with which you associate the resource organization becomes the primary BU. If you associate the organization with more BUs, you can change the primary BU as required.

10. To add more business units, click Save, and then click Add Row.
11. After you add the business units, click Save and Close.
12. Click Done.

Create Employees for a Service BU

You can add resources to the resource organizations that you associate with business units (BUs). When you add a resource to an organization, the resource becomes a member of the organization and a part of the organization hierarchy.

You must first create a manager for the organization. To create application users, use the Users and Roles task:

1. Sign in to the application as an administrator or a setup user.
2. In the navigator, select Users and Roles.
3. On the Search Person page, click Create.
4. On the Create User page, enter the Last Name and First Name.
5. Enter the Email.
6. In the User Details region, enter a User Name.
7. In the Employment Information region, select Employee from the Person Type drop-down list.
8. Select a Legal Employer from the drop-down list.
9. Select the Business Unit of the employee from the drop-down list.

**Note:** This BU that you select is the BU of the employee, and not the BU of the resource organization. They both may be different. What BU you select for the employee information depends on how employees are organized.

10. In the Resource Information region, select the Resource Role from the drop-down list.
11. Search for and select an organization from the Organization drop-down list.

This organization is the one that you created earlier. The agent is associated with the BU through this organization.

12. Click Autoprovion Roles. This gives the user any predefined job roles.
13. Click Save and Close.

Repeat the steps to create another user who is the employee of the manager. The steps are the same except that in the Resource Information region, you search for and add the Reporting Manager that you already created.
14. When you have added all the users, click **Autoprovision Roles**.
15. Click **Save and Close**.

You can view everyone you created in the **Resource Directory** by using the Navigator.

### View Employees in the Resource Directory

To view the employees that you created in the Resource Directory:

1. In the Navigator, click **Resource Directory**.
2. Click the Tasks panel tab.
3. In the Resource Organizations region, click **View Organizations**.
4. On the View Organizations page, in the **Organization** field, type the name of the organization for which you want to view the employees.
5. From the displayed list of organizations matching your search, click the organization that you want.

The list of employees is displayed in the Members tab.

For more information about the Resource Directory, see the *Oracle Fusion Automation Using Customer Data Management for Sales and Service* guide.

**Related Topics**

- Overview of Setting Up Users and Security
- About Security Roles
- Resource Directory

### Set the Scope in Service BU Setup

When you opt in to the business units (BUs) feature for Service, the Scope column in the Business Units tasks list contains links to set the scope of the task.

Let’s learn how to set the scope for tasks when setting up BUs for Service.

To set the scope for tasks when you set up BUs for Service:

1. Sign in to the application as an administrator or a setup user.
2. Navigate to **Setup and Maintenance**.
3. From the **Setup** drop-down list, select the Service offering.
4. Select the **Business Units** functional area.
5. From the **Show** drop-down list, select **All Tasks**.
6. In the **Scope** column for any task in the task list, click the displayed link.

The **Select Scope** dialog box is displayed, and the task for which you are setting the scope is already selected.

**Note:** When you go to the task list for the first time, the scope may not be set and the **Scope** column displays the **Select** link. After you set the scope once, that BU appears as a link in the Scope column.

7. From the **Business Unit** drop-down list in the **Select Scope** dialog box, select **Select and Add**.
8. Click **Apply and Go to Task**.
9. On the Select and Add: Business Unit page, search for and select the BU that you want to set for the scope.
10. Click **Save and Close**.
The page opens for the task you're working with. On this page, you can choose to use the default Site Level Value or select the Business Unit Profile Value.

11. To select a Business Unit Profile Value:
   a. Deselect the Use Site Value check box.
   b. In the Business Unit Profile Value field, enter the profile value for the BU.
   c. Click Done.

The task closes and now on the Setup page, the BU that you set for the Scope is populated for all tasks. Each task you open now is the setup for the BU in the Scope column.

To set up additional BUs, repeat the same steps.

**Note:**
- After you set up the first BU, the Business Unit drop-down list in the Select Scope window shows the BUs that you already set up.
- For all tasks, the scope displays the BU that you're currently working with. To change the BU again, click the BU in the Scope column for any of the tasks.

### Set the HR Help Desk Service Request BU

The BUs on an HR Help Desk Request are set as follows:

- SR is created by Agent: If the BU on the SR is set as the BU associated with the signed in users resource organization and multiple BU's are associated with the user's resource organization, then the primary is used.
- SR created by Employee: If employees aren't resources and they don't have a resource organization, the BU on the SR is set as the default BU.
- SR created by email: If the SR is created by email, then the BU of the SR is determined based on the BU of the email channel.
- If your requirement is to set a different BU based which employee has signed in, then you must write a groovy script to dynamically set a different BU based on the employee who's signed in.

Only agents are set up as resources and associated with a resource organization. HR Help Desk user employees aren't resources so the business unit on the HR Help Desk service request is set to the value of the profile option HZ_DEFAULT_BU_CRM. To set the BU on the SR to the BU of the employee rather than the default, you must configure the following:

### Add an After Create Trigger to Update the BU on the SR

Complete the following steps in Application Composer.

1. In Application Composer, navigate to the Server Scripts under Service Requests.
2. Go to the Triggers tab.
3. Create a new Trigger with the following.
   - Trigger = After Create
   - Enter an appropriate name
Add an After Field Trigger on the Primary Contact ID Field to Update the BU on the SR

If an agent creates an SR on behalf of the employee, then the After Create trigger on the SR Object wouldn't default the BU of the Primary Point of Contact's BU. To do that, you must add an After Field Changed field Trigger on the Primary Contact ID.

Complete the following steps in Application Composer.

1. In Application Composer, navigate to the Server Scripts under Service Requests.
2. Go to the Triggers tab.
3. Create a new Field Trigger with the following:
   - Trigger = After Field Changed
   - Field Name = Primary Contact ID
   - Enter an appropriate name
   - Paste the following code in the script section of the trigger:

   ```java
   if(StripeCd == "ORA_SVC_HCM")
   {
   def hcmPersonListVL = hcmPersonList
   while(hcmPersonListVL.hasNext())
   {
   def hcmPersonListRow = hcmPersonListVL.next();
   def actualTerminationDate = hcmPersonListRow?.ActualTerminationDate;
   if(actualTerminationDate == null)
   {
   def EmpBuName = hcmPersonListRow?.BusinessUnitName;
   if (EmpBuName != null)
   {
   def buID;
   def buVO = getAttribute("BusinessUnitsLOV");
   buVO.reset()
   while (buVO.hasNext())
   {
   // access the next row in the row iterator
   def curBU = buVO.next()
   if(curBU.getAttribute("Name") == EmpBuName)
   {
   buID= curBU.getAttribute("BusinessUnitId");
   println('buID:'+buID);
   setAttribute("BUOrgId", buID);
   break;
   }
   }
   }
   }
   }
   }
   ```
def EmpBuName = hcmPersonListRow?.BusinessUnitName;
if (EmpBuName != null)
{
def buID;
def buVO = getAttribute("BusinessUnitsLOV");
buVO.reset()
while (buVO.hasNext())
{
    // access the next row in the row iterator
def curBU = buVO.next()
if(curBU.getAttribute("Name") == EmpBuName)
{
buID= curBU.getAttribute("BusinessUnitId");
println('buID:'+buID);
setAttribute("BUOrgId", buID);
break;
}
}
}
}

Note: You can't expose the BU ID field on the SR if you're adding this trigger. This is because if you update the BU using the After Field Changed Trigger, the UI wouldn't be updated with the value set in the trigger. If you want the agent have the ability to change the BU, don't use the After Field Changed Trigger. Or, you can use this trigger but don't expose the BU on the Service Request page.

Give the Employee Privilege to Update BU on the SR
Make sure all the employees have the Update Service Request Business Unit privilege in the security console.
You can do this in two ways.

1. Option 1:
   o Create a new job role and add associate the Update Service Request Business Unit privilege to the role.
   o Associate this role to all your employees.
2. Option 2:
   o If all your employees are already associated with a custom role, you can add Update Service Request Business Unit privilege to that custom role.

Overview of Optional Setup Tasks for Service BU
Once the preliminary steps for setting up Service business units (BUs) are done, you can set up BU-specific tasks. All the BU-specific tasks are grouped under the Business Units functional area.

For multiple BUs in Service, the setup tasks are the same as in a normal Service setup. The only difference is that with most tasks for multiple BUs, you can do one of the following:

- Use the default site-value profile option.
Set or select the business unit profile value. However, the previous statement isn't true for some tasks for multiple BUs. The following multiple-BU tasks aren't related to profile options, so you must configure these tasks for each BU separately:

- Manage Service Categories for Business Units
- Manage HR Help Desk Service Categories for Business Units
- Manage Communication Channels for Business Units

**Note:** Categories and channels are restricted based on the BU set as the scope.
- When a new category or channel is created, it's automatically associated with the BU set in the scope. For more information about setting the scope for tasks when setting up BUs, see "Set the Scope in Service BU Setup".
- You can set the BU only for the top-level category. The BU on the child categories is automatically set based on the BU of the root category.

Here's a list of the other Service optional setup tasks and the help topics that provide more information.

<table>
<thead>
<tr>
<th>Service Task</th>
<th>Related Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Business Unit</td>
<td>Define Business Units</td>
</tr>
<tr>
<td>Manage Service Product Groups Usage for Business Unit</td>
<td>Define a Catalog for the Service Offering</td>
</tr>
<tr>
<td>Manage HR Help Desk Product Group Usage for Business Unit</td>
<td>Associate Different Catalogs to Different Business Units</td>
</tr>
<tr>
<td>Manage Service Categories for Business Unit</td>
<td>Manage Service Request Categories</td>
</tr>
<tr>
<td>Manage HR Help Desk Service Categories for Business Unit</td>
<td>Manage Service Request Categories and Product Usage Groups for HR Help Desk</td>
</tr>
<tr>
<td>Manage Communication Channels for Business Unit</td>
<td>Managing Communication Channels</td>
</tr>
<tr>
<td>Manage Service Email Templates for Business Unit</td>
<td>Define Email Templates</td>
</tr>
<tr>
<td>Manage Human Resources Help Desk Email Templates for Business Unit</td>
<td>Configure HR Help Desk Email</td>
</tr>
<tr>
<td>Manage Service Milestone Configuration for Business Unit</td>
<td>Overview of Milestones for Multiple BUs</td>
</tr>
</tbody>
</table>

**Note:** You must perform additional steps to complete the Manage Service Email Templates for Business Unit task. In Functional Setup Manager, in the Business Units functional area of the Service offering, show **All Tasks**. For each task, click the **Scope** link and select the BU that you want. When you finish, click the **Select and Go to Task** button.
## Related Topics

- Define Email Templates
- Set the Scope in Service BU Setup
- Define a Catalog for the Service Offering
- Manage Categories

<table>
<thead>
<tr>
<th>Service Task</th>
<th>Related Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Outbound Email Profile Values for Business Unit</td>
<td>Configure Profile Options for Inbound and Outbound Email</td>
</tr>
</tbody>
</table>